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Dette kapitel introduserer SMART Notebook®-samarbeidsprogramvare for utdanning og

forklarer hvordan man kommer i gang med programvaren.

About SMART Notebook software
In SMART Notebook software, you can create .notebook files that include graphics, text,

tables, lines, shapes, animations and more. Present your file and keep your class’s attention as

you move and interact with these objects. When your class provides comments and

suggestions, write their input on the page using digital ink. You can open .notebook files in

SMART Notebook software on a Windows®, Mac or Linux® computer. You can also export your

file in a variety of formats, including HTML and PDF.

You can install SMART Notebook Tools as well as third-party add-ons to add special features

to SMART Notebook software. SMART Notebook Tools include the following:

l 3D-verktøy for SMART Notebook-programvare

l Blandet realitet-verktøy for SMART Document Camera™

Om andre SMART-programvarer på
datamaskinen din
Datamaskinen kan inneholde følgende andre SMART-programvarer.

l SMART Product Drivers

Your interactive product detects contact with its screen and sends each contact point,

along with Pen tool information, to the connected computer. SMART Product Drivers

translates the information into mouse clicks and digital ink. SMART Product Drivers

enables you to perform normal computer operations by using your finger or a pen.

l SMART Ink™

Ved hjelp av SMART Ink kan du skrive eller tegne på skjermen med digitalt blekk ved å

bruke en penn, og deretter lagre og slette notatene.

l SMART Board® Tools

Du kan trekke oppmerksomhet mot spesifikke deler av en side ved hjelp av SMART

Board Tools, som f.eks. skjermskyggelegging, spottlys, forstørrelsesverktøy og peker.

Hva er nytt
SMART Notebook 2014-programvaren introduserer følgende nye funksjoner.
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SMART Notebook 14.3 programvare
Funksjon Tema

Undervisningsopptakeren gir en enkel
måte å ta opp aktiviteter på en
SMART Notebook-programvareside.

Ta opp sider med undervisningsopptaker på
side 120

Du kan lenke et objekt til et verktøy på

programvarens verktøylinje for å

tilpasse verktøyet som du deretter kan

plassere hvor som helst på siden.

Lenke objekter til verktøy på side 130

Du kan klippe eller kopiere og lime inn
en side ved bruk av sidesortering.

Klippe eller kopiere og lime inn sider på side 22

Du kan bruke tekstpennen til å gjøre
følgende:

- Sette inn tekst i forskjellige farger.

- Endre farge på valgt tekst

- Endre farge på en hel verden

Redigering med tekstpennen på side 128

Du kan låse et objekt, men likevel

beholde muligheten til å flytte det

horisontalt eller vertikalt.

Låse objekter på side 97

Skjermskygge er tilgjengelig i flere

farger.

Bruke skjermskyggelegging på side 122

Man kan endre størrelsen på

dialogboksen for

bildegjennomsiktighet.

Lage gjennomsiktige områder i et bilde på side 76

SMART Notebook 14.2 programvare
Funksjon Tema

SMART-Ruter Bruke SMART-Ruter på side 131

Du kan bruke farget blekk for
å skrive ligninger i
Matteredigeringsprogrammet.

Sette inn ligninger i matematikkverktøyet på side 80

SMART Notebook 14.1 programvare
Funksjon Tema

Matteredigeringsprogrammet Sette inn ligninger i matematikkverktøyet på side 80

Varsler for verktøyendringer Vise varsler for verktøyendringer på side 10
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SMART Notebook 14 programvare
Funksjon Tema

Pennetype Malerkost  Writing or drawing digital ink på side 28

Beskjære bilder Beskjære bilder med en maske på side 61

Notebook Connect Tilgang til RSS-feed med Notebook Connect på side 161

Tilleggsprogrammet

GeoGebra

Sette inn innhold fra GeoGebra på side 73

Blekkredigering Bruke Tekstpennen på side 127

Tilleggsprogrammet XC

Collaboration

Tilgang til XC Collaboration på side 159

Kalligrafipenn  Writing or drawing digital ink på side 28

Starte SMART Notebook-programvaren
Kjør SMART Notebook-programvaren ved å klikke Notebook i dokken.

MERKNAD

If your computer’s display refresh rate is less than 60 Hz, a warning message appears when

you first start SMART Notebook software. You can change the display refresh rate by

opening System Preferences > Displays in Mac OS X operating system software.

When you start SMART Notebook software the first time, a tutorial file opens automatically.

You can read the contents of this file to learn more about the software and the new features in

the latest release. When you’re done, select File > New to create a new, blank file.

MERKNAD

When you start the software subsequent times, a new, blank file opens automatically. To

open the tutorial file, select Help > Tutorial.

Navigere i brukergrensesnittet
Brukergrensesnittet for SMART Notebook-programvaren består av følgende komponenter:

l Meny

l Verktøylinje

l Faner (sidesortering, galleri, vedlegg, egenskaper, tillegg og SMART Response®)

l Sideområdet
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Meny
Menyen inneholder alle kommandoer du trenger for å manipulere filer og objekter i

SMART Notebook-programmet.

Verktøylinje
The toolbar enables you to select and use a variety of commands. The buttons on the toolbar

are organized in panels.

MERKNAD

Kommandoene i verktøylinjen er også tilgjengelig fra menyen (se Meny oppe).

Handlinger-panelet
Panelet for Handlinger i verktøylinjen inkluderer knapper som lar deg søke og utføre

endringer ved .notebook -filer:

Plugin-panelet
Hvis du installerer SMART Notebook-verktøy som SMART Response eller tredjeparts-plugin,

vil et tilleggspanel synes på høyre side av Handlinger -panelet:

Verktøy-panel
Verktøy-panelet innebærer knapper som lar deg opprette og jobbe med grunnleggende

objekter på sidene:
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Kontekst-panel
When you select one of the buttons in the Tools panel, additional buttons appear. For

example, if you select Pens , the following additional buttons appear:

Press the Pen Types button to select a pen type and then press one of the line type buttons to

write or draw digital ink in that line type. You can customize a selected line type using the

options in the Properties tab and then save your changes for future use (see  Saving tool

settings på side 56).

De tre egenskapsvelgerne ved siden av linjetypeknappene gir deg muligheten til å stille inn

farge, tykkelse, stil og gjennomsiktigheten av digitalblekket.

Hvis du klikker en av de andre knappene i Verktøy -panelet vil en lignende rekke med

knapper synes.

Tilpasse verktøylinje
Du kan legge til, fjerne og endre posisjonen av knappene på verktøylinjen ved å trykke på

Tilpasse verktøylinje (Se  Customizing the toolbar på side 165).

By default, the toolbar appears at the top of the SMART Notebook software window. However,

you can move it to the bottom of the window by pressing Move toolbar to top/bottom of

window . This is useful in situations where you or your students can’t reach the toolbar

when it’s at the top of the window.

Sidesortering
Sidesorteringen viser alle sidene i den åpne filen som miniatyrbilder, og oppdaterer

automatisk disse miniatyrbildene etter hvert som du endrer innholdet på sidene.

Med sidesorteringsfunksjonen kan du gjøre følgende:

l Klipp ut eller kopier og lim inn sider

l Vise sider

l Klippe, kopiere og lime inn sider

l Opprette sider

l Klone sider

l Fjerne sider
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l Slette sider

l Navngi sider på nytt

l Omarrangere sider

l Flytte objekter fra en side til en annen

l Gruppesider

Åpne sidesorteringsfunksjonen

For å åpne sidesortereren, trykk Sidesorterer .

Tilpasse sidesorteringsfunksjonen
Du kan flytte sidesortereren fra den ene siden av vinduet til SMART Notebook-programvare til

den andre ved å trykke Flytt sidefane. .

Du kan endre størrelsen til sidesortereren ved å dra kantene til venstre eller høyre. Du kan

også skjule sidesortereren når du ikke bruker den ved å velge avkryssingboksen Autoskjul

(For å vise den skjulte sidesortereren igjen, trykkSidesorterer .)

MERKNAD

Hvis du reduserer sidesorteringsfunksjonen til dens minimale størrelse skrus autoskjul-

funksjonen på automatisk.

Gallerifanen
The Gallery tab contains clip art, backgrounds, multimedia content, files and pages that you

can use in your lessons, and displays preview images of this content. The Gallery tab also

provides access to other online resources. For more information, see  Inserting content from

the Gallery på side 72.

Du kan også inkludere ditt eget innhold og innhold fra andre lærere på skolen din i gallerifanen

(se Organisere og dele innhold ved bruk av galleriet på side 85).

Åpning fanen Galleri

For å åpne gallerifanen, trykk Galleri .

Tilpasse fanen Galleri
Du kan flytte gallerifanen fra den ene siden av vinduet til SMART Notebook-programvaren til

den andre ved å trykke Flytt sidefane. .

You can resize the Gallery tab by dragging its border left or right. You can also hide the Gallery

tab when you aren’t using it by selecting the Auto-hide check box. (To display the Gallery tab

when it’s hidden, press Gallery .)
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MERKNAD

Hvis du reduserer fanen Gallery til minimumsstørrelse, slås auto-skjul-funksjonen på

automatisk.

Vedleggsfane
The Attachments tab displays the files and web pages attached to the current file. For more

information, see  Attaching files and web pages på side 84.

Åpne vedleggsfanen

For å åpne vedleggsfanen, trykk Vedlegg .

Tilpasse vedleggfanen
Du kan flytte vedleggsfanen fra en side av vinduet til SMART Notebook-programvaren til den

andre siden ved å trykke Flytt sidefane. .

You can resize the Attachments tab by dragging its border left or right. You can also hide the

Attachments tab when you aren’t using it by selecting the Auto-hide check box. (To display the

Attachments tab when it’s hidden, press Attachments .)

MERKNAD

Hvis du reduserer tilleggfanen til den minimale størrelsen, vil funksjonen "Skjul automatisk"

automatisk slås på.

Egenskaper-fane
Egenskaper-fanen lar deg formatere objekter på en side, inkludert digitalt blekk, former, linjer,

tekst og tabeller. Avhengig av objektet du velger - kan du gjøre følgende:

l Fargen, tykkelsen og linjestilen

l Gjennomsiktigheten og fylleffekten av objekter

l Skrifttypen, størrelsen og stilen på teksten

l Objektanimasjon

Egenskaperfanen viser kun alternativene som er tilgjengelig for det objektet du valgte. For

ytterligere informasjon for visning og innstillinger av objektegenskaper i egenskaperfanen, se

 Changing objects’ properties på side 53.

Egenskaperfanen inkluderer også en knapp for Sideinnspilling . Du kan bruke denne

funksjonen til å spille inn dine handlinger på den aktuelle siden (se Ta opp sider med

undervisningsopptaker på side 120).
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Åpning av egenskaperfanen

For å åpne fanen for egenskaper, trykk Egenskaper .

Tilpassing av egenskaperfanen
Du kan flytte fanen for egenskaper fra den ene siden av vinduet til SMART Notebook-

programvare til den andre ved å trykke Flytt sidefane. .

Du kan endre størrelsen til fanen for egenskaper ved å dra kantene til venstre eller høyre. Du

kan også skjule gallerifanen når du ikke bruker den ved å velge avkryssingboksen Autoskjul.

(For å vise den skjulte fanen for egenskaper igjen, trykkEgenskaper .)

MERKNAD

Hvis du reduserer egenskaperfanen til dens minimale størrelse - skrus autoskjul-funksjonen

på automatisk.

Tilleggfanen
Tilleggsfanen gir deg muligheten til å jobbe med tillegg for SMART Notebook-programvare

(se  Enhancing SMART Notebook software with add-ons på side 157).

Åpne tilleggfanen

For å åpne tilleggsfanen, trykk Tillegg .

Tilpasse tilleggfanen
Du kan flytte tilleggsfanen fra en side av vinduet til SMART Notebook-programvaren til den

andre siden ved å trykke Flytt sidefane. .

You can resize the Add-ons tab by dragging its border left or right. You can also hide the Add-

ons tab when you aren’t using it by selecting the Auto-hide check box. (To display the Add-ons

tab when it’s hidden, press Add-ons .)

MERKNAD

Hvis du reduserer tilleggfanen til den minimale størrelsen, vil funksjonen "Skjul automatisk"

automatisk slås på.

SMART Response-fanen
SMART Response-fanen er en del av SMART Response-programvaren og er kun tilgjengelig

for deg hvis du har installert SMART Response-programvaren.

Sideområdet
The page area displays the contents of a selected page in a file. This is the area of the page

where you create and work with objects (see Opprette grunnleggende objekter på side 27).
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Vise varsler for verktøyendringer
If your SMART product has Touch Recognition enabled, SMART Notebook software displays

tool change notifications when you select a new hardware tool or change a tool’s settings.

Pens, the eraser and the mouse are all hardware tools. You can also view tool change

notifications when you touch the display with your finger.

MERKNAD

Only some SMART hardware products support Touch Recognition. For more information,

refer to your SMART hardware product’s user’s guide.

Se varsler for verktøyendringer

For å bruke maskinvareverktøy eller fingeren, trykk på verktøylinjen for å velge

verktøyinnstillinger.

A status bar appears under the toolbar and shows the active tool and settings. The status

bar updates each time you select another tool or setting.

MERKNAD

Statusfanen dukker også opp når du setter blekk-innstillinger til maskinvarepennen ved

bruk av Egenskaper-fanen (se  Changing objects’ properties på side 53).

Using gestures
Du kan arbeide med objekter i SMART Notebook-programmet ved bruk av følgende gester

(dersom det støttes av ditt interaktive produkt):

Stryke (venstre til høyre) Stryke (høyre til venstre)



KAPITTEL 1
KOMME I GANG MED SMART NOTEBOOK-PROGRAMVARE

11

Klem for å zoome inn / skalere (forstørre) Klem for å zoome ut / skalere (forminske)

Panorer Roter

Riste Knips
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Angre og gjøre om handlinger
Når du utfører endringer ved en fil kan du reversere effekten av dine forrige kommandoer og

handlinger.

MERKNAD

Angre og Gjøre om påvirker handlingene til begge parter dersom to personer bruker ditt

interaktive produkt.

For å angre effekten av den siste handlingen

Trykk Angre .

MERKNAD

Du kan angre og gjøre om et ubegrenset antall handlinger.

For å sette inn igjen den siste angrede handlingen med kommandoen angre

Trykk Gjør om .
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Kapittel 2: Opprette og jobbe med filer

Creating files 13
Opening files 13
Saving files 14
Exporting files 15
Printing files 17

In SMART Notebook software, you can create or open SMART Notebook software (.notebook)

files. After creating or opening a .notebook file, you can save it, print it and complete other

common tasks.

Creating files
When you start SMART Notebook software for the first time, a tutorial file opens automatically.

When you start the software subsequent times, a new .notebook file opens automatically.

However, you can create a new file at any time.

For å opprette en fil

Velg Fil > Ny.

Opening files
Du kan åpne følgende filer med SMART Notebook 11-programmet:

l .notebook-filer (standardformatet for programvarene: SMART Notebook 9.5, 9.7, 10 og 11)

l .xbk filer (standardformatet for programvarene: SMART Notebook 8.x, 9.0 og 9.1)

Du kan lagre filen som .notebook-fil etter at du har åpnet en den.

Du åpner filer på samme vis med alle SMART Notebook-programvarer.

For å åpne en fil

1. Trykk Åpne fil .

Dialogboksen Åpne vises.
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2. Søk frem og velg filen.

3. Klikk Åpne.

TIPS

Du kan åpne nylig åpnede filer ved å velge Fil > Åpne forrige og velge filnavnet.

Saving files
By default, SMART Notebook software saves your files in .notebook format. Anyone with

SMART Notebook 9.5 or later software for Windows operating systems, Mac OS X operating

system software or Linux operating systems installed on his or her computer can open a

.notebook file.

For å lagre en ny fil

1. Trykk Lagre .

En dialogboks vises.

2. Søk deg frem til plassen du ønsker å lagre den nye filen til.

3. Tast inn et navn på filen i boksenLagre som.

4. Press Lagre .

For å lagre en eksisterende fil

Trykk Lagre .

For å lagre en eksisterende fil med nytt navn eller på nytt sted

1. Velg Fil > Lagre som.

En dialogboks vises.

2. Søk deg frem til plassen du ønsker å lagre den nye filen til.

3. Skriv inn et navn på filen i boksen Lagre som .

4. Press Lagre .

For å lagre alle åpne filer

Velg Fil > Lagre alle.



KAPITTEL 2
OPPRETTE OG JOBBE MED FILER

15 smarttech.com/kb/170656

Exporting files
Du kan eksportere .notebookfiler til følgende formater:

l Nettsider

l Bildeformater

o BMP

o JPEG

o PNG

o TIFF

l PDF

l Common File Format (CFF) for Interaktiv Tavle

NOTATER

l SMART Notebook programvaren inkluderer ikke lenker når du eksporterer filer som

nettsider, bildefiler eller PDF.

l SMART Notebook software doesn’t include attachments when you export files as

picture files or PDF. To include attachments, you must export your file as web pages.

l SMART Notebook software doesn’t export files that you attach to your .notebook file as

aliases. If you want to include an attachment, attach a copy of the file (see  Attaching

files and web pages på side 84).

l SMART Notebook software doesn’t export some gradient, pattern and image effects.

These effects might appear as a solid fill or appear incorrectly in the exported file.

To export a file as web pages

1. Velg Fil > Eksporter som > Nettside .

En dialogboks vises.

2. Bla deg frem til dit du ønsker å eksportere filen.

3. Skriv inn et navn på filen i boksen Lagre som .

4. Press Lagre .

To export a file as picture files

1. Velg Fil> Eksporter som> Bildefiler .

En dialogboks vises.

2. Velg en mappe dit du ønsker å eksportere filer.

3. Velg et bildeformat i nedtrekkslisten Bildeformat .
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4. Velg en bildestørrelse i nedtrekkslisten Bildestørrelse .

5. Skriv inn et navn på filene i boksen Lagre som .

6. Press Lagre .

To export a file as a PDF file

1. Velg Fil > Eksporter som > PDF.

En dialogboks vises.

2. Trykk Miniatyrbilder, Brosjyrer eller Helside.

3. Fyll alternativt inn overskrift i boksen for Overskrift, fotnote i boksen for Fotnote og den

aktuelle datoen i boksen for Dato.

4. Man kan alternativt velge sjekkboksen Vis sidekantlinjer for å vise kantlinjene rundt hver

av de utskrevne sidene.

5. Velg alternativt sjekkboksen Vis sidenummer for å vise sidenummer for hver side.

6. Hvis du valgte Miniatyrbilder eller Brosjyrer i steg 2, velg en miniatyrbildestørrelse i

Miniatyrstørrelse-nedtrekklisten og merk alternativt sjekkboksen Vis miniatyrtit ler for å

vise titler under hvert miniatyrbilde.

7. Trykk Fortsett.

Dialogboksen for Lagre vises.

8. Bla deg frem til dit du ønsker å eksportere filen.

9. Skriv inn et navn på filen i boksen Lagre som .

10. Press Lagre .

To export a file as a CFF file

1. Velg Fil> Eksporter som> CFF .

En dialogboks vises.

2. Bla deg frem til dit du ønsker å eksportere filen.

3. Skriv inn et navn på filen i boksen Lagre som .

4. Press Lagre .

MERKNAD

You can also import CFF files (see  Importing files from other interactive whiteboard

programs på side 80).



KAPITTEL 2
OPPRETTE OG JOBBE MED FILER

17 smarttech.com/kb/170656

Printing files
You can print all pages or select pages in a .notebook file. You can print the pages as

thumbnails, handouts or full pages.

For å skrive ut en fil

1. Velg Fil > Utskrift .

En dialogboks vises.

2. Trykk Miniatyrbilder, Brosjyrer eller Helside.

3. Fyll alternativt inn overskrift i boksen for Overskrift, fotnote i boksen for Fotnote og den

aktuelle datoen i boksen for Dato.

4. Man kan alternativt velge sjekkboksen Vis sidekantlinjer for å vise kantlinjene rundt hver

av de utskrevne sidene.

5. Velg alternativt sjekkboksen Vis sidenummer for å vise sidenummer for hver side.

6. Hvis du valgte Miniatyrbilder eller Brosjyrer i steg 2, velg en miniatyrbildestørrelse i

Miniatyrstørrelse-nedtrekklisten og merk alternativt sjekkboksen Vis miniatyrtit ler for å

vise titler under hvert miniatyrbilde.

7. Trykk Fortsett.

En dialogboks vises.

8. Hvis alle utskriftinnstillingene ikke vises, trykk på avdekkingstrekanten ved siden av

Skriver-nedtrekklisten.

9. Velg Alle for å inkludere alle sider.

ELLER

Velg Fra for å inkludere valgte sider og fyll deretter inn siderekkefølgen.

10. Velge andre utskriftinnstillinger, inkludert skrivernavn og antall kopier.

11. Klikk Utskrift .
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Kapittel 3: Opprette og jobbe med sider

Displaying pages in a file 19
Creating pages 20
Cloning pages 21
Extending pages 21
Renaming pages 22
Klippe eller kopiere og lime inn sider 22
Rearranging pages 23
Grouping pages 23
Deleting pages 24

En .notebook-fil er sammensatt av en rekke sider, hver med sine egne objekter og

egenskaper.

A thumbnail of each page appears in the Page Sorter. Using either the Page Sorter or menu

commands, you can display an existing page, create a blank page, create a clone of an

existing page or delete an existing page.

Displaying pages in a file
You can display any page in the file using the Page Sorter. You can display the next or previous

page in the file using buttons or gestures.

For å vise en side

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Trykk på miniatyrbildet av siden du ønsker å vise.

For å vise den neste siden i en fil

Trykk neste side .

ELLER

Sveip fingeren over siden fra høyre mot venstre.
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En melding som angir det gjeldende sidetallet vises.

For å vise forrige side i en fil

Trykk Forrige side .

ELLER

Sveip fingeren over siden fra venstre til høyre.

En melding som angir det gjeldende sidetallet vises.

Creating pages
Du kan legge til en tom side i den åpne filen ved hjelp av Legg til side-knappen eller

Sidesortering.

For å sette inn en side ved å bruke knappen "Legg til side"

Trykk Legg til side .

Den nye siden vises etter gjeldende side.
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For å sette inn en side ved å bruke "Sidesortering"

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Velg miniatyrbildet av siden du vil den nye siden skal vises etter.

3. Trykk på miniatyrmenypilen, og velg deretter Sett inn tom side .

Den nye siden vises etter den valgte siden.

Cloning pages
Du kan duplisere (eller “klone”) en eksisterende side istedenfor å opprette en ny side.

MERKNAD

Du kan kun klone en side dersom siden har innhold.

For å klone en side

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Velg miniatyren av siden du vil klone.

3. Trykk miniatyrbildets menypil og velg Klone siden.

Den klonede siden vises umiddelbart etter nåværende side.

MERKNAD

Du kan gjenta dette steget så mange ganger du vil.

Extending pages
If you need more room at the bottom of a page, you can extend the page vertically without

affecting the page’s width. You can turn this feature off to prevent your pages from becoming

longer.

For å utvide en side

1. Hvis du viser siden i Full Side-visningen, velg et annet zoomnivå.

2. Trykk på linken Utvid Side nederst på siden.
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 To turn Extend Page on or off 

1. Velg Vis> Utvid Side

2. Velg Av for å slå Utvid Side off.

ELLER

Velg På for å slå på Utvid Side-funksjonen.

Renaming pages
When you create a page, SMART Notebook software automatically names the page with the

date and time of its creation. You can change this name.

For å navngi en side på nytt

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Dobbeltklikk sidens navn.

3. Skriv et nytt navn du vil at siden skal hete.

4. Klikk et annet sted.

Klippe eller kopiere og lime inn sider
Du kan klippe eller kopiere og lime inn en side i den gjeldende filen ved bruk av sidesortering.

For å klippe eller lime inn en side ved bruk av "Sidesortering"

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Velg miniatyren av siden du ønsker å klippe ut.

3. Trykk miniatyrbildets menypil og velg deretter Klipp ut side eller Kopier side.

4. Velg miniatyrbildet av siden du ønsker at skal følge den innlimte siden.

5. Trykk på miniatyrbildemenypilen og velg deretter Lim inn side.

Det nye miniatyrbildet vises før miniatyrbildet du valgte i forrige steg.

TIPS

Du kan også kopiere og lime inn sider fra andre SMART Notebook-programvarefiler.
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Rearranging pages
Hvis du vil, kan du endre rekkefølgen på sider i en fil.

For å omarrangere sider

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Trykk på miniatyrbildet av siden du vil flytte i filen.

En blå ramme omgir miniatyrbildet.

3. Dra miniatyrbildet til dets nye posisjon i sidesorteringen.

En blå ramme indikerer sidens nye posisjon.

4. Slipp miniatyrbildet.

Grouping pages
You can group pages in a file. This enables you to find a particular group quickly in the Page

Sorter, and then display its pages. This is useful when there are a lot of pages in a file.

For å opprette eller redigere en gruppe

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Trykk den første gruppens menypil, og velg deretter Rediger Sidegrupper .

All the groups and pages for the current file are displayed. Groups appear as blue bars

and pages appear as thumbnails:

o Hvis du opprettet og redigerte gruppene i denne filen, kan sidene vises under de blå

søylene du opprettet og døpte om.

o Hvis du ikke har redigert gruppene, vises en standardgruppe med tittelen Gruppe 1,

som inkluderer alle sidene og deres miniatyrbilder under den blå linjen.

MERKNAD

Thumbnails below each blue bar include the same menu arrow options as thumbnails in

the Page Sorter. This enables you to press a thumbnail in a group, select its menu arrow,

and then delete the page, clear the page, insert a new page, clone the page, rename

the page, add a Screen Shade to the page or add the page to the Gallery.

3. Trykk på Legg til ny gruppe.knappen i øvre høyre hjørne.

En ny gruppe, med en ny, blank side, vises.

4. Skriv inn et nytt navn på gruppen.
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5. Gjør følgende:

o Å flytte en side i en gruppe, trykker du på miniatyrbildet for siden, og deretter drar du

den under gruppens blå linjen og til høyre for miniatyrbildet du vil den skal følge.

o For å endre rekkefølgen på sidene i en gruppe, trykker på miniatyrbildet til en side,

og drar den deretter til høyre for miniatyrbildet du vil den skal følge.

o For å endre rekkefølgen av gruppene, trykk på en gruppes blå linje, og dra den

deretter under den blå linjen til gruppen du vil at den skal følge.

NOTATER

o Du kan også endre rekkefølgen av gruppene ved å trykke på menypilen på

den blå linjen, og deretter velge Flytt opp eller Flytt ned .

o SMART Notebook software numbers pages sequentially across a file. If you

change the order of groups, SMART Notebook software renumbers the pages

in the groups accordingly.

o To delete a group and keep its pages, move all of its pages to different groups.

When a group contains no pages, SMART Notebook software automatically deletes

it.

o For å slette en gruppe, og alle sidene i gruppen, trykker du den blå linjens menypil,

og velg deretter Slett gruppe .

6. Trykk på .

For å få tilgang til en gruppe i Sidesortering

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Trykk den første gruppens menypil, og velg deretter navnet på gruppen du vil ha tilgang

til.

Sidesorteringen viser miniatyrbildet for den første siden i gruppen du vil ha tilgang til.

Deleting pages
Du kan slette en side fra den nåværende filen ved hjelp av knappen for slett side eller

sidesorteringsfunksjonen.

TIPS

Alternativt til å slette en side, kan du fjerne alle objektene på siden (se  Clearing pages på

side 151).
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For å slette en side ved å bruke knappen "Slett side"

1. Vis siden du ønsker å slette hvis du ikke allerede har gjort det.

2. Velg Slett side .

For å slette en side ved å bruke "Sidesortering"

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Velg miniatyrbildet av siden du vil slette.

3. Klikk på miniatyrbildemenypilen og velg Slett Side.
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Kapittel 4: Opprette grunnleggende objekter

Writing, drawing and erasing digital ink 28
Writing or drawing digital ink 28
Erasing digital ink 30

Creating shapes and lines 31
Creating shapes with the Shapes tool 31
Creating shapes with the Regular Polygons tool 32
Creating shapes with the Shape Recognition Pen tool 33
Creating straight lines and arcs 33

Opprette tekst 34
Typing text 34
Converting handwriting to typed text 35
Formatting text 36
Resizing text objects 38
Inserting mathematical symbols 39
Checking the spelling of text objects 39
Cutting and pasting text 40

Creating tables 41
Creating tables 41
Pasting tables from other programs 42
Adding objects to tables 43
Selecting tables, columns, rows or cells 44
Moving tables 45
Changing a table’s properties 45
Endre størrelse på tabeller, kolonner eller rader 47
Adding or removing columns, rows or cells 48
Splitting or merging table cells 49
Slette tabeller og innhold i tabeller 50

Objects are the building blocks of content in your .notebook files. An object is simply an item

on a page that you create or import and then work with. Basic types of objects include the

following:

l Digitalt blekk (frihåndskriving og tegning)

l Figurer

l Rette linjer

l Buer
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l Tekst

l Tabeller

Writing, drawing and erasing digital ink
Digital ink is freehand text or objects that you create using your interactive display’s pen or

pens, or the SMART Notebook software Pens tool. Writing or drawing digital ink enables you to

quickly add content to your SMART Notebook software files, either when creating the files or

when presenting the files to students.

Når du har opprettet digitalt blekk, kan du slette det.

Writing or drawing digital ink
Den enkleste måten å skrive eller tegne digitalt blekk er å bruke den interaktive skjermens

penn eller penner.

You can also create freehand objects using the Pens tool. The Pens tool enables you to write

or draw digital ink using the following pen types:

Pennetype Formål og eksempel Merknader

Standard
Skrive eller tegne digitalt blekk i en rekke
farger og linjestiler.

Ved bruk av en Standardpenn
kan du skrive eller tegne
digital blekk som falmer etter
noen sekunder (se  Using the
Standard pen type to create
fading objects på side 131).

Calligraphic

Skrive eller tegne digitalt blekk, som du
gjør med Standard pennetype, men med
linjer av varierende tykkelse.

Den kalligrafiske pennetypen
er nyttig for å lære elevene
håndskrift.

Crayon Skrive eller tegne fargestift-lignende
digitalt blekk.

Fargestiftpennetypen er ment
for kunstnerisk arbeid, for
eksempel maling og
fargebilder, snarere enn å
skrive.

Highlighter
Uthev tekst og andre objekter.
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Pennetype Formål og eksempel Merknader

Text Skriv notater som automatisk konverteres
til redigerbar tekst.

Du kan redigere din tekst
samtidig som du jobber uten
å bruke et tastatur (se Bruke
Tekstpennen på side 127).

Creative
Legg fargerike elementer til dine
presentasjoner.

Du kan tilpasse Kreative
pennstiler (se  Creating
custom Creative pen styles
på side 92).

Paint Brush Skrive eller tegne maling-lignende digitalt
blekk.

Malerpensel-pennetypen er

ment for kunstnerisk arbeid,

for eksempel maling og

fargebilder, snarere enn å

skrive.

Magic
Skrive eller tegne digitalt blekk som
blekner etter noen få sekunder.

Du kan også benytte deg av
Magipennen for å åpne et
forstørrelsesvindu eller et
følgespotvindu (se  Using the
Magic Pen på side 123).

Shape
Recognition

Tegn en rekke figurer med digitalt blekk. Du kan tegne sirkler, ovaler,
firkanter, trekanter og buer
(se  Creating shapes with the
Shape Recognition Pen tool
på side 33).

For å skrive eller tegne med digitalt blekk

1. Press Penner .

Knappene for pennverktøy vises.

2. Press Pennetyper , og velg deretter en pennetype.

3. Velg en linjetype.
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4. Tilpass eventuelt linjetypen ved hjelp av egenskapsvelgere.

MERKNAD

Du kan også tilpasse strektypen via Egenskaper-fanen (se  Changing objects’

properties på side 53).

5. Skrive eller tegne digitalt blekk på siden.

TIPS

o Ikke hvil albuen eller håndflaten på det interaktive produktets overflate mens du

skriver eller tegner.

o If you write or draw multiple lines, SMART Notebook software automatically

combines the lines into a single object. For example, if you write the letters of a

word, SMART Notebook software combines the individual letters, enabling you to

interact with the whole word. If you want to write words on the same line but don’t

want them combined, leave a large gap between them, use different pens, or

briefly put the pen in the pen tray before writing another word (interactive

whiteboards only).

o Hvis du vil skrive skriften diagonalt kan du først skrive i en rett linje og deretter

rotere linjen (se  Rotating objects på side 65).

o Hvis du vil skrive i små bokstaver kan du skrive store bokstaver og redusere

størrelsen etterpå (se  Resizing objects på side 62).

o Du kan fylle områder du har omsluttet med digital blekk (se  Filling digital ink

drawings på side 55).

Erasing digital ink
You can erase digital ink from your interactive display using the eraser or the erasing gesture. If

you’re erasing digital ink from a .notebook file page, you can also erase objects using the

Eraser tool.

MERKNAD

Although you can erase digital ink, you’re unable to erase other types of objects, including

shapes, lines, text and pictures. To remove these types of objects, you must delete them

(see  Deleting objects på side 68).

Viske ut digitalt blekk

1. Trykk Viskelær og deretter velg viskelærtype.

2. Slette digitalt blekk.
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Creating shapes and lines
I tillegg til å skape frihåndsfigurer og linjer ved å tegne med digitalt blekk kan du lage figurer

og linjer ved hjelp av verktøyene i SMART Notebook-programvaren.

MERKNAD

To remove a shape or line from a page, you must delete it (see  Deleting objects på

side 68). The Eraser tool doesn’t remove shapes.

Creating shapes with the Shapes tool
Du kan bruke Figurverktøyet for å lage en rekke figurer, inkludert perfekte sirkler, perfekte

firkanter, perfekt trekanter, andre geometriske figurer, hjerter, haker og X-tegn.

You can add a shape to your page, and then edit its properties. Alternatively, you can

customize a shape’s outline color, fill color and line thickness, and then add it to your page.

Å skape en figur

1. Trykk Figurer .

Figurverktøyknappene vises.

2. Velg en figur på verktøylinjen.

ELLER

Klikk og velg deretter en figur.

3. Eventuelt tilpass figuren ved hjelp av egenskapinnstillingene.

MERKNAD

Du kan også tilpasse figuren ved hjelp av kategorien Egenskaper (se  Changing

objects’ properties på side 53 ).
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4. Opprett en figur ved å trykke der du vil plassere figuren, og dra helt til figuren har den

størrelsen du ønsker.

TIPS

o Du kan opprette perfekte sirkler, firkanter, trekanter og andre figurer ved å holde

nede SHIFT mens du tegner figuren.

o You can select a shape while the Shapes tool is active without having to switch

to the Select tool . Press the shape once, and a selection rectangle appears

around the shape.

Creating shapes with the Regular Polygons tool
I tillegg til å skape figurer ved hjelp Figurverktøyet, kan du lage regelmessige polygoner med

3 til 15 sider med vektøyet for Regelmessige Polygoner.

For å opprette en figur med den verktøyet for Regelmessige Polygoner

1. Trykk Regelmessige polygoner .

Verktøytastene for Regelmessige polygoner vises.

2. Velg en figur på verktøylinjen.

ELLER

Klikk og velg deretter en figur.

MERKNAD

Tallet i formen indikerer hvor mange sider den har.

3. Eventuelt tilpass figuren ved hjelp av egenskapinnstillingene.

MERKNAD

Du kan også tilpasse figuren ved hjelp av kategorien Egenskaper (se  Changing

objects’ properties på side 53 ).

4. Opprett en figur ved å trykke der du vil plassere figuren, og dra helt til figuren har den

størrelsen du ønsker.
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Creating shapes with the Shape Recognition Pen tool
Du kan bruke penneverktøyet for figurgjenkjenning for å tegne sirkler, ovaler, kvadrater,

rektangler, trekanter og buer.

MERKNAD

Du kan også lage figurer ved hjelp Figurverktøyet (se  Creating shapes with the Shapes tool

på side 31 ) eller verktøyet for regelmessige polygoner (se    Creating shapes with the

Regular Polygons tool på forrige side ).

For å tegne en figur

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Figurgjenkjennelsespenn.

3. Tegn en figur på siden.

Hvis SMART Notebook-programvaren gjenkjenner tegningen som en sirkel, oval,

kvadrat, rektangel, trekant eller bue, legger det figuren til siden.

Creating straight lines and arcs
Du kan bruke Strekverktøyet for å tegne rette linjer og buer.

You can add a line to your page, and then edit its properties. Alternatively, you can customize

the line, and then add it to your page.
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Å skape en rett linje eller bue

1. Trykk Linjer .

Strekverktøyknappene vises.

2. Velg en strek- eller buetype.

3. Eventuelt kan du tilpasse strek- eller buetypen med egenskpasinnstillinger.

MERKNAD

Du kan også tilpasse linje- eller buetype ved å bruke Egenskaper-kategorien (se

 Changing objects’ properties på side 53 ).

4. Lag en linje ved å trykke der du vil at linjen skal starte, og dra den til der du vil at den skal

slutte.

Opprette tekst
Du kan lage tekst i SMART Notebook-programvaren ved å gjøre ett av følgende:

l Skrive inn tekst ved hjelp av et tastatur som er koblet til datamaskinen

l Skrive inn tekst ved hjelp av SMART-tastaturet

l Skrive teksten (se  Writing, drawing and erasing digital ink på side 28 ), og deretter

konvertere den til skrevet tekst ved hjelp av programvaren for håndskriftgjenkjenning

Når du har opprettet tekst, kan du redigere den, sjekke stavemåten og endre dens

egenskaper, inkludert skriftstil, størrelse og farge.

Typing text
Du kan skrive ny tekst eller redigere eksisterende tekst.

For å skrive en ny tekst

1. Hvis tastaturet ikke er tilgjengelig, trykk og hold inne SMART Board-verktøy i dokken

og deretter velg Tastatur.

2. Trykk Tekst og deretter velg en tilgjengelig skrifttype.

3. Du kan også tilpasse skrifttypen (se  Formatting text på side 36).
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4. Klikk der du vil at teksten skal begynne fra.

5. Skriv tekst.

6. Klikk på utsiden av tekstobjektet når du er ferdig.

For å redigere en eksisterende tekst

1. Dobbeltklikk tekstobjektet.

2. Rediger teksten.

3. Klikk på utsiden av tekstobjektet når du er ferdig.

Converting handwriting to typed text
You can write on your interactive product’s screen using the Standard or Calligraphic pen

types and convert your writing to typed text. SMART Notebook software can convert

handwriting in multiple languages.

For å konvertere håndskrift t il maskinskrevet tekst

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Penn eller Kalligrafipenn.

3. Skriv tekst.

TIPS

Write tidy, printed characters on a horizontal line. Although SMART Notebook software

can convert slanted or cursive writing, it doesn’t always do so consistently.

4. Velg tekstobjektet.

Funksjonen for håndskriftgjenkjenning i SMART Notebook-programvaren sammenligner

skriften din med programvarens ordbok og identifiserer ord som ligner mest på det du har

skrevet.
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5. Klikk tekstobjektets menypil.

En meny dukker frem og viser en liste over matchende ord. Hvert ord etterfølges av

Gjenkjenn.

NOTATER

o If you want SMART Notebook software to identify words in a different language,

select Recognize Languages, and then select another language in the list.

SMART Notebook software updates the list of matching words to include words in

the selected language.

o Når du endrer håndskriftgjenkjenningsspråket, endrer du ikke standardspråket til

SMART Notebook-programvarens grensesnitt eller ditt operativsystem.

6. Velg et ord fra en liste over matchende ord.

Det utvalgte ordet vises på siden.

Formatting text
Hvis du ønsker å formatere all tekst i et tekstobjekt, velger du tekstobjektet.

ELLER

Hvis du vil formatere en bestemt tekst i et tekstobjekt, dobbeltklikker du på tekstobjektet, og

velg deretter teksten.

Du kan formatere tekst ved hjelp av knappene på verktøylinjen eller alternativene i kategorien

Egenskaper eller Format-menyen.

MERKNAD

Hvis fanen over egenskaper ikke vises, trykk Egenskaper og deretter trykk Tekststil.

Tabellen under presenterer formatendringer som du kan gjøre ved hjelp av de ovennevnte

verktøy:

Endre Verktøylinje Egenskaper-
fane

Format-
menyen

Character, avsnitt eller objektnivå

Endre skrifttype
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Endre Verktøylinje Egenskaper-
fane

Format-
menyen

Endre skriftstørrelse

TIPS

For å velge en skriftstørrelse som ikke vises i
rullegardinlisten (inkludert skriftstørrelser med
desimaler verdier som 20,5), skriv
skriftstørrelsen i boksen for Skriftstørrelse på
verktøylinjen.

Endre fargen

Fet, kursiv eller understreket tekst

Gjennomstreket tekst 1

Hevet eller senket tekst 2

Avsnitt- eller objektnivå

Endre tekstjusteringen (venstre, høyre eller
midtstilt)

Endre innrykk 3

Lag en punktmerket eller nummerert liste 4

Sett inn en droppgrense

TIPS

For å sette inn en droppgrense i begynnelsen
av en paragraf, trykk Droppgrense

undertekststili fanenfor egenskaper.

ELLER

Velg Format> Avsnitt> Uthevet Bokstav .

1Under More Text Options

2Under More Text Options

3Under More Text Options

4Under More Text Options
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Endre Verktøylinje Egenskaper-
fane

Format-
menyen

Endre linjeavstand

TIPS

For å legge til avstand mellom avsnittene, velg
avkryssningsboksen for Sett inn mellomrom
etter avsnitt i fanen for Egenskaper eller velg
Format> Avsnitt> Linjeavstand> Sett inn
mellomrom etter avsnitt .

Endre språkretningen (venstre mot høyre eller
høyre mot venstre)

MERKNAD

Velg Format> Avsnitt> Retning> Venstre til
Høyre for språk som leses fra venstre mot
høyre (for eksempel engelsk og fransk).

ELLER

Velg Format> Avsnitt> Retning> Høyre til
venstre for språk som leses fra høyre mot
venstre (for eksempel arabisk og hebraisk).

Objektnivå

Endre tekstretning (horisontal eller vertikal) 5

Juster gjennomsiktigheten.

Resizing text objects
Når du endrer størrelsen på et objekt i henhold til forklaringen i  Resizing objects på side 62, vil

teksten i objektet også endre størrelse.

Følg denne prosedyren hvis du vil endre størrelsen på tekstobjektet uten å endre størrelsen

på teksten i objektet.

For å endre størrelsen på en tekstobjekt

1. Dobbeltklikk tekstobjektet.

2. Klikk en av de to hvite sirklene du finner på hver side av tekstobjektet og dra sirkelen for

å øke eller redusere størrelsen på tekstobjektet.

5Under More Text Options
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Inserting mathematical symbols
Du kan sette en rekke matematiske og vitenskapelige symboler inn på en side.

MERKNAD

The mathematical symbols are characters only. They don’t perform mathematical

operations.

For å skrive et matematisk symbol

1. Skriv tekst på siden.

2. Trykk Flere tekstalternativer og deretter velg Sett inn symbol .

Tegn -dialogboksen vises.

3. Klikk en kategori.

En liste over symboler vises.

4. Klikk symbolet du vil legge til teksten.

5. Klikk Sett inn.

Symbolet vises i tekstobjektet.

Checking the spelling of text objects
As you type text, SMART Notebook software checks the spelling. If you spell a word

incorrectly, SMART Notebook software underlines the word red. You can then right-click the

word and select the correct spelling from a list of options.

Du kan deaktivere denne funksjonen og kjøre stavekontroll via stavekontroll -dialogboksen

dersom du foretrekker det.

For å deaktivere automatisk stavekontroll

1. Trykk Tekst .

2. Trykk Flere tekstalternativer og deretter velg Stavekontroll .

For å sjekke stavemåten av et tekstobjekt manuelt

1. Velg tekstobjektet.

2. Klikk objektets menypil og velg Stavekontroll.

If SMART Notebook software finds a misspelled word, the Spelling Check dialog box

appears. This dialog box displays the misspelled word and suggests alternatives.
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3. Du kan utføre en av de følgende handlingene for en stavefeil:

o Beholde den nåværende stavelsen ved å klikke Ignorer en gang.

o Beholde den nåværende stavelsen for alle tilfeller i filen ved å klikke Ignorer alle.

o Beholde den nåværende stavelsen for alle tilfeller i filen og legge stavelsen til

ordboken ved å klikke Legg til ordbok.

o Endre stavelsen for dette tilfellet ved å velge den rette stavelsen i forslag -listen og

klikke Endre.

o Endre stavelsen i alle tilfeller i filen ved å velge den rette stavelsen i forslag -listen

og klikke Endre alle.

MERKNAD

I tilfelle du trykket en knapp ved uhell - kan du klikke Angre for å endre på din forrige

handling.

En dialogboks vises etter at du har fullført dette steget for hver feilstavelse, den spør deg

om du ønsker å kjøre stavekontroll på resten av filen.

4. Klikk Ja for å sjekke resten av filen.

ELLER

Klikk Nei for å lukke stavekontroll -dialogboksen uten å sjekke resten av filen.

Cutting and pasting text
You can cut, copy and paste text objects like any other objects (see  Cutting, copying and

pasting objects på side 60). You can also cut and paste text in a text object.

Klippe ut og lime inn tekst til et annet sted på samme side

1. Dobbeltklikk tekstobjektet.

2. Velg teksten du vil klippe.

3. Dra den utvalgte teksten til en annen plass på den samme siden.

Klippe ut og lime inn tekst på en annen side

1. Hvis sidesorteringsfanen ikke vises, trykk Sidesortering .

2. Dobbeltklikk tekstobjektet.

3. Velg teksten du vil kopiere.

4. Dra den utvalgte teksten til ikonet for den andre siden i sidesorteringsfanen.
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Creating tables
You can create tables in SMART Notebook software or paste them from other programs. After

you create a table, you can insert objects into the table’s cells.

Hvis du vil tilpasse en tabell, kan du velge en tabell, kolonne, rad, celle eller utvalg av celler,

og gjør ett av følgende:

l Flytt tabellen

l Endre strektype, fyll og tekstegenskaper

l Endre størrelsen på tabellen, en kolonne eller rad

l Sette inn eller fjerne kolonner, rader eller celler

l Dele eller slå sammen celler

l Slette tabellen

Creating tables

For å sette inn en tabell ved hjelp av Tabellknappen

1. Trykk Tabell .

Et rutenett vises.

2. Flytt pekeren over rutenettet for å velge antall kolonner og rader som du vil bruke i

tabellen.

MERKNAD

Cellene i rutenettet tilsvarer cellene i tabellen din.

TIPS

The grid displays eight rows and eight columns by default. You can add rows by moving

the pointer past the bottom row. Similarly, you can add columns by moving the pointer

past the right row.

Hvis du bruker en mus, klikk og hold museknappen nede mens du flytter pekeren.

3. Trykk på skjermen eller klikk med musen.

Tabellen vises på siden.

For å sette inn en tabell ved hjelp av Sett inn Tabell-dialogboksen

1. Velg Sett inn> Tabell .

Dialogboksen for å Sette inn tabell vises.
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2. Skriv inn antall rader og kolonner i boksene.

3. Du kan også velge Gjør cellene firkantede for å lage firkantede celler.

4. Du kan også velge Husk dimensjoner for nye tabeller for å bruke nåværende

tabelldimensjon for alle fremtidige tabeller du oppretter i SMART Notebook-

programvaren.

5. Press OK .

Tabellen vises på siden.

Hvis du vil tegne en tabell

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Penn eller Kalligrafipenn.

3. Velg en linjetype.

4. Tegn en tabell på skjermen.

TIPS

Gjør strekene i tabellen så rette som mulig, og koble sammen hjørnene.

5. Trykk Velg .

6. Velg tegningen din.

7. Klikk menypilen, og velg deretter Gjenkjenn tabell.

Hvis SMART Notebook-programvaren gjenkjenner tegningen som en tabell, fjerner den

tegningen din og legger til en tabell på siden.

Pasting tables from other programs
You can cut or copy a table from Word or PowerPoint®, and then paste it into a .notebook file.

The table’s formatting and layout can vary when the table appears in the .notebook file.

Hvis du vil klippe eller kopiere mer enn en tabell må du kutte eller kopiere hver tabell for seg.
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MERKNAD

You can also cut or copy a table from a .notebook file, and then paste it into Word or

PowerPoint. However, the table’s formatting and layout can vary when the table appears in

Word or PowerPoint.

Hvis du limer en tabell som har celler som inneholder ikke-teksobjekter inn i PowerPoint vil

ikke-tekstobjektene vises utenfor tabellen i PowerPoint.

Adding objects to tables
Når du setter inn en tabell på en side, kan du sette inn objekter i tabellens celler.

MERKNAD

You can add only one object to each cell. If you want to add multiple objects to a cell, do

one of the following:

l Grupper objektene før du legger dem til i tabbellen (se  Grouping objects på side 67 ).

l Select all of the objects at once, and then add them to the table as described in the

following procedure. SMART Notebook software automatically groups the objects in

the table cell.

For å legge til et objekt i en tabell

1. Velg objektet.

2. Dra objektet til tabellcellen.

MERKNAD

Du er ikke i stand til å flytte et objekt hvis den er låst på plass (se Låse objekter på

side 97 ).

Objektet vises i tabellcellen.

MERKNAD

If you add a text object to a table, the cell resizes to fit to the text object. If you add

other object types to the table, the object resizes to fit the cell.

Hvis du vil fjerne et objekt fra en tabell

1. Velg objektet.

2. Dra objektet ut av tabellen.
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Selecting tables, columns, rows or cells
You can select a table, column, row, cell or selection of cells. After you select a table or part of

a table, you can do the following:

l Flytt tabellen

l Endre tabellen eller cellenes egenskaper

l Endre størrelsen på tabellen, kolonnene eller radene

l Legge til eller fjerne kolonner, rader eller celler

l Dele eller slå sammen celler

l Slette tabellen

For å velge en tabell

1. Trykk Velg .

2. Klikk utsiden av - men nært - et hjørne på tabellen og dra mot det motsatte hjørnet.

MERKNAD

Don’t start dragging from inside the table. If you do, you select a table cell instead of the

table.

For å velge en kolonne

1. Trykk Velg .

2. Klikk innsiden av kolonnens øverste celle og dra mot den nederste cellen.

For å velge en rad

1. Trykk Velg .

2. Klikk på innsiden av cellen som er lengst mot venstre i en rad og dra mot cellen som er

lengst mot høyre.

For å velge en celle

1. Trykk Velg .

2. Klikk på innsiden av cellen.



KAPITTEL 4
OPPRETTE GRUNNLEGGENDE OBJEKTER

45 smarttech.com/kb/170656

For å velge flere celler

1. Trykk Velg .

2. Klikk på innsiden av cellen øverst til venstre og dra ned mot cellen som er nederst til

høyre.

MERKNAD

Hvis du velger flere celler og drar dem til en annen plass på siden - skaper du en ny

tabell med de utvalgte cellene og deres innhold.

Moving tables
Du kan flytte tabellen på siden etter at du har opprettet den.

Å flytte en tabell

Velg tabellen og dra den til en annen plass på siden.

ELLER

Velg alle cellene i tabellen og dra de til en annen plass på siden.

Changing a table’s properties
Du kan benytte deg av Egenskaper-fanen for å endre tabellens egenskaper, inkludert dens

gjennomsiktighet, celle- og linjefarge.

For å endre tabellfyll

1. Velg en tabell, kolonne, rad, celle, eller et utvalg av flere celler.

2. Trykk menypilen til tabellen, kolonnen, raden eller cellen og velg Egenskaper.

3. Klikk Fyll effekter.
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4. Velg en fyllstil:

Fyllstil Framgangsmåte

Ingen
(gjennomsiktig)

Velg Ingen fyll.

Klar farge a. Velg Klart fyll .

b. Gjør en av følgende:

o Velg ett av de 40 fargene i paletten.

o Press Mer , og velg deretter en farge i dialogboksen.

o Press på dråpetelleren for å velge en farge på
skjermen.

Gradient av to farger a. Velg Gradientfyll .

b. For hver farge, gjør ett av følgende:

o Velg ett av de 40 fargene i paletten.

o Press Mer , og velg deretter en farge i dialogboksen.

o Press på dråpetelleren for å velge en farge på
skjermen.

c. Velg et alternativ i Stilnedtrekkslisten .

Mønster a. Velg Mønsterfyll .

b. Velg et mønster.

Bilde a. Velg Bildefyllet .

b. Press Bla .

c. Bla og velg bildet du ønsker å bruke og trykk deretter på
Åpne.

MERKNAD

If you insert a large picture, a dialog box may appear and
prompt you to either reduce the picture’s file size or retain
the picture’s file size. For more information, see  Setting
image optimization preferences på side 168.

d. Velg Behold bildestørrelse for å beholde bildestørrelsen,
uavhengig om bildet er større eller mindre enn objektet.

ELLER

Velg Skaler bilde for å passe for å omgjøre størrelsen av
bildet slik at det passer til objektet.

5. Alternativt kan du dra glidebryteren for Objektgjennomsiktighet til høyre for å gjøre

tabellen gjennomsiktig.
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For å endre linjestilen til en tabell

1. Velg en tabell.

MERKNAD

Du kan kun endre linjestilen til en hel tabell, ikke individuelle celler, kolonner eller rader.

2. Trykk menypilen til tabellen, kolonnen, raden eller cellen og velg Egenskaper.

3. Klikk Linjestil.

4. Endre tabellens linjestil.

For å endre teksstilen til en tabell

1. Velg en tabell, kolonne, rad, celle, eller et utvalg av flere celler.

2. Trykk menypilen til tabellen, kolonnen, raden eller cellen og velg Egenskaper.

3. Klikk Tekststil.

4. Endre tabellens tekststil (se  Formatting text på side 36 ).

Endre størrelse på tabeller, kolonner eller rader
Hvis du vil tilpasse en tabell kan du endre størrelsen på tabellen, en kolonne eller en rad.

For å endre størrelsen på en tabell

1. Velg tabellen.

2. Klikk tabellens knapp for størrelsesendring (den grå sirkelen) og dra for å øke eller

redusere tabellens størrelse.

For å endre størrelsen på en kolonne

1. Trykk Velg .

2. Klikk den vertikale kanten på høyre side av kolonnen.

En forstørrings-/forminskingspeker vises.

3. Dra den vertikale kanten for å endre størrelsen på kolonnen.

For å endre størrelsen på en rad

1. Trykk Velg .

2. Klikk den horisontale kanten nedenfor raden.

En forstørrings-/forminskingspeker vises.

3. Dra den horisontale kanten for å endre størrelsen på raden.
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For å endre størrelsen på alle cellene i en tabell

1. Velg tabellen.

2. Klikk tabellens menypil og velg Juster størrelse.

3. Velg en av de følgende alternativene:

o Still inn lik høyde for å gjøre alle cellene i tabellen like høye.

o Still inn lik bredde for å gjøre alle cellene i tabellen like brede.

o Still inn lik størrelse for å gjøre alle cellene i tabellen like i høyde og bredde.

o Opprett firkantede celler for å gjøre alle cellene i tabellen firkantede.

Adding or removing columns, rows or cells
Hvis du vil tilpasse en tabell, kan du legge til kolonner og rader.

For å legge til en kolonne

1. Velg en kolonne.

2. Trykk på kolonnemenypilen, og velg deretter Sett inn kolonne .

En ny kolonne vises til høyre for den aktuelle kolonnen.

Slik fjerner du en kolonne

1. Velg kolonnen.

2. Trykk på kolonnemenypilen, og velg deretter Slett Kolonne.

For å legge til en rad

1. Velg en rad.

2. Trykk på radmenypilen, og velg deretter Sett inn Rad .

En ny rad vises under gjeldende rad.

Hvis du vil fjerne en rad

1. Velg raden.

2. Trykk på radmenypilen, og velg deretter Slett Rad .
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Hvis du vil fjerne en celle

1. Velg cellen.

2. Trykk cellens menypil og velg deretter Slett celler.

MERKNAD

o Å fjerne en celle sletter innholdet i cellen.

o Du er ikke i stand til å fjerne en celle hvis den er den eneste forbindelsen mellom

to halvdeler av en tabell.

Splitting or merging table cells
You can add tables to your page and insert objects into the table’s cells. If you want to

customize a table, you can split or merge cells.

For å dele en celle

1. Velg cellen.

2. Klikk cellens menypil og velg Sammenslå.

3. Velg et alternativ for å dele cellen i flere rader og/eller kolonner.

MERKNAD

Hvis du deler en celle med innhold vil innholdet vises i cellen ovenfor til venstre etter

delingen.

For å sammenslå celler sammen

1. Velg cellene.

2. Klikk cellens menypil og velg Sammenslå celler.

MERKNAD

If you merge cells that contain content, the merged cell contains the contents of the

top-left cell. If the top-left cell is empty, the merged cell contains the contents of the

next available non-empty cell, moving from left to right, top to bottom.
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Slette tabeller og innhold i tabeller
Du kan slette innholdet i en tabell eller selve tabellen.

MERKNAD

Du kan slette alle objekter på en side, som tabeller, ved å tømme siden (se  Clearing pages

på side 151 ).

For å slette innholdet i en tabell

1. Merk cellene med innholdet du vil slette.

2. Trykk Slett .

Slik sletter du en tabell

1. Velg tabellen.

2. Klikk tabellens menypil og velg Slett.
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Kapittel 5: Jobbe med objekter

Selecting objects 52
Changing objects’ properties 53

Endre fyllet 53
Filling digital ink drawings 55

Endring av andre egenskaper 56
Saving tool settings 56

Posisjonere objekter 56
Moving objects 56
Moving objects to another page 57
Aligning objects 58
Rearranging stacked objects 59

Cutting, copying and pasting objects 60
Beskjære bilder med en maske 61
Cloning objects 62
Resizing objects 62

Bruk av knappen for størrelsesendring 63
Using the scale gesture 63

Rotating objects 65
Bruke rotasjonshåndtaket 65
Bruk av roteringsgesten 65

Flipping objects 66
Grouping objects 67

Gruppere objekter manuelt 67
Bruke menyen 67
Bruke ristebevegelsen 67

Gruppere objekter automatisk 68
Deleting objects 68

Når du har opprettet et objekt, kan du velge det og jobbe med det som er beskrevet i dette

kapitlet.

MERKNAD

Oppgavene som er beskrevet i dette kapitlet er for alle objekter, ikke bare grunnleggende

objekter.
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Selecting objects
Before you can work with an object, you must select it. You can select an individual object,

multiple objects or all objects on a page. When you select an object, a selection rectangle

appears around it.

Den grå sirkelen i hjørnet nederst til høyre på objektet er en knapp til å endre størrelsen (se

 Resizing objects på side 62).

Den grønne sirkelen over objektet er en roteringsknapp (se  Rotating objects på side 65).

The downward arrow in the object’s upper-right corner is a menu arrow. Press the menu arrow

to display a menu of commands.

MERKNAD

Når du trykker objektets menypil får du tilgang til den samme menyen som du får når du

CTRL-klikker objektet.

For å velge et objekt

1. Trykk Velg .

2. Trykk på objektet du vil velge.

Et valgrektangel omgir objektet.

MERKNAD

If you press an object and a lock symbol appears instead of the menu arrow, the object

is locked. Depending on the type of lock, you might have to unlock the object before

you can manipulate it (see Låse objekter på side 97).
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For å velge flere objekter

1. Trykk Velg .

2. Klikk den interaktive skjermen og dra helt til du får en rektangel rundt objektene du

ønsker å velge.

ELLER

Hold COMMAND-knappen (⌘) inne og klikk objektene du vil velge.

En valgrektangel vises rundt de valgte objektene.

MERKNAD

Hvis du tegner en rektangel rundt flere objekter og noen av objektene er fastlåste (se

Låse objekter på side 97) betyr dette at du kun velger de ulåste objektene.

For å velge alle objektene på en side

Velg Rediger > Velg alle.

En valgrektangel vises rundt alle objektene på siden.

MERKNAD

Dersom noen av objektene er fastlåste (se Låse objekter på side 97), velger du kun de

ulåste objektene.

For å velge alle låste objekter på siden

Velg Rediger > Velg alle låste notater.

En valgrektangel vises rundt alle låste objekter på siden.

Changing objects’ properties
You can change an object’s properties. The properties you can change depend on the object

you select. You can also select several objects and change their properties at the same time.

Endre fyllet
Du kan endre objektets fyll ved å velge objektet og deretter still inn fyll i fanen for egenskaper

eller ved å klikke Fyll , innstilling av fyll og deretter velge objektet.

Endre et objekts fyll ved først å velge objektet

1. Velg objektet.

2. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .
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3. Klikk Fyll effekter.

4. Velg en fyllstil:

Fyllstil Framgangsmåte

Ingen
(gjennomsiktig)

Velg Ingen fyll.

Klar farge a. Velg Klart fyll .

b. Gjør en av følgende:

o Velg ett av de 40 fargene i paletten.

o Press Mer , og velg deretter en farge i dialogboksen.

o Press på dråpetelleren for å velge en farge på
skjermen.

Gradient av to farger a. Velg Gradientfyll .

b. For hver farge, gjør ett av følgende:

o Velg ett av de 40 fargene i paletten.

o Press Mer , og velg deretter en farge i dialogboksen.

o Press på dråpetelleren for å velge en farge på
skjermen.

c. Velg et alternativ i Stilnedtrekkslisten .

Mønster a. Velg Mønsterfyll .

b. Velg et mønster.

Bilde a. Velg Bildefyllet .

b. Press Bla .

c. Bla og velg bildet du ønsker å bruke og trykk deretter på
Åpne.

MERKNAD

If you insert a large picture, a dialog box may appear and
prompt you to either reduce the picture’s file size or retain
the picture’s file size. For more information, see  Setting
image optimization preferences på side 168.

d. Velg Behold bildestørrelse for å beholde bildestørrelsen,
uavhengig om bildet er større eller mindre enn objektet.

ELLER

Velg Skaler bilde for å passe for å omgjøre størrelsen av
bildet slik at det passer til objektet.

5. Alternativt kan du dra glidebryteren for objektgjennomsiktighet til høyre for å gjøre

objektet gjennomsiktig.

TIPS

Du kan også endre egenskapene til et objekt via egenskapsvelgerne på verktøylinjen.
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Endre et objekts fyll ved først å trykke på Fyll-knappen

1. Trykk Fyll og deretter velg farge.

2. Velg objektet.

3. Gjenta steg 2 for hvert objekt du vil fylle.

Filling digital ink drawings
I tillegg til å fylle former, regulære og irregulære polygoner, kan du fylle former som er tegnet

med digitalt blekk - ved bruk av Fyll -knappen.

NOTATER

l For å fylle et område må du omslutte det med en enkel strek i digitalt blekk.

l Du er ikke i stand til å fylle et lukket område hvis dette området er en del av en gruppe

(se  Grouping objects på side 67 ).

l When you fill an enclosed area, the fill becomes a separate object, which you can move

away from the original enclosed area. You can fill the enclosed area and move the

resulting fill object multiple times.
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Endring av andre egenskaper
I tillegg til fyll, kan du også endre objektets linje- og tekststiler.

For å endre linjestilen til et objekt

1. Velg objektet.

2. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

3. Klikk Linjestil.

4. Endre objektets linjestil.

For å endre teksstilen til en tabell

1. Velg objektet.

2. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

3. Klikk Tekststil.

4. Endre objektets tekststil (se  Formatting text på side 36 ).

Saving tool settings
Når du velger et verktøy fra verktøylinjen kan du endre dets standardinnstillinger via

egenskaperfanen og lagre endringene dine ved å klikke Lagre verktøysinnstillinger.

Når du lagrer endringene ved verktøyets standardinnstillinger vil verktøyets knapp vise de

endringene:

For å gjenopprette standardinnstillingene, se  Customizing the toolbar på side 165 .

Posisjonere objekter
You can change the position of an object by moving it to another area of the existing page or

to another page. You can also align objects and change the order of stacked objects.

Moving objects
You can move objects to another position on the page. You can also flick objects.

MERKNAD

Du kan ikke flytte et objekt dersom det er låst på plass (se Låse objekter på side 97).
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TIPS

Du kan manipulere flere objekter ved å velge dem og opprette en gruppe (se  Grouping

objects på side 67).

For å flytte ett eller flere objekter

1. Velg objektet eller objektene.

2. Dra objektet eller objektene til en ny plassering på siden.

TIPS

Du kan flytte et objekt i små steg ved å trykke piltastene på tastaturet.

For å flytte en Adobe® Flash® Player kompatibel fil

1. Klikk den fargede linjen øverst på den Adobe Flash Player-kompatible filen.

2. Dra filen til dens nye plassering.

To flick an object

1. Velg objektet.

2. Knips raskt fingeren i en retning.

Moving objects to another page
Du kan flytte objekter til en annen side i filen.

For å flytte en eller flere objekter til en annen side

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Hvis du ikke ser siden du vil flytte objektet til kan du rulle i sidesorteringsfunksjonen til du

ser sidens miniatyrbilde.

3. Velg objektet eller objekter du vil flytte.

4. Dra objektet eller objektene inn i sidesorteringen over miniatyrbildet av siden du vil flytte

objektene til.
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For å flytte en Adobe Flash Player kompatibel fil t il en annen side

1. Hvis sidesortering ikke er synlig, trykk Sidesortering .

2. Hvis du ikke ser siden du vil flytte objektet til kan du rulle i sidesorteringsfunksjonen til du

ser sidens miniatyrbilde.

3. Klikk den fargede linjen øverst på den Adobe Flash Player-kompatible filen.

4. Dra filen inn på sidesorteringsfunksjonen ovenfor miniatyrbildet til siden ønsker å flytte

objektet til.

Aligning objects
You can use the Alignment Tools add-on to align and distribute objects on a page. You can

align selected objects on the bottom, left, right, top, vertically or horizontally. You can also

align stacked objects vertically or horizontally.

If you want, you can display guidelines on a page to assist you in manually aligning objects with

other objects, as well as the page’s vertical and horizontal centers. You can also set objects to

align automatically with these guidelines when you move the objects on a page (see side 56).

Å justere objekter på en side

1. Velg objektene du vil justere (se  Selecting objects på side 52 ).

2. Trykk Tillegg på verktøylinjen for å vise innrettingens verktøyknapper.

3. Trykk på en innrettingsknapp:

Knapp Navn Velg denne knappen for å:

Innrette bunn Innretter valgte objekter langs bunnkanten.

Innrette venstre Innretter valgte objekter langs objektenes venstre kant.

Innrette midtre

X

Innretter valgte objekter vertikalt gjennom midten av
objektene.

Innrette midtre

Y

Innretter valgte objekter horisontalt gjennom midten av
objektene.

Innrette til

høyre

Innretter valgte objekter langs objektenes høyre kant

Innrette til

toppen

Innretter valgte objekter langs objektenes toppkant

Stable

horisontalt

Innretter den valgte stabelen av objekter horisontalt.

Innrette

vertikalt

Innretter den valgte stabelen av objekter vertikalt.
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For å vise retningslinjer

1. Velg Vis > Innretting.

En dialogboks vises.

2. Velg sjekkboksene for å spesifisere retningslinjene du ønsker å vise:

Avmerkingsboks Velg denne avmerkingsboksen for å:

Vis retningslinjer for
aktive objekter

Vis en retningslinje for hvordan du flytter et objekt for å innrette et
annet objekt.

Vis vertikal
sidesentrumretning

Viser en retningslinje for hvordan du flytter et objekt for å innrette
det etter sidens vertikale sentrum.

Vis horisontal
sidesentrumretning

Viser en retningslinje for hvordan du flytter et objekt for å innrette
det etter sidens horisontale sentrum.

Sett objekter i
retninger

Innretter objektene etter retningslinjene automatisk når du flytter
objektene på en side.

3. Hvis du ønsker å fargelegge retningslinjene, klikk fargefanen til venstre for Fargekart og

klikk deretter en farge.

4. Press OK .

Rearranging stacked objects
Hvis objekter overlapper på en side, kan du omarrangere rekkefølgen på stabelen (dvs at du

kan kontrollere hvilken objekter som vises foran andre).

MERKNAD

Du kan ikke flytte på et objekt fra bunken dersom det er låst på plass (se Låse objekter på

side 97).

For å flytte et objekt fremst i bunken

1. Velg objektet.

2. Klikk objektets menypil og velg Rekkefølge > Plasser den fremst.

For å flytte et objekt bakerst i bunken

1. Velg objektet.

2. Klikk objektets menypil og velg Rekkefølge > Plasser den bakerst.

For å flytte et objekt en plass fremover i bunken

1. Velg objektet.

2. Klikk objektets menypil og velg Rekkefølge > Plasser den fremover.
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For å flytte et objekt en plass bakover i bunken

1. Velg objektet.

2. Velg objektets menypil og velg Rekkefølge > Plasser den bakover.

Cutting, copying and pasting objects
Du kan klippe, kopiere og lime inn objekter - inkludert tekst, bilder, rette streker, buer og

former - i en .notebook -fil.

TIPS

l Du kan lime inn tekst fra andre programmer til SMART Notebook-programvaren og

klippe ut tekst fra SMART Notebook-programvaren og lime den inn i andre programmer

(se  Cutting, copying and pasting content from other programs på side 79 og  Cutting

and pasting text på side 40 ).

l Du kan lage en eksakt kopi av et objekt ved kloning det (se  Cloning objects på side 62

).

Klippe ut og lime inn et objekt

1. Velg objektet.

2. Klikk objektets menypil og velg Kutt.

TIPS

Du kan alternativt trykke Klipp om du har lagt til denne knappen i verktøylinjen (se

 Customizing the toolbar på side 165).

3. Hvis du vil lime objektet inn på en annen side, må du vise den siden.

4. Trykk Lim inn .

Kopiere og lime inn et objekt

1. Velg objektet.

2. Klikk objektets menypil og velg Kopier.

TIPS

Du kan alternativt trykke Kopier om du har lagt til denne knappen i verktøylinjen (se

 Customizing the toolbar på side 165).

3. Hvis du vil lime inn elementet på en annen side, åpne den siden.

4. Trykk Lim inn .
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Beskjære bilder med en maske
You can use a mask to crop images. The mask hides the section of the image you crop out

instead of deleting it. This enables you to edit the mask if you want to crop a different section

of the image. You can also unmask the image to restore the original image.

MERKNAD

You can crop raster images only. For example, you can crop raster pictures you insert from

the Gallery or from your computer. You’re unable to crop other types of objects.

Beskjære et bilde med en maske

1. Velg bildet.

2. Klikk bildets menypil og velg Maske.

A cropping mask appears on the image. Cropped out sections of the image are shaded

gray.

3. Dra bildet til den delen av bildet du vil beholde vises i beskjæringsmasken.

4. Klikk eventuelt på en av beskjæringsmaskens åtte håndtak for å endre størrelser (de hvite

sirklene), og dra den deretter for å øke eller redusere beskjæringsmaskestørrelsen.

5. Klikk hvor som helst utenfor bildet for å beskjære det.

Redigere masken

1. Velg bildet.

2. Trykk bildets menypil og velg Rediger maske.

A cropping mask appears on the image. Cropped out sections of the image are shaded

gray.

3. Dra bildet til den delen av bildet du vil beholde vises i beskjæringsmasken.

4. Klikk eventuelt på en av beskjæringsmaskens åtte håndtak for å endre størrelser (de hvite

sirklene), og dra den deretter for å øke eller redusere beskjæringsmaskestørrelsen.

5. Klikk hvor som helst utenfor bildet for å beskjære det.
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Slik gjenopprettes et bilde

1. Velg bildet.

2. Klikk bildets menypil og velg Fjern maske.

Det opprinnelige bildet er gjenopprettet.

Cloning objects
Du kan duplisere et objekt med klonekommandoen eller bruke kommandoen for uendelig

kloning for å lage flere kopier av et objekt.

MERKNAD

Du kan også kopiere og lime inn objekter, inkludert tekst, bilder, rette linjer, buer og former

(se  Cutting, copying and pasting objects på side 60 ).

Klone et objekt

1. Velg objektet.

2. Klikk objektets menypil og velg Kloning.

Et duplisert objekt vises på siden.

Å klone et objekt med Uendelighetskloner

1. Velg objektet.

2. Klikk objektets menypil og velg Uendelig kloning.

3. Velg objektet igjen.

Et uendelighetstegn vises istedenfor objektets menypil.

4. Dra objektet til en annen plass på siden.

5. Gjenta steg 4 så ofte du ønsker.

6. Velg originalobjektet når du er ferdig med å klone det.

7. Klikk uendelighetstegnet og fjern merking av Uendelig kloning.

Resizing objects
Du kan endre størrelsen på objekter ved å bruke skaleringshåndtakene eller

skaleringsbevegelsen (hvis det interaktive produktet støtter flerberøringsbevegelser).
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MERKNAD

Du kan ikke endre størrelsen på et objekt dersom det er fastlåst (se Låse objekter på

side 97).

Bruk av knappen for størrelsesendring

For å endre størrelsen på et objekt

1. Velg objektet.

2. Klikk objektets knapp for størrelsesendring (den grå sirkelen) og dra det for å forstørre

eller forminske objektets størrelse.

For å endre størrelsen på flere objekter

1. Sett objektene sammen i en gruppe (se  Grouping objects på side 67) og velg deretter

gruppen.

Et valgrektangel omgir gruppen.

2. Trykk på skaleringshåndtaket nederst i høyre hjørne av valgrektangelet.

3. Dra knappen for størrelsesendring for å øke eller redusere størrelsen på objekter.

Using the scale gesture

For å endre størrelsen på et objekt fra midten

1. Velg objektet.

2. Bruk én finger på hver hånd til å trykke på skjermen i motstående ender av objektet.
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3. Dra fingrene dine i motsatte retninger for å øke objektets størrelse.

ELLER

Dra fingrene mot hverandre for å redusere objektets størrelse.

For å endre størrelsen på et objekt fra dets hjørne eller side

1. Velg objektet.

2. Bruk en finger fra hver hånd og klikk siden eller hjørnet på skjermbildet du vil endre

størrelsen på.

3. Dra fingrene dine i motsatte retninger for å øke objektets størrelse.

ELLER

Dra fingrene mot hverandre for å redusere objektets størrelse.

For å endre størrelsen på flere objekter

1. Velg objektene.

2. Bruk én finger på hver hånd til å trykke på skjermen i motstående ender av ett av

objektene.
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3. Dra fingrene dine i motsatte retninger for øke objektets størrelse.

ELLER

Dra fingrene mot hverandre for å redusere objektenes størrelse.

MERKNAD

Objektene endrer størrelsen utover fra sine midtpunkt uavhengig av hvor du trykker på

skjermen.

Rotating objects
Du kan rotere objekter på en side ved å bruke roteringshåndtakene eller rotasjonsbevegelsen

(hvis det interaktive produktet støtter flerberøringsbevegelser).

NOTATER

l Du kan ikke rotere et objekt dersom det er fastlåst (se Låse objekter på side 97).

l Du kan ikke rotere tabellene.

Bruke rotasjonshåndtaket

For å rotere et objekt

1. Velg objektet.

2. Klikk objektets roteringsknapp (den grønne sirkelen) og dra den i retningen du ønsker å

rotere den.

For å rotere flere objekter

1. Velg objektene.

Et valgrektangel omgir hvert objekt.

2. Press the rotation handle (the green circle) on any one of the selected objects, and then

drag it in the direction you want to rotate the object. When you rotate one object, all other

selected objects rotate automatically.

Bruk av roteringsgesten

For å rotere et objekt rundt dets midtpunkt

1. Velg objektet.

2. Bruk én finger på hver hånd til å trykke på skjermen i motstående ender av objektet.
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3. Beveg fingrene i en sirkel rundt midten av objektet for å rotere det.

For å rotere et objekt rundt et hjørne

1. Velg objektet.

2. Trykk skjermen i det hjørne du vil rotere objektet rundt med en finger fra hver hånd.

3. Beveg fingrene i en sirkel rundt det hjørne du vil rotere objektet.

For å rotere flere objekter

1. Velg objektene.

2. Bruk én finger på hver hånd til å trykke på skjermen i motstående ender av ett av

objektene.

3. Beveg fingrene i en sirkel.

MERKNAD

Objektene roteres rundt sine midtpunkt uavhengig av hvor du trykker på skjermen.

Flipping objects
Du kan vende et objekt på en side.

MERKNAD

Du er ikke i stand til å vende et objekt hvis den er låst på plass (se Låse objekter på side 97

).

Vende et objekt

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Snu> Opp/Ned eller Snu> Venstre/Høyre .
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Vende flere objekter

1. Velg objektene.

2. Trykker du på menypilen på ett av de valgte objektene, og velg deretter Snu> Opp/Ned

eller Snu> Venstre/Høyre .

Grouping objects
You can create a group of objects, which lets you interact with all grouped items at the same

time. After you create a group, you can select, move, rotate or resize the group as if it were an

individual object. However, if you want to interact with an individual object in a group, you must

ungroup the objects first.

Gruppere objekter manuelt
Du kan gruppere og dele opp grupper med objekter manuelt ved hjelp av menyen eller

ristebevegelsen.

Bruke menyen

Gruppere objekter

1. Velg objektene.

2. Trykker du på menypilen til et av de valgte objektene, og velg deretter Gruppe>Gruppe

.

Dele opp objekter

1. Velge gruppen.

2. Press gruppens menypil, og velg deretter Gruppe> Løs opp gruppe .

Bruke ristebevegelsen

NOTATER

l Du kan ikke bruke ristebevegelsen med en mus.

l Ristebevegelsen fungerer bare når du først kommer i kontakt med overflaten på ditt

interaktive produktet.
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Gruppere objekter

Riste fingeren din raskt over objektene tre ganger.

Dele opp objekter

Risk fingeren din raskt over gruppen tre ganger.

Gruppere objekter automatisk
If you write or draw multiple lines, SMART Notebook software automatically combines the lines

into a single object. For example, if you write the letters of a word, SMART Notebook software

combines the individual letters, enabling you to interact with the whole word. If you want to

write words on the same line but don’t want them combined, leave a large gap between them,

use different pens, or briefly put the pen in the pen tray before writing another word

(interactive whiteboards only).

Hvis SMART Notebook-proprogramvaren kombinerer streker som du ønsker å redigere

individuelt, kan du dele opp strekene som beskrevet ovenfor.

Deleting objects
Although you can erase digital ink (see  Erasing digital ink på side 30), you’re unable to erase

some types of objects, including text, shapes, straight lines, arcs and pictures. To remove

these types of objects from a page, you must delete them.

MERKNAD

You’re unable to delete an object if it’s locked in place (see Låse objekter på side 97). To

delete a locked object from a page, you must unlock it.
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Slette et objekt

1. Velg objektet.

2. Klikk objektets menypil og velg Slett.
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Kapittel 6: Sette inn, organisere og dele
innhold

Inserting content from the Gallery 72
Sette inn innhold fra GeoGebra 73
Sette inn innhold fra SMART Exchange-nettstedet 74
Sette inn innhold fra andre kilder 75

Inserting pictures 75
Inserting pictures from files 75
Inserting pictures from a SMART Document Camera 76
Jobbe med bilder 76
Lage gjennomsiktige områder i et bilde 76

Inserting multimedia files 77
Inserting Adobe Flash Player compatible files 77
Inserting Adobe Flash Player compatible video files 78
Sette inn lydfiler 78
Jobbe med multimediafiler 78
Installing encoders for additional formats 79

Sette inn innhold fra andre programmer 79
Cutting, copying and pasting content from other programs 79
Importing files from other interactive whiteboard programs 80

Sette inn ligninger i matematikkverktøyet 80
Inserting Internet browsers 82

Sette inn en nettleser 82
Konfigurering av proxyservere 83

Attaching files and web pages 84
Organisere og dele innhold ved bruk av galleriet 85

Adding content to the Gallery 86
Organizing content in the Gallery 87
Sharing content with other teachers 88
Connecting to Team Content categories 89

Sharing content using the SMART Exchange website 89

You can insert pictures, multimedia files and other content into your .notebook files from a

variety of sources. These sources include the Gallery, the SMART Exchange® website and the

Internet.

Etter innsetting av innhold, kan du organisere innholdet ved å bruke galleriet og dele videre

med andre lærere ved å bruke galleriet eller nettsiden til SMART Exchange.
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Inserting content from the Gallery
Galleriet er en fane i SMART Notebook-programvarens brukergrensesnitt hvor du kan søke

etter innhold og legge innholdene til dine .notebook-filer .

Galleriet innholder eksempler på undervisningsaktiviteter som kan inkluderes i eksemplene fra

aktivitetsbyggeren (se  Creating a matching lesson activity på side 104), samt interaktive

teknikker og 3D-modeller som vil hjelpe deg i å opprette undervisningsaktiviteter.

Når systemansvarlig installerer SMART Notebook-programvaren, kan han eller hun installere

følgende tilleggselementer:

l Galleri-vesentligheter er en samling av tusenvis av bilder, multimedia objekter og mer,

organisert i fagspesifikke kategorier.

l Lesson Activity Toolkit is a collection of customizable tools and templates that you can

use to create professional-looking and interactive lessons. The toolkit helps you create

engaging content like word games, quizzes and sorting activities. It also offers

Adobe Flash Player compatible files like hide-and-reveal and drag-and-drop.

The Gallery is divided into two sections. The top section of the Gallery is the category list.

When you select a category or subcategory in the list, its contents appear in the bottom

section of the Gallery.

TIPS

Du kan endre størrelsen på kategori- og innholdslisten ved å klikke på grensen mellom dem

og dra det opp eller ned.

You can browse the category list to view the contents of each category. Thumbnails in the

categories provide preview images of the content.

l I Bilder vises bildene som miniatyrbilder.

l I Interaktiv og multimedia vises videoobjekter med et enkelt bilde fra videoene;

lydobjekter vises med et høyttalerikon i hjørnet nederst til venstre, og Adobe Flash

Player-kompatible filer vises som et Adobe Flash-ikon eller med miniatyrbilde av

innholdet med et lite Adobe Flash-ikon i hjørnet øverst til venstre.

l I 3D Objects vises 3D-modeller som miniatyrbilder.

l I Notebook-filer og sider vises filene som ringpermer og sider vises med brettet hjørne

øverst til høyre.

l I Bakgrunn og temaer vises bakgrunn som sider med et brett i hjørnet nederst til høyre.

Temaene vises som miniatyrbilder.

Du kan søke etter et galleriobjekt via nøkkelordsøk.

Etter at du har søkt frem et galleriobjekt kan du legge det til din .notebook fil.
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For å bla igjennom galleriet

1. Hvis galleriet ikke synes, trykk Galleri .

2. Trykk avdekkingstrekanten til en kategori for å se dens underkategorier.

MERKNAD

Du kan lukke en kategori ved å trykke kategoriens avdekkingstrekant igjen.

3. Velg en kategori eller underkategori for å vise innholdet.

For å søke i galleriet

1. Hvis galleriet ikke synes, trykk Galleri .

2. Fyll inn et nøkkelord i boksen Angi søkeordene her og deretter trykk Søk .

Galleriet viser all innhold med søkeordet.

For å legge en gallerienhet til din .notebook-fil

1. Hvis galleriet ikke synes, trykk Galleri .

2. Søk etter alle galleriobjekter du ønsker legge til.

3. Dobbeltklikk galleriobjektets miniatyrbilde.

o Hvis du legger til et bilde, en Adobe Flash Player-kompatibel fil, video- eller lydfil - vil

det vises på nåværende side.

o Hvis du legger til en bakgrunn, vil den erstatte sidens eksisterende bakgrunn (se

 Applying page backgrounds and themes på side 101).

o Hvis du legger til en side fra en .notebook fil vil SMART Notebook-programmet

legge det til før nåværende side.

o Hvis du legger til en .notebook fil vil SMART Notebook-programmet legge inn filens

sider før nåværende side.

Sette inn innhold fra GeoGebra
GeoGebra is an interactive mathematics software for all levels of education. When you insert

the GeoGebra widget in SMART Notebook software, you can explore geometry, algebra,

tables, graphing, statistics and calculus with your students.

You can also search for worksheets from GeoGebraTube using the keyword search. After

searching for a worksheet, you can add it to your .notebook file. GeoGebraTube

(geogebratube.org) contains thousands of worksheets created and shared by other teachers.

http://www.geogebratube.org/
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MERKNAD

For mer informasjon om hvordan du bruker GeoGebra-programvare, gå til GeoGebra Wiki ( 

wiki.geogebra.org ).

For å få tilgang til GeoGebra-widget

Trykk Tillegg og deretter trykk GeoGebra.

For å sette inn GeoGebra-widget

1. Hvis GeoGebra-widget ikke vises, trykk Vedlegg og deretter trykk GeoGebra.

2. Velg Sett Inn GeoGebra Widget .

For å søke i GeoGebraTube

1. Hvis GeoGebra-widget ikke vises, trykk Vedlegg og deretter trykk GeoGebra.

2. Skriv inn et nøkkelord i søkeboksen for Søk i Gratis Materiale og trykk deretter på Søk .

GeoGebra Widgeten viser miniatyrbilder av regneark som inneholder søkeordet.

For å legge et GeoGebraTube-regneark til din .notebook-fil

1. Hvis GeoGebra-widget ikke vises, trykk Vedlegg og deretter trykk GeoGebra.

2. Søk etter det GeoGebraTube-regnearket du vil legge til.

3. Trykk regnearkets miniatyrbilde, og velg deretter Sett inn GeoGebra Widget .

Regnearket vises på den aktuelle siden.

TIPS

For mer informasjon om et regneark, press miniatyrbildets tittel for å gå til regnearkets

nedlastingsside i GeoGebraTube.

Sette inn innhold fra SMART Exchange-
nettstedet
SMART Exchange-nettstedet ( exchange.smarttech.com ) omfatter tusenvis av timeplaner,

spørsmålssett, widgets og annet innhold som du kan laste ned og deretter åpne i SMART

Notebook programvare.

MERKNAD

You can also share your lesson plans with other teachers through the SMART Exchange

website. For more information, see  Sharing content using the SMART Exchange website på

side 89.

http://wiki.geogebra.org/
http://exchange.smarttech.com/
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For å sette inn innhold fra nettsiden til SMART Exchange

1. Trykk SMART Exchange .

SMART Exchange-nettstedet åpnes i nettleseren din.

2. Hvis du er ny til SMART Exchange-nettstedet, press Bli med gratis , og følg deretter

instruksjonene på skjermen for å opprette en konto.

ELLER

Hvis du har en konto, press Logg inn , og følg deretter instruksjonene på skjermen for å

logge på SMART Exchange-nettsiden med kontoen din.

3. Søk eller bla gjennom innhold, og last det deretter ned til datamaskinen din.

4. Importere innhold til galleriet (se  Sharing content with other teachers på side 88).

Sette inn innhold fra andre kilder
If you or other teachers in your school have created content outside of SMART Notebook

software, you can include this content in your .notebook files. Specifically, you can do the

following:

l Sette inn bilder, Adobe Flash Player-kompatible filer, videofiler og lydfiler

l Klippe ut eller kopiere og deretter lime innhold fra andre programmer

l Importere innhold fra andre programmer

Inserting pictures
Du kan sette bilder inn i sider fra filer, en skanner eller et SMART dokumentkamera.

MERKNAD

You can also insert pictures from the Gallery tab. For more information, see  Inserting content

from the Gallery på side 72.

Etter at du setter inn et bilde kan du definere et transparent område i det.

Inserting pictures from files
Du kan sette et bilde inn på en side.

SMART Notebook-programvaren støtter følgende formater BMP, GIF, JPEG og PNG.

For å sette inn et bilde fra en fil

1. Select Insert > Picture.

Dialogboksen Åpne vises.

2. Søk etter og velg bildet du ønsker å sette inn.
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3. Klikk Åpne.

Bildet vises i hjørnet øverst til venstre på siden.

Inserting pictures from a SMART Document Camera
Du kan legge bilder fra et SMART dokumentkamera til en side.

For å sette inn et bilde fra SMART Document Camera

1. Select Insert > Picture from SMART Document Camera.

SMART dokumentkamera -vinduet vises på siden.

2. Sett inn et bilde ved hjelp av instruksene i hjelpavdelingen.

Jobbe med bilder
When you insert a picture in a .notebook file, the picture becomes an object in the file.

Therefore, you can move, resize, rotate and make other changes to the picture like any other

object.

For informasjon om hvordan jobbe med objekter, inkludert bilder, i.notebook-filer, se Jobbe

med objekter på side 51.

Lage gjennomsiktige områder i et bilde
Du kan lage gjennomsiktige områder i et bilde som du setter inn i en side. Dette er nyttig for å

fjerne bildets bakgrunn. Du kan gjøre hvilken som helst farge i bildet gjennomsiktig.

MERKNAD

Du kan redusere størrelsen på et stort bilde når du setter det inn i en fil (se  Setting image

optimization preferences på side 168). Hvis du oppretter et transparent område i bildet på et

senere tidspunkt, vil bildet ikke lenger være optimalisert.

For å opprette et transparent område i et bilde

1. Velg bildet.

2. Trykk på bildetmenypilen og velg Still inn bildegjennomsiktighet.

Dialogboksen for Bildegjennomsiktighet vises.

3. Dra i hjørnene på dialogboksen for å endre på størrelsen.

4. Trykk et området i bildet som du vil gjøre gjennomsiktig.

MERKNAD

Å klikke på et område gjør at kun det området blir gjennomsiktig, selv om bildet

inneholder den samme farge på andre områder.

5. Press OK .
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Inserting multimedia files
Du kan sette multimediafiler, inkludert Adobe Flash Player-kompatible filer, video- og lydfiler

inn på siden.

MERKNAD

You can also insert multimedia files from the Gallery tab. For more information, see  Inserting

content from the Gallery på side 72.

Inserting Adobe Flash Player compatible files
Du kan sette inn Adobe Flash Player-kompatible filer i en side.

After you insert an Adobe Flash Player compatible file into a page, or display a page that

already contains an Adobe Flash Player compatible file, the file plays immediately. You can

control the playback of the file. If the file has buttons, you can press them on your interactive

product. If the file doesn’t have buttons, you can use the options in the file’s menu arrow.

NOTATER

l Adobe Flash Player compatible files on a page must be self-extracting. You’re unable to

use Adobe Flash Player compatible files that load or rely on other Adobe Flash Player

compatible files.

l Du er ikke i stand til å dra en Adobe Flash Player-kompatibel fil fra en nettleser til en

side.

l To write on top of an Adobe Flash Player compatible file with a handwriting recognition

component, start writing outside the file and continue to write over the file. This enables

SMART Notebook software to recognize the digital ink as a separate object from the

Adobe Flash Player compatible file.

For å sette inn en Adobe Flash Player kompatibel fil

1. Velg Sett inn> Adobe Flash Player-kompatibel Fil .

Dialogboksen Åpne vises.

2. Bla til og velg den Adobe Flash Player-kompatible filen som du ønsker å sette inn på

siden.

3. Klikk Åpne.

Den Adobe Flash Player-kompatible filen vises i øverste venstre hjørne på siden.
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For å kontrollere en Adobe Flash Player kompatibel fil

1. Velg en Adobe Flash Player-kompatibel fil.

2. Kontrollere filen ved å gjøre ett av følgende:

o For å spille av filen, trykk filens menypil, og velg deretter Flash> Spill .

o For å spille av filen fra begynnelsen, trykk filens menypil, og velg deretter Flash>

Spol Tilbake .

o For å spole filen fremover litt og pause avspillingen, trykker du på fil-menypilen, og

velg deretter Flash> Spol Forover .

o For å spole tilbake filen litt og pause avspillingen, trykker du på fil-menypilen, og

velg deretter Flash> Spol Tilbake .

o For å spille av filen kontinuerlig, trykk filens menypil, og velg deretter Flash> Loop .

o For å stoppe å spille av filen kontinuerlig, trykk filens menypil, og opphev valget av

Flash> Loop .

Inserting Adobe Flash Player compatible video files
Du kan sette inn Adobe Flash Player-kompatible videofiler i en side.

MERKNAD

SMART Notebook software supports the Adobe Flash Player compatible video file (FLV)

format. If you want SMART Notebook software to support other file types, you can install

additional encoders (see  Installing encoders for additional formats på neste side).

For å sette inn en Adobe Flash Player kompatibel videofil

1. Velg Sett Inn > Video.

Dialogboksen Åpne vises.

2. Bla til og velg Adobe Flash Player-kompatibel videofil som du vil sette inn i siden.

3. Klikk Åpne.

Sette inn lydfiler
You can attach a sound file to any object (except Adobe Flash Player compatible objects) in a

.notebook file. For more information, see  Adding sounds to objects på side 96.

Jobbe med multimediafiler
When you insert a multimedia file in a .notebook file, the multimedia file becomes an object in

the file. Therefore, you can move, resize, rotate and make other changes to the multimedia file

like any other object.

For informasjon om hvordan jobbe med objekter, inkludert multimedia-filer, i.notebook-filer, se

Jobbe med objekter på side 51.
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Installing encoders for additional formats
SMART Notebook software supports the FLV and MP3 formats. If you want SMART Notebook

software to support other video and audio formats, you can install the following encoder. If you

install this encoder, SMART Notebook software automatically detects it and supports its video

and audio formats.

Koder Videoformater Lydformater Link

ffmpegX 0.0.9y l WAV

l WMA

l ASF

l AVI

l MOV

l MP4

l MPEG og
MPG

l WMV

l AIF og AIFF

l WAV

l WMA

ffmpegx.com/download.html

MERKNAD

SMART Technologies ULC provides links to these programs as a courtesy, and makes no

representations or warranties regarding the programs or any information related thereto. Any

questions, complaints or claims regarding the programs must be directed to the appropriate

software vendor.

Sette inn innhold fra andre programmer
Hvis du har innhold i andre programmer som du vil bruke i dine .notebook-filer kan du flytte

dette innholdet til SMART Notebook-programvaren ved å gjøre ett av følgende:

l Skjæring eller kopiere og lime inn innholdet

l Importere innhold

Cutting, copying and pasting content from other programs
Du kan klippe ut eller kopiere og deretter lime innhold fra andre programmer til

SMART Notebook-programvaren.

For å klippe ut innhold fra et annet program

1. I det andre programmet velger du innholdet du ønsker å klippe og deretter Rediger>

Klipp.

2. I SMART Notebook-programvare, trykk Lim inn .

http://www.ffmpegx.com/download.html


KAPITTEL 6
SETTE INN, ORGANISERE OG DELE INNHOLD

80

For å kopiere innhold fra et annet program

1. I det andre programmet velger du innholdet du vil kopiere og deretter Rediger> Kopier.

2. I SMART Notebook-programvare, trykk Lim inn .

Importing files from other interactive whiteboard programs
Du kan importere innholdet til en .notebook-fil fra en rekke kilder, inkludert andre interaktive

tavleprogrammer.

Hvis de andre interaktive tavleprogrammene støtter den Interaktiv Tave Felles Filformat (CFF),

kan du eksportere en CFF-fil fra disse programmene og deretter importere CFF-fil til SMART

Notebook-programvare.

MERKNAD

Du kan også eksportere CFF-filer (se  Exporting files på side 15).

To import CFF files

1. Velg Fil> Importer> Alle Felles Filformat-filer (.IWB) .

En dialogboks vises.

2. Bla til og velg filen du vil importere.

3. Klikk Åpne.

Filen åpnes.

Sette inn ligninger i matematikkverktøyet
You can use the Math Editor to insert a handwritten equation to a page in a more readable

format. The Math Editor recognizes your handwriting and automatically converts it to a typeset

format. You can also add the recognized equation to a GeoGebra worksheet if the equation is

in a supported graph format.

For å sette inn en ligning på en side

1. Trykk Vedlegg og deretter velg Sett inn ligning .

Matteredigeringsprogrammet vises.

2. Velg pennverktøy og farge (se side 28).
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3. Skriv en matteligning på grafpapiravsnittet i redigerinsprogrammet.

The handwritten equation converts to a typed equation, which appears below the graph

paper section. Accept and reject icons appear beside the recognized equation.

4. Klikk for å akseptere den gjenkjente ligningen.

Den dataskrevne ligningen vises på siden.

ELLER

Klikk for å avvise den gjenkjente ligningen og lukke matteredigeringsprogrammet.

For å redigere en anerkjent ligning

1. Klikk Velg , og klikk den gjenkjente ligningen på siden to ganger.

Den håndskrevne ligningen vises i matteredigeringsprogrammet.

2. Rediger den håndskrevne ligningen med viske- og pennredskapen.

The edited equation is recognized and appears below the graph paper section. Accept

and reject icons appear beside the recognized equation.

3. Klikk for å akseptere den gjenkjente ligningen.

Ligningen oppdateres med endringene dine.

ELLER

Klikk for å avvise den gjenkjente ligningen og lukke matteredigeringsprogrammet.

Ligningen blir ikke oppdatert.
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For å legge en anerkjent ligning til et GeoGebra-regneark

1. Sett inn et GeoGebra-regneark på en side (se Sette inn innhold fra GeoGebra på side 73).

2. Dra ligningen fra siden til GeoGebra-widgeten.

Ligningen legges automatisk til regnearket.

Inserting Internet browsers
You can insert an Internet browser into a .notebook page. In the Internet browser, you can

browse to and display web pages. You can modify the Internet browser like any other object in

SMART Notebook software (see Jobbe med objekter på side 51).

MERKNAD

Når du endrer størrelsen på en nettleser vil størrelsen på nettleserens innhold endres i

samsvar med nettleseren slik at du alltid ser hele nettstedet.

Sette inn en nettleser

For å sette inn en nettleser

1. Velg Sett inn > Nettleser.

En nettleser vises.
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2. Dobbelklikk på adresselinjen, fyll inn en nettsideadresse du ønsker å gå til og deretter

trykk Gå .

TIPS

Hvis det ikke er noen tastatur tilkoblet på datamaskinen din, klikk SMART-tastatur

for å vise et tastatur på skjermen.

3. Naviger nettstedet med knappene i verktøylinjen til nettleseren:

Knapp Kommando Handling

Tilbake Vis forrige nettside.

Fremover Vis neste nettside.

Gå tilbake til
festet side

Åpne den festede nettsiden.

Fest side Fest nåværende side.

When you first open the .notebook file, the pinned web page
appears in the Internet browser. You can return to the pinned

page at any time by pressing Return to Pinned Page .

Last på nytt Last opp nåværende nettside.

Flytt
verktøylinje

Endre plasseringen til nettleserens verktøylinje.

Konfigurering av proxyservere
Internet browsers in SMART Notebook software work with any proxy server that adheres to the

RFC 2068 HTTP standard. If your system administrator installed SMART Notebook software

behind a proxy server, he or she must create access policy rules for inbound and outbound

traffic on that proxy server. Your system administrator can further enhance network security by

enabling authentication, such as basic or NT LAN Manager (NTLM) authentication.

MERKNAD

Selv om proxy-servere beskytter interne nettverk fra inntrengere, innfører de uunngåelig

nettverksventetid.
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Attaching files and web pages
Du kan legge til kopier og alias for filer, samt lenker til nettsider - ved å bruke vedleggsfanen.

Å legge ved filer eller nettsider gir deg muligheten til å finne og åpne enheter enkelt under en

presentasjon av en .notebook-fil.

NOTATER

l Du kan også legge lenker til en fil eller nettside til ett objekt på en side (se  Adding links

to objects på side 94).

l Alternativt til å legge en lenke til en nettside, kan du også sette inn en nettleser i din

.notebook-fil se  Inserting Internet browsers på side 82).

For å legge ved en kopi av en fil

1. Hvis vedleggsfanen ikke synes, trykk Vedlegg .

2. Trykk Sett inn fil i bunnen av Vedlegg-fanen

Dialogboksen Åpne vises.

3. Bla frem og velg filen du ønsker å legge ved.

4. Velg Kopi av fil.

5. Klikk Åpne.

Filens navn og størrelse vil vises i fanen for Vedlegg.

MERKNAD

When you attach a file, the size of the .notebook file increases. Although

SMART Notebook software compresses files to conserve space, SMART Notebook

software can compress some file types more than others.

To attach an alias for a file

1. Hvis vedleggsfanen ikke synes, trykk Vedlegg .

2. Trykk Sett inn fil i bunnen av Vedlegg-fanen

Dialogboksen Åpne vises.

3. Bla frem og velg filen du ønsker å legge ved.

4. Velg Alias.
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5. Klikk Åpne.

Filnavnet og alias vises i fanen for vedlegg.

NOTATER

o SMART Notebook software doesn’t export aliases. If you want to export file

attachments, attach a copy of your file, not an alias for the file.

o Sørg for at filen er tilgjengelig på datamaskinen din under en undervisningstime.

To attach a link to a web page

1. Hvis vedleggsfanen ikke synes, trykk Vedlegg .

2. Trykk Sett inn hyperlenke i bunnen av Vedlegg-fanen

En dialogboks vises.

3. Tast nettsideadressen inn i boksen for Hyperlenke.

4. Tast et navn for lenken inn i boksen for Vis navn.

5. Klikk Sett inn hyperlenke.

Visningsnavnet og nettstedsaddressen vises i fanen for Vedlegg.

For å åpne en fil eller nettside fra vedleggfanen

1. Hvis vedleggsfanen ikke synes, trykk Vedlegg .

Vedleggsfanen viser en liste over alle vedlegg i den åpne filen.

o Hvis den vedlagte enheten er en kopi av filen vil filens størrelse vises i Størrelse-

kolonnen.

o Hvis den vedlagte enheten er et alias for filen vil alias vises i Størrelse- kolonnen.

o Hvis den vedlagte enheten er en lenke til en nettside vil nettadresse vises i

Størrelse-kolonnen.

2. For å åpne en fil, dobbelklikk på filens navn eller alias.

ELLER

For å åpne en nettside, dobbelklikk på lenken.

Organisere og dele innhold ved bruk av
galleriet
The Gallery is a tab in the SMART Notebook software user interface where you can browse or

search for content and then add that content to your .notebook files. The Gallery consists of a

set of categories, one of which is the My Content category.
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If you find you use the same content across multiple .notebook files, you can add this content

to the My Content category. You can share content from the My Content category with other

teachers in your school by importing or exporting Gallery collection files. You can also connect

to a Team Content category containing content that you and other teachers in your school

contribute to.

Etter at du har lagt innhold til galleriet, kan du sette det inn i .notebook-filer som beskrevet i

 Inserting content from the Gallery på side 72.

Adding content to the Gallery
Du kan legge til SMART Notebook-programvareobjekter og sider samt støttede filer i Mitt

innhold-kategorien i galleriet.

To add an object to the Gallery

1. Hvis galleriet ikke synes, trykk Galleri .

2. Velg objektet du vil legge til galleriet.

3. Dra objektet fra siden til galleriets Mitt innhold-kategori eller en av dens underkategorier.

NOTATER

o Du er ikke i stand til å flytte et objekt hvis den er låst på plass (se Låse objekter på

side 97).

o Hvis du ønsker å endre navnet på et Galleriobjekt, velg objektet, press menypilen,

og velg deretter Gi nytt navn .

To add a page to the Gallery

1. Lage og redigere objekter på siden til siden vises nøyaktig slik du vil ha den.

2. Select File > Export Page as Gallery Item.

En dialogboks vises.

3. Bla frem til den mappen du vil lagre siden i.

4. Skriv inn et navn på siden i Lagre som -boksen.

5. Press Lagre .

6. Hvis galleriet ikke synes, trykk Galleri .

7. Velg Mitt innhold (Eller en av dens underkategorier) i Galleriets kategoriliste, trykk

menypilen, og velg deretter Legg til i mine innlegg .

Dialogboksen Åpne vises.

8. Bla til og velg det objektet som du lagret i trinn 5.

9. Klikk Åpne.
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For å legge en støttet fil t il galleriet

1. Hvis galleriet ikke synes, trykk Galleri .

2. Velg Mitt innhold (Eller en av dens underkategorier) i Galleriets kategoriliste, trykk

menypilen, og velg deretter Legg til i mine innlegg .

Dialogboksen Åpne vises.

3. Bla til og velg objektet du vil legge til galleriet.

4. Klikk Åpne.

MERKNAD

By default, SMART Notebook software names the new Gallery item based on the

original file name. If you want to change the item’s name, select the Gallery item’s

thumbnail, press its menu arrow, and then select Rename.

Organizing content in the Gallery
As you add objects, pages and supported files to the My Content category in the Gallery, you

may want to reorganize the category’s structure. You can create subcategories and move

Gallery items between subcategories.

For å opprette en underkategori

1. Hvis galleriet ikke synes, trykk Galleri .

2. Velg Mitt innhold (eller en av underkategoriene innunder) i galleriets kategoriliste, klikk

menypilen til kategorien og velg Ny mappe.

En ny underkategori blir opprettet.

3. Skriv et navn du vil gi underkategorien og trykk RETURN.

For å navngi en underkategori på nytt

1. Hvis galleriet ikke synes, trykk Galleri .

2. Velg Mitt innhold i galleriets kategoriliste og søk deg frem til underkategorien du vil

endre navnet på.

3. Velg underkategorien, trykk dens menypil og velg Gi nytt navn.

4. Skriv inn det nye navnet du vil gi til underkategorien og trykk RETURN.



KAPITTEL 6
SETTE INN, ORGANISERE OG DELE INNHOLD

88

For å flytte en gallerienhet til en annen underkategori

1. Hvis galleriet ikke synes, trykk Galleri .

2. Søk deg frem til kategorien som inneholder galleriobjektet du ønsker å flytte.

Galleriet viser kategoriens innhold.

3. Dra objektet til en annen underkategori.

Sharing content with other teachers
Importing and exporting collection files is an ideal way to share custom categories with other

teachers and to use categories that other teachers have created. You can use collection files

to add items to the My Content category in the Gallery. After you import a collection file, all of

its items appear in the Gallery as a new subcategory.

To import a collection file from another teacher

1. Hvis galleriet ikke synes, trykk Galleri .

2. Velg Mitt innhold (eller en av dens underkategorier) i galleriets kategoriliste, klikk

menypilen og velg Legg til mitt innhold.

Dialogboksen Åpne vises.

3. Søk deg frem til mappen som inneholder samlingsfilen du ønsker å importere.

MERKNAD

En samlingsfil indikeres med utvidelsen: .galleri

4. Velg samlingsfilen og klikk Åpne.

Samlingsfilen vises som en ny underkategori.

To export a collection file to share with other teachers

1. Velg kategorien som inneholder objektene du ønsker å lagre i samlingen.

MERKNAD

SMART Notebook-programvaren eksporterer den valgte kategorien uten dens

underkategorier.

2. Klikk kategoriens menypil og velg Eksporter som samlingsfil.

Dialogboksen for Lagre vises.

3. Søk deg frem til mappen du vil lagre samlingsfilen i.

4. Skriv inn et navn på filen i boksen Lagre som .

5. Press Lagre .
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Connecting to Team Content categories
The Team Content categories feature enables you to connect to Gallery content in a shared

location on your school’s network. Multiple teachers can connect to the same folder.

SMART Notebook software automatically updates your changes for all other teachers.

MERKNAD

Your access permissions for the Team Content category are the same as your folder access

permissions on your school’s network. If you have full access to a folder on the network, you

can add or remove items in that folder’s Team Content category. However, if you have read-

only access to the folder, you can copy items from the Team Content category, but you’re

unable to add, edit or remove items.

For å koble seg til kategorien Teaminnhold

1. Hvis galleriet ikke synes, trykk Galleri .

2. Trykk Klikk her for flere gallerialternativer og velg deretter Koble til teaminnhold.

Koble til teaminnhold -dialogboksen vises.

3. Søk etter og velg mappen som innholder teaminnholdskategorien du ønsker å koble til

og klikk Åpne.

Teaminnholdskategorien vises i galleriet.

For å bidra med noe til kategorien Teaminnhold

Legg innhold til kategorien Teaminnhold på samme måte som du legger til kategorien

Mitt innhold (se  Adding content to the Gallery på side 86).

Sharing content using the SMART Exchange
website
I tillegg til å dele innholdet ditt med andre lærere på skolen din (se  Sharing content with other

teachers på forrige side), kan du også dele .notebook-filene med lærere verden rundt. Dette

kan gjøres ved å bruke SMART Exchange-nettsiden (exchange.smarttech.com).

For å dele en .notebook-fil på SMART Exchange-nettsiden

1. Åpne .notebook -filen du ønsker lagre.

2. Velg Fil > Del på SMART Exchange.

En dialogboks vises.

http://exchange.smarttech.com/
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3. Hvis du er ny på SMART Exchange-nettstedet, klikk Enda ikke blitt medlem og følg

instruksene på skjermen for å opprette en konto.

ELLER

Hvis du har en konto kan du skrive e-postadressen din i e-postadresse -boksen og

passordet ditt i passord -boksen, og klikke Logg inn.

TIPS

o Hvis du har glemt passordet ditt kan du klikke Passordet er glemt og følge

instruksene på skjermen for å gjenopprette det.

o Dersom du ikke ønsker å logge deg inn på SMART Exchange-nettstedet hver gang

du vil dele innhold kan du velge Forbli innlogget -avmerkingsboksen.

4. Skriv all nødvendig informasjon:

Kontroll Instrukser

Skriv ressursdetaljer Skriv en tittel for .notebook -filen.

Beskrivelse Skriv en beskrivelse av .notebook -filen.

Emne(r) Velg emnene som gjelder for .notebook -filen.

Trinn Velg de trinnene .notebook -filen gjelder.

Søk på begrep Type words or phrases that other SMART Exchange users will
likely enter to search for the .notebook file. Separate the
words or phrases with commas.

5. Les avtalen i henhold til deling.

6. Hvis du aksepterer avtalen, klikk Samtykk og send.
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Kapittel 7: Opprette undervisningaktiviteter

Bruke avanserte funksjoner for objekter 91
Creating custom Creative pen styles 92
Adding links to objects 94
Adding sounds to objects 96
Animating objects 97
Låse objekter 97

Bruke avanserte sidefunksjoner 99
Ta opp sider med undervisningsopptaker 99
Applying page backgrounds and themes 101

Legge til bakgrunner ved hjelp av Egenskaper-fanen 101
Legge til bakgrunner og temaer ved å bruke galleriet 103

Creating themes 104
Opprette et eksempel-undervisningsaktivteter 104

Creating a matching lesson activity 104
Opprette en skjul-og-vis undervisning 106
Opprette en skjul-og-vis undervisningsaktivitet 108
Opprette andre typer av undervisningsaktiviteter 110

Ved å bruke SMART Notebook-programvaren, kan du både presentere informasjon til elevene

og engasjere dem i interaktive undervisningsaktiviteter.

Du kan opprette undervisningsaktiviteter ved å sette inn objekter av former, bilder eller

tabeller, samt bruke ekstrafunksjoner som f.eks. aktivitetsbygger og skaleringsbevegelser.

This section documents the advanced features you can use to create lesson activities and

shows you how to create a set of example lesson activities. You can use these example lesson

activities or develop your own. You can also use resources available to you in the Gallery and

SMART Exchange website.

Bruke avanserte funksjoner for objekter
Du kan bruke følgende avanserte objektfunksjoner når du oppretter undervisningsaktiviteter:

l Tilpass kreative pennstiler

l Objektlenker

l Objektlyder
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l Objektanimasjon

l Lenke et verktøy til et objekt

Du kan også låse fast objekter du ikke vil skal flyttes på eller modifiseres under presentasjon

av en undervisningsaktivitet.

Creating custom Creative pen styles
SMART Notebook software includes eight Creative pen styles (see  Writing or drawing digital

ink på side 28). In addition to these styles, you can create your own styles using pictures or

objects on the currently selected page.

Å skape en egendefinert kreativ penn ved bruk av et bilde

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Pennetyper og velg Kreativ penn.

3. Velg en linjetype.

4. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

5. Klikk Linjestil.

6. Velg Bruke et egendefinert stempelbilde.

7. Klikk Bla.

Dialogboksen for Sett inn Bildefil vises.

8. Bla til og velg bildet du ønsker å bruke for stiler for Kreativ penn.
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9. Klikk Åpne.

10. Skrive eller tegne digitalt blekk på siden.

TIPS

o For å fortsette å bruke standard linjetype, velger du Bruk standard mønster .

o If you want to save your custom Creative pen style for future use, press Save Tool

Properties. You can later reset the Creative pen style (see  Customizing the toolbar

på side 165).

Å skape en egendefinert kreativ penn ved bruk av et objekt

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Pennetyper og velg Kreativ penn.

3. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

4. Klikk Linjestil.

5. Velg Bruke et egendefinert stempelbilde.

6. Press Velg objekt , og velg deretter et objekt på siden.

7. Skrive eller tegne digitalt blekk på siden.

TIPS

o For å fortsette å bruke standard linjetype, velger du Bruk standard mønster .

o If you want to save your custom Creative pen style for future use, press Save Tool

Properties. You can later reset the Creative pen style (see  Customizing the toolbar

på side 165).
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Adding links to objects
You can link any object on a page to a web page, another page in the file, a file on your

computer or an attachment. An attachment is a copy of a file, a shortcut to a file or a link to a

web page that you add to the Attachments tab.

MERKNAD

Du kan vise animerte koblingstegn rundt alle koblinger på en side (se  Displaying links på

side 118).

To add a link to a web page

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke .

Dialogboksen for å Sette inn lenke vises.

3. Press Nettside , og deretter skriver du inn nettadressen i Adresseboksen .

4. Hvis du ønsker å åpne lenken ved å trykke på et ikon, velg Hjørneikonet .

ELLER

Hvis du ønsker å åpne lenken ved å trykke hvor som helst i objektet, velg Object .

5. Press OK .

Hvis du valgte Hjørneikonet ,vises ikonet nederst i venstre hjørne av objektet.

To add a link to another page in the file

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke .

Dialogboksen for å Sette inn lenke vises.

3. Press Side i denne Filen , og velg deretter et alternativ i Velg en side-området .

4. Hvis du ønsker å åpne lenken ved å trykke på et ikon, velg Hjørneikonet .

ELLER

Hvis du ønsker å åpne lenken ved å trykke hvor som helst i objektet, velg Object .

5. Press OK .

Hvis du valgte Hjørneikonet ,vises ikonet nederst i venstre hjørne av objektet.
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To add a link to a file on your computer

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke .

Dialogboksen for å Sette inn lenke vises.

3. Klikk Filen på denne datamaskinen og skriv deretter filens plassering og navn i Filboksen

.

4. Hvis du ønsker å legge ved en kopi av filen, velger du Kopi av fil .

ELLER

Hvis du ønsker å sette inn en snarvei til filen, velger du Snarvei til fil .

5. Hvis du ønsker å åpne lenken ved å trykke på et ikon, velg Hjørneikonet .

ELLER

Hvis du ønsker å åpne lenken ved å trykke hvor som helst i objektet, velg Object .

6. Press OK .

Hvis du valgte Hjørneikonet ,vises ikonet nederst i venstre hjørne av objektet.

For å legge en kobling til et vedlegg

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke .

Dialogboksen for å Sette inn lenke vises.

3. Klikk Gjeldende vedlegg og velg deretter vedlegget i listen.

4. Hvis du ønsker å åpne lenken ved å trykke på et ikon, velg Hjørneikonet .

ELLER

Hvis du ønsker å åpne lenken ved å trykke hvor som helst i objektet, velg Object .

5. Press OK .

Hvis du valgte Hjørneikonet ,vises ikonet nederst i venstre hjørne av objektet.

For å fjerne en kobling

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke .

Dialogboksen for å Sette inn lenke vises.

3. Press Fjern Lenke .
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Adding sounds to objects
You can add a sound to any object (except Adobe Flash Player compatible files and widgets)

by attaching a sound file or recording a sound using a computer microphone. You can play the

sound during the lesson by pressing an icon in the corner of the object or the object itself.

MERKNAD

SMART Notebook software supports the MP3 audio format. If you want SMART Notebook

software to support other file types, you can install additional encoders (see  Installing

encoders for additional formats på side 79).

For å legge en lydfil t il et objekt

1. Velg objektet.

2. Trykk på objektets menypil og velg deretter Lyd.

En dialogboks vises.

3. Trykk Velg fil.

Dialogboksen Åpne vises.

4. Bla frem til og velg lydfilen og trykk deretter på Åpne.

5. Velg Hjørneikon om du ønsker at lydfilen skal spilles av ved klikke på denne ikonen som

plasseres ved ikonets nedre venstre hjørne.

ELLER

Velg Objekt om du ønsker å spille av lydfilen når du trykker hvor som helst på objektet.

6. Trykk Legg ved lyd.

For å legge en lydinnspilling til et objekt

1. Koble en mikrofon til datamaskinen og skru den på.

2. Velg objektet.

3. Trykk på objektets menypil og velg deretter Lyd.

En dialogboks vises.

4. Trykk Start innspilling.

5. Spill inn lyden ved hjelp av mikrofonen.

VIKTIG

SMART Notebook software stops recording after one minute. Therefore, ensure the

sound is no more than one minute long.

6. Klikk Stopp innspilling.
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7. Tast inn et navn på lyden i boksen Innspillingsnavn.

8. Klikk alternativt på Forehåndsspill innspilling for å høre lyden før man legger den til et

objekt.

9. Velg Hjørneikon om du ønsker at lydfilen skal spilles av ved klikke på denne ikonen som

plasseres ved ikonets nedre venstre hjørne.

ELLER

Velg Objekt om du ønsker å spille av lydfilen når du trykker hvor som helst på objektet.

10. Klikk Legg ved innspilling.

For å fjerne en lydklipp fra et objekt

1. Velg objektet.

2. Trykk på objektets menypil og velg deretter Lyd.

En dialogboks vises.

3. Klikk Fjern lyd.

Animating objects
You can animate an object to fly onto a page from the side, spin, fade in, shrink and more. You

can set the animation to start when you open a page or when you press the object.

For å animere et objekt

1. Velg objektet.

2. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

3. Trykk på Objektanimasjon.

4. Velg alternativene i nedtrekklisten for Type, Retning, Hastighet, Oppstå og Repetere.

Låse objekter
Du kan låse et objekt for å forhindre at det blir modifisert, flyttet eller rotert. Alternativt kan du

låse et objekt men samtidig begrense flytting vertikalt eller horisontalt, eller tillate flere

flyttinger og rotasjoner.

Du kan fjerne denne låsen når som helst.

For å låse et objekt
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1. Velg objektet.

2. Klikk objektets menypil og velg Lås > Lås på plass.

Du kan ikke flytte, rotere eller endre objektet før du låser det opp.

MERKNAD

Hvis du trykker på et låst objekt, vil et låseikon vises i stedet for en menypil.

For å låse et objekt, men likevel beholde muligheten til å flytte det

1. Velg objektet.

2. Klikk objektets menypil og velg Lås > Tillat flytting.

Du kan flytte et objekt, men du kan ikke rotere eller modifisere det før du åpner låsen.

MERKNAD

Hvis du trykker på et låst objekt, vil et låseikon vises i stedet for en menypil.

For å låse et objekt, men likevel beholde muligheten til å flytte det vertikalt

1. Velg objektet.

2. Klikk objektets menypil og velg Lås > Tillat vertikal flytting.

Du kan flytte et objekt vertikalt, men du kan ikke rotere eller modifisere det før du åpner

låsen.

MERKNAD

Hvis du trykker på et låst objekt, vil et låseikon vises i stedet for en menypil.

For å låse et objekt, men likevel beholde muligheten til å flytte det horisontalt

1. Velg objektet.

2. Trykk på objektets menypil og velg Lås > Tillat horisontal flytting.

Du kan flytte et objekt horisontalt, men du kan ikke rotere eller modifisere det før du

åpner låsen.

MERKNAD

Hvis du trykker på et låst objekt, vil et låseikon vises i stedet for en menypil.

For å låse et objekt, men likevel beholde muligheten til å flytte og rotere det.
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1. Velg objektet.

2. Klikk objektets menypil og velg Lås > Tillat flytting og rotering.

Du kan flytte og rotere objektet, men du kan ikke modifisere det før du har åpnet låsen.

MERKNAD

Hvis du trykker på et låst objekt, vil et låseikon vises i stedet for en menypil.

For å åpne et objekt

1. Velg objektet.

2. Klikk objektets låseikon og velg Lås opp.

Bruke avanserte sidefunksjoner
Du kan benytte deg av følgende avanserte sidefunksjoner når du oppretter

undervisningsaktiviteter:

l Sideopptak

l Sidebakgrunn og temaer

Ta opp sider med undervisningsopptaker
Du kan bruke undervisningsopptakerens tillegg til å ta opp aktiviteter på en side. Du kan

deretter avspille opptaket på samme side ved å bruke undervisningsopptakeren eller den nye

avspillings-widgeten.

MERKNAD

SMART-opptaker er et annet men lignende verktøy. Ved bruk av SMART-opptaker kan du

spille inn handlingene dine i andre program enn SMART Notebook-programvare. Med

SMART-opptaker kan du spille inn en full skjerm, et spesifisert vindu eller en rektangulær del

av skjermen. Hvis du kobler en mikrofon til datamaskinen din kan du også spille inn lyd.

Se Bruke SMART-opptaker på side 133for mer informasjon.

For å spille inn en side

1. Trykk Tillegg og trykk deretter Undervisningsopptaker.

2. Trykk Nytt opptak.

En rød firkant vises rundt utsiden av den innspilte siden.

3. Utfør de handlingene du ønsker å spille inn fra den nåværende siden.
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4. Trykk Stopp opptak når du er ferdig med disse handlingene.

TIPSS

o For å lagre opptaket ditt, trenger du bare å lagre .notebook-filen din.

o Lukk undervisningsopptakerens tillegg under presentasjoner. Avspillings-widgeten

vises på bunnen av siden. Du kan frigjøre og flytte denne til hvor som helst på

siden.

o Du kan ikke fjerne opptaket fra siden.

For å spille av et sideopptak ved bruk av tillegget undervisningsopptaker

1. Åpne siden du tok opp.

2. Hvis tillegget undervisningsopptaker ikke er åpen, trykk Tillegg og trykk deretter

Undervisningsopptaker.

3. Trykk Spill av på verktøylinjen for avspilling.

Du kan veksle mellom Spill av og Pause under avspilling av opptak.

4. Alternativt kan du utføre følgende handlinger:

o Trykk Spol tilbake for å spole tilbake en avspilling

o Trykk Spol fremover for å spole fremover i avspillingen

For å spille av et sideopptak ved bruk av avspilling-widget

1. Åpne siden du tok opp.

2. Hvis tillegget undervisningsopptaker er åpen, trykk på tilleggs-verktøylinjen for å

lukke den.

Avspillings-widgeten vises på bunnen av siden.

TIPS

Du kan frigjøre og flytte widgeten til hvor som helst på siden, slik at det er enkelt å få

tilgang til den under presentasjonen din.

3. Trykk Spill av på avspillings-widgeten.

Du kan veksle mellom Spill av og Pause under avspilling av opptak.

4. Alternativt kan du utføre følgende handlinger:

o Trykk Spol tilbake for å spole tilbake en avspilling

o Trykk Spol fremover for å spole fremover i avspillingen
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Applying page backgrounds and themes
Du kan definere utseende til sidens bakgrunn ved å bruke fanen for egenskaper eller galleriet.

Legge til bakgrunner ved hjelp av Egenskaper-fanen
Du kan sette bakgrunnen på siden i solid farge, en blanding av to farger, et mønster eller et

bilde ved hjelp av Egenskaper-fanen.

For å bruke en bakgrunn

1. Velg Format > Side > Sett bakgrunnsfyll.

Egenskaper-fanen viser alternativer for Fylleffekter.
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2. Velg en fyllstil:

Fyllstil Framgangsmåte

Ingen
(gjennomsiktig)

Velg Ingen fyll.

Klar farge a. Velg Klart fyll .

b. Gjør en av følgende:

o Velg ett av de 40 fargene i paletten.

o Press Mer , og velg deretter en farge i dialogboksen.

o Press på dråpetelleren for å velge en farge på
skjermen.

Gradient av to farger a. Velg Gradientfyll .

b. For hver farge, gjør ett av følgende:

o Velg ett av de 40 fargene i paletten.

o Press Mer , og velg deretter en farge i dialogboksen.

o Press på dråpetelleren for å velge en farge på
skjermen.

c. Velg et alternativ i Stilnedtrekkslisten .

Mønster a. Velg Mønsterfyll .

b. Velg et mønster.

c. Klikk Forgrunnsfarge, velg en farge i dialogboksen, og
trykk deretter på OK .

d. Press Bakgrunnsfarge, velg en farge i dialogboksen, og
trykk deretter på OK .

Bilde a. Velg Bildefyllet .

b. Press Bla .

Dialogboksen Åpne vises.

c. Bla og velg bildet du ønsker å bruke og trykk deretter på
Åpne.

MERKNAD

If you insert a large picture, a dialog box may appear and
prompt you to either reduce the picture’s file size or retain
the picture’s file size. For more information, see  Setting
image optimization preferences på side 168.

For å fjerne en bakgrunn

1. Velg Format > Side > Sett bakgrunnsfyll.

Egenskaper-fanen viser alternativer for Fylleffekter.

2. Velg Ingen fyll.
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Legge til bakgrunner og temaer ved å bruke galleriet
Du kan sette en side, alle sider i en gruppe eller alle sider i en fil til å bruke en bakgrunn eller et

tema fra galleriet.

For å bruke en bakgrunn eller et tema

1. Hvis galleriet ikke synes, trykk Galleri .

2. Velg Mitt Innhold i galleriets kategoriliste for å se dine egne bakgrunner og temaer (se

 Creating themes på neste side).

ELLER

Velg Galleriverktøy for å se bakgrunner og temaer du har installert sammen med

programvaren.

3. Velg Bakgrunner og temaer.

Galleriet viser miniatyrbilder av tilgjengelige bakgrunner og temaer.

4. Trykk på miniatyrbildet av temaet du ønsker å bruke.

5. Trykk på miniatyrbildets menypil og velg deretter Sett inn i Notebook.

Dialogboksen Sett inn tema vises.

6. Velg Sett inn tema på alle sider for å legge bakgrunnen eller temaet til alle sider i filen.

ELLER

Velg Sett inn tema på alle sider i den aktuelle gruppen for å legge bakgrunn eller tema til

alle sider i den aktuelle gruppen.

ELLER

Velg Sett inn tema kun på den aktuelle siden for å sette bakgrunn eller tema til den

aktuelle siden.

7. Klikk Ok.

For å fjerne en bakgrunn eller et tema

1. CTRL-klikk på siden.

2. Velg Fjern tema.

3. Velg Fra alle sider for å fjerne bakgrunn eller temaer fra alle sidene hvor de ble brukt.

ELLER

Velg Fra siden for å fjerne bakgrunnen eller temaet fra kun den utvalgte siden.
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Creating themes
You can use themes to customize pages. You can create a theme and add it to the Gallery so

that it’s available in a convenient location. You can then apply this theme to a page, all pages in

a group or all pages in a file.

Galleriet inneholder også noen temaer.

For å opprette et tema

1. Velg Format> Tema> Opprett nytt tema.

2. Skriv inn et navn for temaet i Temanavn -boksen.

3. Still inn bakgrunnen på samme måte som du gjør med en side (Se  Applying page

backgrounds and themes på side 101).

4. Legg til å modifiser objekter i temaet på samme måte som du gjør det på en side (se

Opprette grunnleggende objekter på side 27).

5. Press Lagre .

Temaet vises i Mitt innhold -kategorien i galleriet.

For å opprette et temabasert evne på en side

1. Velg Format> Tema> Opprett nytt tema fra side.

2. Skriv inn et navn for temaet i Temanavn -boksen.

3. Press Lagre .

Temaet vises i Mitt innhold -kategorien i galleriet.

Opprette et eksempel-undervisningsaktivteter
Denne delen inneholder eksempler på undervisningsaktiviteter som du kan opprette, og

forklarer hvordan du oppretter andre typer undervisningsopplegg også.

Creating a matching lesson activity

MERKNAD

Du fullfører følgende oppgaver når du oppretter lignende undervisningaktiviteter:

l Bruke aktivitetsbygger

l Legg lyd til objekter (se  Adding sounds to objects på side 96)

The Activity Builder enables you to create matching activities, sorting activities, labeling

activities, games and more using your own content.
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Using the Activity Builder, you define one object on the page as an activity object. You then

define which objects on the page will be accepted and which will be rejected when you drag

the objects over the activity object.

Å opprette en lik undervisningsaktivitet.

1. Opprett et objekt du ønsker å bruke som aktivitetsobjekt og deretter objektene du vil at

skal aksepteres eller avvises når de dras over til aktivitetsobjektet.

2. Trykk Tillegg og deretter trykk på Aktivitetsbygger.

3. Velg objektet du ønsker å bruke som aktivitetsobjekt og trykk deretter på Rediger.

4. Dra objektene du ønsker at skal aksepteres over til listen Aksepter disse objektene .

En grønn avkryssing  dukker opp ved siden av objektene du har valgt å akseptere.

5. Dra objektene du ønsker at skal avvises over til listen Avvis disse objektene .

En rød X dukker opp ved siden av objektene du har valgt å avvise.

NOTATER

o For raskt å velge de igjenværende objektene på siden til å aksepteres eller

avvises, trykk Legg alle igjenværende til den aktuelle listen.

o For å fjerne et objekt fra listen, kan du dra den til søppelkasse-ikonet

6. Klikk Ferdig.

Å endre innstillingene for en lik undervisningsaktivitet

1. Trykk Tillegg og deretter trykk på Aktivitetsbygger.

2. Velg et aktivitetsobjekt og trykk deretter Rediger.

TIPS

If you don’t know which object on the page is the activity object, click Identify. Blue

diagonal lines appear for three seconds over any activity objects on the page.

3. Trykk på Innstillinger.

4. Velg ønsket animasjon for aksepterte objekter i den første Animasjon for nedtrekklisten.

5. Alternativt kan sjekkboksen Spill også av objektlyden velges til å spille av lyder lagt til de

aksepterte objektene når de dras over til aktivitetsobjektet (se  Adding sounds to objects

på side 96).

6. Velg ønsket animasjon for avviste objekter i den første Animasjon for nedtrekklisten.

7. Alternativt kan også sjekkboksen Spill også av objektlyd velges til å spille av lyder lagt til

de avviste objektene når de dras over til aktivitetsobjektet (se  Adding sounds to objects
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på side 96).

8. Klikk Ferdig.

Å presentere en lik undervisningsaktivitet

1. Dra objekter (eller få elevene til å dra objekter) til aktivitetsobjektet.

o Hvis objektet blir akseptert, vil animasjonen for aksepterte objekter avspilles

(standardinnstilt på å forsvinne gradvis).

o Hvis objektet blir avvist, vil animasjonen for avviste objekter avspilles

(standardinnstilt på å sprette tilbake).

2. Trykk Tillegg, trykk Aktivitetsbygger og deretter trykk Gjenopprett alle når du er

ferdig.

Å fjerne en lik undervisningsaktivitet

1. Trykk Tillegg og deretter trykk på Aktivitetsbygger.

2. Velg aktivitetsobjektet og deretter trykk Fjern egenskaper.

Opprette en skjul-og-vis undervisning

MERKNAD

Du vil fullføre følgende oppgaver ved oppretting av skjul-og-vis undervisningsaktiviteter:

l Å bevege på objekter (se  Moving objects på side 56)

l Låse objekter fast (se Låse objekter på side 97)

l Endre størrelsen på objekter med skaleringsbevegelser (se   Using the scale gesture

på side 63)

Du kan skjule et objekt og deretter vise det på forskjellige måter:

l Add a Screen Shade to a page. During the presentation, gradually remove the shade to

reveal the underlying text and graphics when you’re ready to discuss them (see Bruke

skjermskyggelegging på side 122).

l Dekk objektet med digital blekk og slett det digitale blekket etterpå (se  Writing, drawing

and erasing digital ink på side 28).

l Dekk objektet med et annet objekt og endre rekkefølgen på objektene i bunken (se

 Rearranging stacked objects på side 59).

l Benytt deg av funksjonen for objektanimasjon (se  Animating objects på side 97).
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Alternativt kan du skjule et objekt bak et låst objekt og deretter bruke skaleringsbevegelsen

for å forstørre og vise det skjulte objekt hvis du bruker et interaktivt SMART-produkt som

støtter flerberøringsbevegelser.

For å opprette en skjul-og-vis undervisning

1. Opprett eller sette inn objektet du vil skjule.

2. Opprett eller sette inn objektet du vil låse.
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3. Flytt objektet du vil låse slik at det dekker det objektet du vil skjule.

4. Velg objektet du vil låse, klikk menypilen, og velg deretter Låsing> Lås på plass .

5. Benytt deg av skaleringsbevegelser for å forstørre og vise det skjulte objektet samtidig

som du holder det fastlåste objektet på plass (se   Using the scale gesture på side 63).

Opprette en skjul-og-vis undervisningsaktivitet

MERKNAD

Du vil fullføre følgende oppgaver når du oppretter avslørings-undervisningsaktiviteten:

l Opprette tabeller (se  Creating tables på side 41)

l Endre størrelsen på celler (se Endre størrelse på tabeller, kolonner eller rader på

side 47)

l Fylle bakgrunnen på en tabell med et bilde (se  Changing a table’s properties på

side 45)

l Legge objekter til celler (se  Adding objects to tables på side 43)

l Legge til og fjerne celleskygger (se  Using cell shades på side 123)
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You can use tables and cell shades to create a variety of reveal lesson activities. The following

are two examples:

l En avsløringsaktivitet i puslespill-stil der du avslører deler av et bilde før elevene kan

gjette hva bildet er.

l En avsløringsaktivitet i huskestil der du avslører innholdet i cellen og deretter ber elevene

om å velge andre celler til de finner cellen med samsvarende innhold.

For å opprette en skjul-og-vis undervisning i puslespillstil

1. Opprett en tabell med de celler du ønsker å inkludere i en skjul-og-vis-aktivitet (se

 Creating tables på side 41).

2. Gjør om størrelsen på cellene etter egne ønsker (se Endre størrelse på tabeller, kolonner

eller rader på side 47).

3. Velg tabellen, klikk tabellens menypil, og velg deretter Egenskaper .

fanen for Egenskaper vises.

4. Klikk Fyll effekter.

5. Velg Bildefyllet klikk Bla, bla til og velg bildet du vil bruke i avslørings-

undervisningsaktiviteten og trykk deretter på Åpne .

6. Velg Skalere bildet slik at det passer.

7. Klikk tabellens menypil og velg Legg til tabellskygge.
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For å opprette en skjul-og-vis undervisning i minnestil

1. Sett inn objektene du ønsker å inkludere i undervisningsaktiviteten.

2. Opprett en tabell med de celler du ønsker å inkludere i en skjul-og-vis-aktivitet (se

 Creating tables på side 41).

3. Gjør om størrelsen på cellene etter egne ønsker (se Endre størrelse på tabeller, kolonner

eller rader på side 47).

4. Dra objektene inn i cellene i tabellen.

5. Klikk tabellens menypil og velg Legg til tabellskygge.

Å presentere en skjul-og-vis undervisningsaktivitet

Klikk på en individuell celles celleskygge for å avdekke innholdet i cellen.

For å skjule cellen bak celleskyggen, klikk i hjørnet av cellen.

Opprette andre typer av undervisningsaktiviteter
The Lesson Activity Toolkit and Lesson Activity Examples in the Gallery include interactive

objects you can use to create lesson activities. For more information on the Lesson Activity

Toolkit, the Lesson Activity Examples and the Gallery in general, see  Inserting content from

the Gallery på side 72.

The SMART Exchange website includes thousands of lesson plans, question sets and other

content that you can download and then open in SMART Notebook software. For more

information on the SMART Exchange website, see Sette inn innhold fra SMART Exchange-

nettstedet på side 74.
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Kapittel 8: Presentasjon av
undervisningsaktiviteter og
tilrettelegging for samarbeid

Forberedelser før presentasjon 112
Stille inn sidevisning 113

Zooming in and out 113
Panning pages 114
Displaying pages in Full Screen view 114
Displaying pages in Transparent Background view 116
Displaying pages in Dual Page view 118

Displaying links 118
Moving windows between screens 119
Adjusting the volume 120

Bruke presentasjonsverktøy under presentasjon 120
Ta opp sider med undervisningsopptaker 120
Bruke skjermskyggelegging 122
Using cell shades 123
Using the Magic Pen 123

Velge den magiske pennen 123
Using the Magic Pen to create fading objects 124
Using the Magic Pen to open a magnification window 124
Using the Magic Pen to open a spotlight window 126

Bruke Tekstpennen 127
Skrive med tekstpenn 127
Redigering med tekstpennen 128

Lenke objekter til verktøy 130
Using the Standard pen type to create fading objects 131
Bruke SMART-Ruter 131

SMART Rute-aktiviteter 132
Bruke SMART-opptaker 133

Legge et vannmerke til opptak 133
Endre plasseringen av en opptaksfil 135
Endre video- og lydkvaliteten på et opptak 136
Endre videoformatet til en opptaksfil 137
Deaktivere maskinvareakselerasjon 138
Skjule SMART-opptakeren 139
Ta opp handlingene dine 139
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Forbedre systemytelse under opptak 141
Redusere skjermoppløsning og skjermfarger 141
Dele et opptak 141
Starte SMART-opptaker 142

Using measurement tools 143
Using the ruler 143
Using the protractor 144
Using the Geodreieck protractor 147
Using the compass 149

Fjerne eller omstille sider etter presentasjonen er ferdig 150
Clearing pages 151
Tilbakestille sider 152

Tillater to personer å bruke en interaktiv tavle 153
Enabling two people to use a SMART Board D600 series interactive whiteboard 154
Enabling two people to use a SMART Board 800 series interactive whiteboard 154

Velge verktøy 155

Etter at du har opprettet undervisningsaktiviteter i programvaren til SMART Notebook kan du

presentere undervisningsaktiviteter for studenter som benytter seg av ditt interaktive produkt

og programvarens presentasjonsfunksjoner.

In addition to presenting lesson activities to students, you can facilitate collaboration in your

classroom using SMART Notebook software and your interactive product. Specifically, you can

enable two people to use your SMART Board D600 series or 800 series interactive

whiteboard at the same time.

Forberedelser før presentasjon
When you have completed your .notebook files and are ready to present them to students,

save the files on a CD, DVD or USB drive. This enables you to access and display the files by

inserting the CD, DVD or USB drive into the computer connected to the interactive product.

Alternatively, make the files accessible on your local area network, and then browse to them

on the interactive product.

Så forbereder du presentasjonen ved å gjøre følgende:

l Stille inn sidevisningen

l Hvis lenker fra filen

l Hvis du har flere interaktive produkter i klasserommet ditt kan du flytte vinduene til

skjermene de skal vises på

l Juster lydnivået i tilfelle du skal presentere video- eller lydfiler
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Stille inn sidevisning
Du kan zoome inn og ut med vis skjermer-knappen eller flerberøringsbevegelser (dersom ditt

interaktive produkt støtter flerberøringsbevegelser).

SMART Notebook-programmet inkluderer i tillegg følgende visningsmodus:

l Fullskjermmodus fyller hele den interaktive skjermen med sideområdet ved å skjule

tittellinjen, verktøylinjen, oppgavelinjen og sidepanelet.

l Transparent bakgrunn-modus viser deg skrivebordet og vinduene bak SMART Notebook-

programvinduet og lar deg jobbe med den åpne transparente siden samtidig.

l Dobbel sidevisning viser to sider ved siden av hverandre.

Zooming in and out
Du kan zoome inn og ut med vis skjermer-knappen eller flerberøringsbevegelser (dersom ditt

interaktive produkt støtter flerberøringsbevegelser).

For å zoome inn eller ut ved bruk av Vis skjermer-knappen

1. Trykk Vis skjermer .

2. Velg et forstørrelsesnivå mellom 50 % og 300 %.

ELLER

Velg Hele siden for å få hele siden til å passe skjermen.

ELLER

Velg Sidebredde for å sette sidens bredde til samme bredde som skjermen din.

To zoom in or out using multitouch gestures

Dra fingrene i motsatt retning for å zoome inn.

ELLER

Dra fingrene mot hverandre for å zoome ut.
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En melding dukker opp og viser gjeldende zoomnivå.

Panning pages
Hvis ditt interaktive produkt støtter panoreringsbevegelsen kan du panorere en side imens du

er zoomet inn (se  Zooming in and out på forrige side).

For å panerere

1. Trykk og hold skjermen ved bruk av to fingre på samme hånd.

2. Hold fingrene på skjermen og gå opp, ned, til venstre eller høyre.

3. Når du når området du vil vise, slipper du fingrene.

Displaying pages in Full Screen view
In Full Screen view, SMART Notebook software expands the page to fill the screen by hiding

the other user interface elements. You can still access commonly used commands using the

Full Screen toolbar.

TIPS

Before displaying a page in Full Screen view, select View > Full Screen Page Border, and

then select the appropriate aspect ratio for your interactive product. A blue line appears,

indicating the portion of the page that will appear in Full Screen view without scrolling.

Denne funksjonen er nyttig når du oppretter innhold som du ønsker å presentere i

fullskjermvisning.
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For å vise en side i fullskjermmodus

Trykk Vis skjermer og velg deretter Fullskjerm.

Siden utvides for å fylle skjermen, gjemme de andre elementene i brukergrensesnittet,

og fullskjerm -verktøylinjen synes.

Knapp Kommando Handling

Forrige side Vise forrige side i filen.

Neste side Vise neste side i filen.

Flere
alternativer

Åpne en meny med alternativer.

Sidebredde Endre zoomnivået til sidens bredde.

TIPS

Dette er nyttig hvis du bruker et interaktivt
bredskjermsprodukt og grå striper vises på kantene av
siden.

Hele siden Endre zoomnivået til fullskjermsvisning.

Avslutt full
skjerm

Tilbake til standardvisningen.

Alternativer for
verktøylinje

Vise flere knapper på verktøylinjen.

NOTATER

o Verktøylinjen viser nåværende sidenummer og totalt antall sider i filen.

o Hvis SMART Response-programvaren er installert, vises ekstra knapper som gjør at

du kan sette inn spørsmål og håndtere vurderinger.



KAPITTEL 8
PRESENTASJON AV UNDERVISNINGSAKTIVITETER OG TILRETTELEGGING FOR SAMARBEID

116

For å vise flere verktøylinjeknapper

Trykk Alternativer for verktøylinje .

Verktøylinjen utvides til å omfatte følgende knapper:

Knapp Kommando Handling

Sett inn tom
side

Sett inn en ny og tom side i den nåværende filen.

Angre Omgjør siste handling.

Velg Velg objekter på gjeldende side.

Magisk penn For å opprette objekter som falmer gradvis ut, åpne
forstørrelsesglass-vinduet eller åpne følgespotvinduet (se
 Using the Magic Pen på side 123).

Displaying pages in Transparent Background view
Using Transparent Background view, you can see the desktop and windows behind the

SMART Notebook software window and continue to interact with the open, transparent page.

You can draw in digital ink on a transparent page and save your notes in the file. You can also

display measurement tools, take screen captures and more. If an area of the screen doesn’t

include any SMART Notebook software objects, you can select and interact with the desktop

and applications behind the SMART Notebook software window.

For å vise en side med transparent bakgrunn

Trykk Vis skjermer og velg deretter Transparent bakgrunn.

Bakgrunnen for SMART Notebook-programvarevinduet blir gjennomsiktig slik at du kan

se skrivebordet og programmene bak SMART Notebook-programvaren, men ethvert

objekt på .notebookfilsiden forblir synlig.

Verktøyslinjen for gjennomsiktig bakgrunn vises.

Knapp Kommando Handling

Velg Velg objekter på nåværende side eller samhandle med
stasjonære- og applikasjonsobjekter som ikke er dekket av
et SMART Notebook-programvareobjekt.

Penner og
merkepenner

Skrive eller tegne med digitalt blekk på nåværende side.
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Knapp Kommando Handling

Forrige side Vise forrige side i den nåværende filen.

Neste side Vise neste side i den nåværende filen.

Flere
alternativer

Åpne en meny med alternativer som gjør det mulig å legge
til en skjermskygge, velge annerledes digitalt blekk, velge
en kreativ pennstil, legge til rette streker, legge til former og
mer.

Gå ut av
gjennomsiktig
bakgrunn

Tilbake til standardvisningen.

Alternativer for
verktøylinje

Vise flere knapper på verktøylinjen.

NOTATER

o Verktøylinjen viser nåværende sidenummer og totalt antall sider i filen.

o Hvis SMART Response-programvaren er installert, vises ekstra knapper som gjør at

du kan sette inn spørsmål og håndtere vurderinger.

For å vise flere verktøylinjeknapper

Trykk Alternativer for verktøylinje .

Verktøylinjen utvides til å omfatte følgende knapper:

Knapp Kommando Handling

Sett inn tom
side

Sett inn en ny og tom side i den nåværende filen.

Angre Omgjør siste handling.

Slett Slett alle markerte objekter.

Tøm side Slett all digitalt blekk og slett alle objekter fra siden.

Verktøylinje for
skjermkopiering

Åpne verktøylinjen for skjermbildekopiering.

Sett inn linjal Sett en linjal inn på siden (se  Using the ruler på side 143).

Sett inn
transportør

Sett en transportør inn på siden (se  Using the protractor på
side 144).
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Knapp Kommando Handling

Sett inn
geometrisk
vinkelmåler

Sett en geometrisk vinkelmåler inn på siden (se  Using the
Geodreieck protractor på side 147).

Sett inn passer Sett inn en passer på siden (se  Using the compass på
side 149).

Displaying pages in Dual Page view
You can display two pages side-by-side. You can draw, make notes, import files and add links

on either page in the same way as you would on a single page.

Når du viser to sider, kan du feste en side for å fortsette å vise det på sideområdet mens du

viser andre sider i sidesorteringsfunksjonen.

For å vise i dobbeltsidig visning

Trykk Vis skjermer og velg deretter Dobbel sidevisning.

A second page appears. A red border indicates the active page.

For å feste en side

1. Vis dobbel sidevisning hvis du ikke allerede har gjort det.

2. Velg siden du vil fortsette å vise.

3. Velg Vis > Dobbelt sidevisning > Fest side.

Festeikoner vises i de øverste hjørnene av den låste siden.

For å feste fra en side

Oppheve valget av Vis > Dobbel sidevisning > Fest side.

For å tilbakestille til standard visning

Trykk Vis skjermer og velg deretter Enkel sidevisning.

Displaying links
You can attach a copy of a file, a shortcut to a file, a link to a web page or a sound file to any

object on a page (see  Adding links to objects på side 94). You can display an animated

indicator around each object that has a link.



KAPITTEL 8
PRESENTASJON AV UNDERVISNINGSAKTIVITETER OG TILRETTELEGGING FOR SAMARBEID

119

For å vise lenkekoblinger ved åpning av en side

Select View > Show All Links When Page Opens.

Each time you open a page, an animated indicator appears around each object that has a

link. Depending on how you define the links, each indicator surrounds either the entire

object or an icon in the object’s lower-left corner. The indicators disappear automatically

after several seconds.

MERKNAD

Opphev valget av Vis > Vis alle koblinger når siden åpnes for å stoppe visningen av

koblinger når du åpner en side.

For å vise lenkekoblinger på en aktuell side

Velg Vis > Vis alle koblinger .

An animated indicator appears around each object that has a link. Depending on how you

define the links, each indicator surrounds either the entire object or an icon in the object’s

lower-left corner. The indicators disappear automatically after several seconds.

Moving windows between screens
You can operate multiple interactive products from the same computer. You can split the

computer display over two or more screens, or you can display some programs on one screen

and other programs on another. For more information, see Connecting multiple interactive

whiteboards to one computer (smarttech.com/kb/000315).

Hvis du kobler flere interaktive produkter på en datamaskin kan du flytte vinduer fra en skjerm

over på en annen.

For å flytte et vindu fra en skjerm til en annen

1. Vis vinduet hvis du ikke allerede har gjort det.

MERKNAD

Du kan kun flytte et vindu dersom det ikke er maksimert eller minimert.

2. Klikk og hold vinduet på den første skjermen med en finger.

3. Klikk den andre skjermen med din andre hånd.

4. Løft fingeren fra den første skjermen.

Vinduet forsvinner fra den første skjermen og vises på den andre.

http://www.smarttech.com/kb/000315
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Adjusting the volume
Hvis du skal presentere en video eller en lydfil og ønsker å justere lydstyrken, kan du gjøre

dette ved å presse inn knappen Lydkontroll og deretter kan du justere lydstyrken for

operativsystemet ditt.

MERKNAD

Sørg for at høyttalerne dine er påslått.

For å legge denne knappen til verktøylinjen, se  Customizing the toolbar på side 165.

Bruke presentasjonsverktøy under
presentasjon
Du kan bruke følgende verktøy imens du presenterer undervisningsaktiviteter:

l Skjermskyggelegging

l Celleskygger

l Magisk penn

l Tekstpenn (for å skrive med blekk som kan redigeres)

l Standardpenntype (for å lage falmende objekter)

l SMART-Ruter

l Måleverktøy

o Linjal

o Vinkelmåler

o Geodreieckvinkelmåler

o Passer

Ta opp sider med undervisningsopptaker
Du kan bruke undervisningsopptakerens tillegg til å ta opp aktiviteter på en side. Du kan

deretter avspille opptaket på samme side ved å bruke undervisningsopptakeren eller den nye

avspillings-widgeten.

MERKNAD

SMART-opptaker er et annet men lignende verktøy. Ved bruk av SMART-opptaker kan du

spille inn handlingene dine i andre program enn SMART Notebook-programvare. Med

SMART-opptaker kan du spille inn en full skjerm, et spesifisert vindu eller en rektangulær del

av skjermen. Hvis du kobler en mikrofon til datamaskinen din kan du også spille inn lyd.

Se Bruke SMART-opptaker på side 133for mer informasjon.



KAPITTEL 8
PRESENTASJON AV UNDERVISNINGSAKTIVITETER OG TILRETTELEGGING FOR SAMARBEID

121

For å spille inn en side

1. Trykk Tillegg og trykk deretter Undervisningsopptaker.

2. Trykk Nytt opptak.

En rød firkant vises rundt utsiden av den innspilte siden.

3. Utfør de handlingene du ønsker å spille inn fra den nåværende siden.

4. Trykk Stopp opptak når du er ferdig med disse handlingene.

TIPSS

o For å lagre opptaket ditt, trenger du bare å lagre .notebook-filen din.

o Lukk undervisningsopptakerens tillegg under presentasjoner. Avspillings-widgeten

vises på bunnen av siden. Du kan frigjøre og flytte denne til hvor som helst på

siden.

o Du kan ikke fjerne opptaket fra siden.

For å spille av et sideopptak ved bruk av tillegget undervisningsopptaker

1. Åpne siden du tok opp.

2. Hvis tillegget undervisningsopptaker ikke er åpen, trykk Tillegg og trykk deretter

Undervisningsopptaker.

3. Trykk Spill av på verktøylinjen for avspilling.

Du kan veksle mellom Spill av og Pause under avspilling av opptak.

4. Alternativt kan du utføre følgende handlinger:

o Trykk Spol tilbake for å spole tilbake en avspilling

o Trykk Spol fremover for å spole fremover i avspillingen

For å spille av et sideopptak ved bruk av avspilling-widget

1. Åpne siden du tok opp.

2. Hvis tillegget undervisningsopptaker er åpen, trykk på tilleggs-verktøylinjen for å

lukke den.

Avspillings-widgeten vises på bunnen av siden.

TIPS

Du kan frigjøre og flytte widgeten til hvor som helst på siden, slik at det er enkelt å få

tilgang til den under presentasjonen din.
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3. Trykk Spill av på avspillings-widgeten.

Du kan veksle mellom Spill av og Pause under avspilling av opptak.

4. Alternativt kan du utføre følgende handlinger:

o Trykk Spol tilbake for å spole tilbake en avspilling

o Trykk Spol fremover for å spole fremover i avspillingen

Bruke skjermskyggelegging
Hvis du ønsker å dekke over informasjon og avsløre det sakte under en presentasjon, kan du

legge en skjermskygge til en side. Du kan også endre fargen på skjermskyggen, slik at du

forbedrer presentasjonen din.

Hvis du legger til en Skjermskyggelegging til en side og lagrer filen, vises

Skjermskyggeleggingen over siden neste gang du åpner filen.

For å legge skjermskygge til en side

1. Trykk Vis/skjul skjermskygge .

Skjermskyggelegging vises over hele siden.

2. Trykk på skjermskygge for å endre den automatisk til en annen farge.

For å avsløre en del av siden

Dra en av Skjermskyggeleggingens Størrelse-håndtak (de små sirklene på siden av

Skjermskyggen).

For å fjerne skjermskyggeleggingen fra en side

Trykk Vis/skjul skjermskygge .

ELLER

Trykk Lukk øverst i høyre hjørne av skjermskyggen.
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Using cell shades
You can add a cell shade to a table cell. This enables you to reveal the information in the cells

during a presentation.

NOTATER

l Du må fjerne celleskyggen hvis du ønsker å endre cellens egenskaper; sette inn

kolonner eller rader; fjerne kolonner, rader eller celler eller dele eller slå sammen celler.

l Du kan også legge til en skjermskygge som dekker en hel side (se Bruke

skjermskyggelegging på forrige side ).

For å legge til en celleskygge

1. Velg cellen.

2. Klikk cellens menypil og velg Legg til celleskygge.

For å vise og skjule innholdet i en celle

1. Klikk celleskyggen.

Celleskyggen forsvinner og cellens innhold blir avslørt.

2. Klikk øverst til venstre i hjørnet til cellen.

Celleskyggen vises og skjuler cellens innhold.

For å fjerne en celleskygge

1. Velg cellen.

2. Klikk cellens menypil og velg Fjern celleskygge.

Using the Magic Pen
Den Magiske Pennen lar deg gjøre følgende:

l Opprett et objekt som sakte falmer

l Åpne et forstørrelsesvindu

l Åpne et følgespotvindu

Velge den magiske pennen
Du må velge den magiske pennen før du kan bruke den.
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For å velge magisk penn

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Magisk penn.

Using the Magic Pen to create fading objects
Du kan lage et objekt som sakte falmer ved bruk av den Magiske Pennen.

MERKNAD

Falmende objekter lagres ikke i .notebook-filer .

For å lage et falmende objekt

1. Velg Magisk penn(se Velge den magiske pennen på forrige side).

2. Ved hjelp av fingeren eller en penn kan du skrive eller tegne objekter på den interaktive

skjermen.

Objektene falmer sakte.

For å stille inn antall sekunder det tar før et objekt falmer

1. Velg Magisk penn(se Velge den magiske pennen på forrige side).

2. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

3. Klikk Fyll effekter.

4. Skriv eller velg antall sekunder du vil at det skal ta før objektet toner ut i Falmetid -

nedtrekklisten.

TIPS

Du kan lagre endringene du har lagret i den magiske pennverktøyets

standardinnstillinger ved å klikke Lagre Verktøyegenskaper (se  Saving tool settings på

side 56).

Using the Magic Pen to open a magnification window
Du kan bruke den Magiske Pennen til å åpne et forstørret vindu.
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For å åpne et forstørringsvindu

1. Velg Magisk penn(se Velge den magiske pennen på side 123).

2. Ved hjelp av fingeren eller en penn kan du tegne en firkant eller rektangel på den

interaktive skjermen.

Et forstørrelsesvindu åpnes.

TIPS

Du kan tegne en firkant som du vil tone ut eller inn istedenfor å åpne et forstørringsvindu

ved bruk av Standardpennen (se  Using the Standard pen type to create fading objects

på side 131).

3. Gjør følgende:

o For å redusere forstørrelsesvinduets størrelse, trykk i midten av vinduet, og drar

deretter til venstre.

o For å øke forstørrelsesvinduets størrelse, trykk i midten av vinduet, og dra deretter til

høyre.

o Å flytte forstørrelsesvinduet, trykk nær kanten av vinduet, og dra den deretter.

4. Trykk Lukk når du er ferdig.
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Using the Magic Pen to open a spotlight window
Du kan åpne en følgespotvindu ved hjelp av Magisk Penn.

For å åpne et følgespotvindu

1. Velg Magisk penn(se Velge den magiske pennen på side 123).

2. Ved hjelp av fingeren eller en penn, tegne en sirkel eller ellipse på den interaktive

skjermen.

En følgespotvindu vises.

TIPS

Du kan tegne en sirkel som falmer istedenfor å åpne et forstørringsvindu ved å bruke

standardpennen (se  Using the Standard pen type to create fading objects på side 131).

3. Gjør følgende:

o For å redusere følgespotvinduets størrelse, trykker du i midten av vinduet, og drar

det deretter til venstre.

o For å øke følgespotvinduets størrelse, trykker du i midten av vinduet, og drar det

deretter til høyre.

o For å flytte følgespotvinduet, trykk nær kanten av vinduet og dra det deretter.

4. Trykk Lukk når du er ferdig.

Bruke Tekstpennen
Tekstpennen lar deg gjøre følgende:
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l Skrive notater som automatisk konverterer til redigerbar tekst
l Redigere teksten mens du jobber uten å røre et tastatur

Skrive med tekstpenn
Du kan skrive notater som automatisk konvertere til redigerbar tekst ved hjelp av

Tekstpennen.

For å skrive redigerbar tekst

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyperog velg Tekstpenn.

3. Velg en linjetype.

TIPS

Write tidy, printed characters on a horizontal line. Although SMART Notebook software

can convert slanted or cursive writing, it doesn’t always do so consistently.

4. Skriv digitalt blekk-notater på siden.

Your handwriting converts to typed text. Accept and reject icons appear beside the typed

text.

5. Press for å godta skrevet tekst.

ELLER

Press for å gjenopprette dine håndskrevne notater.

TIPS

o Du kan uføre denne handlingen mens tekstpennen er aktiv, uten å bytte til

velgerverktøy

o Skrevet tekst aksepteres som standard hvis du ikke trykker på en av ikonene.
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Redigering med tekstpennen
Du kan bruke markeringer og foreta revisjoner av redigerbar tekst ved hjelp av Tekstpennen.

Du kan slette uønsket tekst ved å tegne en stek gjennom teksten. Du kan bruke forskjellige

blekkfarger til å fremheve forskjellige deler av teksten din. Du kan også bruke andre

markeringer for å sette inn mellomrom, for å sette inn tekst og erstatte tekst med ny tekst.

TIPS

Skriv dine markeringer i en annen farge enn din redigerbare tekst. Dette gjør det lettere for

elevene å se endringene når du presenterer skriftlige leksjoner.

Eksempler på tilgjengelige markeringer er gjengitt i tabellen nedenfor:

Rediger Instruksjon Eksempel

Slett tekst Tegn en stek gjennom teksten.

Sett inn
mellomrom

Tegn en loddrett strek i teksten.

Sett inn tekst 1. Tegn symbolet ^ der du vil sette
inn tekst.

2. Skriv inn den nye teksten i
tekstboksen som vises.

TIPS

Trykk på en linjetype eller trykk
på Farge for å velge en ny
farge til teksten som er satt inn.

Ord som mest ligner det du har
skrevet vises under din håndskrift.

3. Velg et ord for å sette det som
skrevet tekst. Du kan også presse

for å velge automatisk ordet
som vises som uthevet tekst.

ELLER

Press å avbryte innsetting av
tekst.
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Rediger Instruksjon Eksempel

Erstatt tekst 1. Tegn en sirkel rundt teksten du
ønsker å erstatte.

2. Skriv inn erstatningsteksten i
boksen som vises.

Ord som mest ligner det du har
skrevet vises under din håndskrift.

3. Velg et ord til å erstatte den

skrevne tekst eller trykk for å
automatisk velge ordet som vises
som uthevet tekst.

ELLER

Press å avbryte erstatte tekst.

Endre
tekstfarge

1. Trykk på en linjetype eller trykk
på Farge for å velge en ny
farge til teksten som er satt inn.

2. Tegn en sirkel rundt teksten du
ønsker å endre.

3. Trykk for å akseptere
automatisk det nye fargeutvalget.

ELLER

Trykk for å avbryte det nye
fargeutvalget.

Endre
tekstfarge på
en hele ord
ved hjelp av
bevegelser

1. Trykk på en linjetype eller trykk
på Farge for å velge en ny
farge til ordet som er satt inn.

2. Tegn en horisontal linje gjennom
ordet og gå tilbake til starten av
linjen ved hjelp av en bakover og
fremover bevegelse.

Ordet endrer automatisk til det
nye fargeutvalget.

Lenke objekter til verktøy
SMART Notebook-programvarens side for verktøy, innebærer knapper som lar deg opprette

og jobbe med grunnleggende objekter på sidene: Hvis brukerne dine syntes det er vanskelig

å finne verktøylinjen, kan du lenke et objekt til "Velg verktøy", Pennverktøy eller viskeverktøy

for å egendefinere et verktøy som du deretter kan plassere hvor som helst på siden. Trykk på

objektet du vil velge til enhver tid for å aktivere verktøyet..

For å lenke et objekt til et verktøy

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke til verktøy.
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3. Trykk på et av følgende verktøyalternativer:

Ditt objekt er lenket til verktøyet.

Når du trykker på den lenkede objektet, vil verktøyet aktiveres:

Pennverktøy l Når du klikker på objektet, vil penn-verktøyet aktiveres
l Du kan skrive innhold bare med funksjonen penn.

Viskelær l Når du klikker på objektet, vil verktøyet viskelær

aktiveres.
l Du kan viske ut innhold laget av hvilken som helst

penntype.

Valg l Når du klikker på objektet, vil verktøyet Velg aktiveres.
l Du kan klikke på et nytt objekt på siden for å åpne

menyen eller flytte den rundt på siden.

TIPS

l Du kan tegne ditt eget objekt, bruke et objekt fra galleriet eller bruke et tekstobjekt.
l Du kan velge på forehånd hvilke farge- eller linjealternativer for pennen din før du

lenker et objekt til pennverktøyet. Hvis du velger et nytt farge- eller linjealternativ

gjennom Penn-verktøyet, vil endringen skje automatisk til det lenkede objektet.

For å slette en objektlenke fra et verktøy

1. Velg objektet.

2. Trykk objektets menypil, og velg deretter Lenke til verktøy.

3. Trykk Ingen.

Using the Standard pen type to create fading objects
Du kan lage frihåndsobjekter som falmer etter en bestemt tidsperiode ved hjelp av

Penneverktøyet.

MERKNAD

Du kan også lage frihåndsobjekter som falmer etter en spesifisert tidsperiode med en

magisk penn(se  Using the Magic Pen to create fading objects på side 124).
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For å skrive eller tegne med falmende digitalblekk

1. Press Penner .

Knappene for pennverktøy vises.

2. Press Pennetyper , og velg deretter Penn .

3. Velg en linjetype.

4. Hvis fanen for Egenskaper ikke vises, trykk Egenskaper .

5. Klikk Fyll effekter.

6. Velg boksen for å Aktivere at blekk kan falme etter at du skriver det , og angi deretter

eller velge antall sekunder mellom den tiden du skriver eller tegner digitalt blekk og tiden

det blekner i nedtrekkslisten for Falmingstid .

7. Skrive eller tegne digitalt blekk på siden.

Bruke SMART-Ruter
SMART Blocks is an add-on that enables you to perform math activities with your class by

writing numbers on the page, and then connecting them to a SMART Block. You can choose

from seven different equation types to work with. You can learn how to use SMART Blocks

through the pop-up guide.

For å få tilgang til SMART-ruter

Trykk Tillegg og velg deretter SMART-Ruter.

For å få tilgang til sprettoppveiledningen for SMART-Ruter

1. Trykk Tillegg og velg deretter SMART-Ruter.

2. Press Lær mer .

SMART Rute-aktiviteter
Følgende SMART Rute-aktiviteter er tilgjengelige:
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SMART-
Ruter

Funksjon

Addition blocks accept up to two inputs. The output is the sum of the inputs.

Subtraction blocks accept up to two inputs. The output is the difference of
the inputs.

Multiplication blocks accept up to two inputs. The output is the product of the
inputs.

Division blocks accept up to two inputs. The output is the quotient of the
inputs.

Power blocks accept up to two inputs. The output is the first input to the
power of the second input.

Square root blocks accept one input. The output is the square root of the
input.

Unknown blocks accept two inputs. The output is a random operation applied
to the inputs.

Bruke SMART-opptaker
Using SMART Recorder, you can record your actions on your interactive product. If you

connect a microphone to your computer, you can record your voice as well.

Etter at du har tatt et opptak, kan du spille av opptaket ved bruk av QuickTime-programvaren.
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Legge et vannmerke til opptak
Du kan endre innstillingene i SMART Recorder til å legge til et vannmerke i bakgrunnen til et

opptak.

Legge et vannmerkebilde til opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

MERKNAD

Hvis SMART-opptakeren er skjult, press SMART-opptaker ikonet i

systemstatusfeltet, og velg deretter Konfigurer alternativer .

Alternativerdialogboksen vises.

2. Trykk på Vannmerkefanen .

3. Velg Bilde.

4. Press Bla .

5. Bla og velg bildet du vil bruke, og trykk deretter på Åpne.

6. Klikk Egenskaper.

The Watermark Properties dialog box appears. A preview of your selected image

appears in the Preview pane.

7. Gjør følgende:

o For å endre vannmerkets posisjon, dra forhåndsvisningsbildet til et annet område i

Forhåndsvisningsruten .

o For å endre vannmerkets størrelse, drar du i den hvite sirkelen nederst i høyre hjørne

på forhåndsvisningsbildet.

8. Velg innstillingene Gjennomsiktighet og Effekt .

9. Press OK for å lukke dialogboksen Egenskaper for vannmerke .

10. Hvis du vil gå tilbake til å ikke bruke vannmerke etter at SMART-Opptaker stenger, velg

Slå av vannmerket når opptakeren stenger .

11. Press OK for å lukke dialogboksen for Alternativer .

Legge vannmerketekst til opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

MERKNAD

Hvis SMART-opptakeren er skjult, press SMART-opptaker ikonet i

systemstatusfeltet, og velg deretter Konfigurer alternativer .

Alternativerdialogboksen vises.
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2. Trykk på Vannmerkefanen .

3. Velg Tekst .

4. Skriv inn teksten for vannmerket.

5. Klikk Egenskaper.

The Watermark Properties dialog box appears. A preview image appears in the Preview

pane.

6. Velg innstillingene Farge , Skrifttype og Gjennomsiktighet .

7. Gjør følgende:

o For å endre vannmerkets posisjon, dra forhåndsvisningsbildet til et annet område i

Forhåndsvisningsruten .

o For å endre vannmerkets størrelse, drar du i den hvite sirkelen nederst i høyre hjørne

på forhåndsvisningsbildet.

o For å legge til mer informasjon i vannmerket, velg Legg til dagens dato, Legg til

klokkeslett og/eller Legg til rammenummer.

8. Press OK for å lukke dialogboksen Egenskaper for vannmerke .

9. Hvis du vil gå tilbake til å ikke bruke vannmerke etter at SMART-Opptaker stenger, velg

Slå av vannmerket når opptakeren stenger .

10. Press OK for å lukke dialogboksen for Alternativer .

Fjerne et vannmerke fra opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

MERKNAD

Hvis SMART-opptakeren er skjult, press SMART-opptaker ikonet i

systemstatusfeltet, og velg deretter Konfigurer alternativer .

Alternativerdialogboksen vises.

2. Trykk på Vannmerkefanen .

3. Velg Ikke noe vannmerke .

4. Press OK .

Endre plasseringen av en opptaksfil
Du kan endre innstillingene til SMART Recorder til å velge plasseringen til en opptaksfil.

Endre mappen SMART-Opptaker lagrer filer i

1. Velg Meny> Alternativer i SMART-Opptaker.

En dialogboks vises.
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2. Klikk Målrettede filer -fanen.

3. Klikk Søk -knappen ved siden av Standardlagringskatalog -boksen.

4. Søk og velg den mappen du ønsker å lagre filene i og klikk Still inn.

TIPS

For å få best mulig ytelse bør du lagre filene på PC-ens harddisk istedenfor på en

nettverksstasjon.

5. Press OK .

Endre mappen SMART-Opptaker lagrer midlertidige filer i

1. Velg Meny> Alternativer i SMART-Opptaker.

En dialogboks vises.

2. Klikk Målrettede filer -fanen.

3. Klikk Søk -knappen ved siden av Midlertidige filer katalog -boksen.

4. Søk og velg den mappen du vil lagre midlertidige filer i og trykk Still inn.

TIPS

For best mulig ytelse bør du lagre filer og midlertidige filer på samme stasjon for å

redusere tiden som behøves til å lagre et opptak.

5. Press OK .

Spesifisere grenser for diskplass

1. Velg Meny> Alternativer i SMART-Opptaker.

En dialogboks vises.

2. Klikk Målrettede filer -fanen.

3. Velg Varsle meg dersom ledig minne på disken er under -avmerkingsboksen, og skriv en

grense for ledig minne du vil at det skal genereres en varselmelding for når

minnekapasiteten blir for lav.

4. Skriv inn en grense for hvor lite diskplass det skal være før SMART Recorder slutter å ta

opp.

5. Press OK .

Gjenopprette standard filplassering for opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

En dialogboks vises.

2. Klikk Målrettede filer -fanen.
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3. Klikk Gjenopprett standardinnstillinger.

4. Press OK .

Endre video- og lydkvaliteten på et opptak
Du kan endre innstillingene til SMART Recorder til å kontrollere lyd- og videokvaliteten på et

opptak.

Endre video- og lydkvaliteten på et opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

En dialogboks vises.

2. Klikk fanen for Opptakskvalitet .

3. Velg en lydkvalitet i Lydkvalitet -listen.

MERKNAD

Selv om høyere lydkvalitet produserer bedre lydavspilling, øker det også filstørrelsen.

4. Velg en videokvalitet i Videokvalitet -listen.

ELLER

Velg Tilpass og skriv ønsket bildehastighet.

MERKNAD

Selv om høyere bildefrekvens produserer bedre opptakskvalitet, øker det også

filstørrelsen.

TIPS

Hvis du velger Automatisk valg (anbefalt) vil SMART-opptaker evaluere datamaskinen

din automatisk og velge optimal bildehastighet.

5. Press OK .

Gjenopprette standard video- og lydkvalitet på et opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

En dialogboks vises.

2. Klikk fanen for Opptakskvalitet .

3. Klikk Gjenopprett standardinnstillinger.

4. Press OK .

Endre videoformatet til en opptaksfil
Du kan endre innstillingene til SMART Recorder til å velge videoformatet til en opptaksfil.
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Endre videoformatet til en opptaksfil

1. Velg Meny> Alternativer i SMART-Opptaker.

MERKNAD

Hvis SMART-opptakeren er skjult, press SMART-opptaker ikonet i

systemstatusfeltet, og velg deretter Konfigurer alternativer .

Alternativerdialogboksen vises.

2. Klikk Videoformat -fanen.

3. Velg Windows Media Video (*.wmv) eller SMART-opptaker video (*.avi).

NOTATER

o Any version of Windows Media Player can play a Windows Media video file.

Windows Media Player can also play a SMART Recorder video file if

SMART Notebook software is installed on the computer playing the file.

Any version of Windows Media Player can play a Windows Media video file.

Windows Media Player can also play a SMART Recorder video file if

SMART Meeting Pro software is installed on the computer playing the file.

o Du kan konvertere en videofil fra SMART-Opptaker til en Windows Media-videofil

ved å dele opptaket (se Dele et opptak på side 141 ).

4. Press OK .

Gjenopprette standard videoformat for et opptak

1. Velg Meny> Alternativer i SMART-Opptaker.

MERKNAD

Hvis SMART-opptakeren er skjult, press SMART-opptaker ikonet i

systemstatusfeltet, og velg deretter Konfigurer alternativer .

Alternativerdialogboksen vises.

2. Klikk Videoformat -fanen.

3. Klikk Gjenopprett standardinnstillinger.

4. Press OK .

Deaktivere maskinvareakselerasjon
SMART Recorder constantly takes screen captures as you record. Some operating systems

take screen captures very slowly and this can affect recording quality. To improve recording

quality, disable hardware acceleration or upgrade your video driver and video card.
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VIKTIG

Hvis du deaktiverer maskinakselerering, kan dette redusere ytelse til SMART Notebook-

programvare.

MERKNAD

Denne fremgangsmåten kan variere avhengig av hvilken versjon av Vinduer-

operativsystemet du har og systempreferansene dine.

Deaktivere maskinvareakselerering

1. Åpne Windows kontrollpanel.

2. Klikk Skjerm, klikk Endre skjerminnstillinger og deretter Avanserte innstillinger.

3. Klikk fanen for feilsøking.

4. Dra glidebryteren for Maskinvareakselerasjon til Ingen.

5. Press OK .

6. Start datamaskinen på nytt.

Skjule SMART-opptakeren
Hvis du ønsker, kan du skjule SMART-opptakeren, men fortsatt ha tilgang til menyvalgene ved

bruk av SMART-opptaker -ikonet .

Skjule SMART-Opptaker

I SMART-opptaker velger du Meny > Skjul til Systemstatusfelt ..

SMART Recorder forsvinner.

Vise SMART-Opptaker

Trykk på ikonet for SMART-opptaker i meldingsområdet, og velg deretter Vis.

SMART Recorder vises.

Ta opp handlingene dine
Using SMART Recorder, you can record the full screen or a rectangular portion of the screen. If

you connect a microphone to your computer, you can record your narration. You can create

the recording as a video file that you can view using QuickTime software.

Opprette et opptak

1. Endre innstillingene til SMART Recorder for å konfigurere opptakets kvalitet og

filplassering.
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MERKNAD

Hvis du har flere skjermer, må du velge den skjermen du vil ta opp.

2. For å ta opp hele skjermen, press Ta opp .

ELLER

For å ta opp et skjermområde, press nedoverpilen ved siden av Opptakstasten i

SMART-opptakeren, velg Opptaksområdeog tegn et rektangel rundt området du vil ta

opp.

TIPS

Hvis du må redusere opptakets filstørrelse, begrenser du opptaket til et rektangulært

område av skjermen eller til et vindu.

3. Perform the on-screen actions you want to record. If you connected a microphone to your

computer, speak into your microphone.

SMART Recorder viser medgått tid i løpet av opptaket.

TIPS

Animasjoner og andre spesialeffekter øker opptakets filstørrelse i stor grad.

4. If you want to pause your recording, press Pause . To resume recording, press Record

.

5. Etter at du har fullført handlingene du vil ta opp, press Stopp i SMART-opptakeren.

En dialogboks vises.

MERKNAD

Hvis du ønsker å avslutte uten å lagre innspillingen kan du klikke Avbrytog klikke Ja for

å bekrefte slettingen, og så ignorere resten av prosedyren.

6. Skriv inn et filnavn.

7. Hvis du vil lagre opptaket på et annet sted, blar du gjennom til det nye stedet.

8. Press Lagre .

After SMART Recorder creates the video file, a dialog box appears. The information in this

dialog box includes the file location of the recording, file size and duration of the

recording.

9. Hvis du vil se innspillingen etter at du lukker denne dialogboksen, velg Spill av innspilling.

ELLER

Hvis du ønsker å lukke denne dialogboksen uten å se innspillingen, klikk Ok.
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Forbedre systemytelse under opptak

Hvis systemytelsen er treg når du bruker SMART-opptaker, eller opptakskvaliteten ikke er

standarden du ønsker, kan følgende handlinger forbedre ytelsen:

l Reduce your computer’s screen resolution and display color settings. Smaller screens and

fewer colors result in faster performance.

l Save your files to a local hard disk. Network drives are slower and reduce performance.

l Select a lower video quality setting. You need to balance your expectations for video

quality with your computer’s limitations. Higher video quality produces larger files and

places higher demands on your computer.

Redusere skjermoppløsning og skjermfarger
If your system performance slows down when you use SMART Recorder, or the recording

quality isn’t as good as you want, you can reduce your computer’s screen resolution and

display colors. Smaller screens and fewer colors result in faster performance.

MERKNAD

Denne fremgangsmåten kan variere avhengig av hvilken versjon av Vinduer-

operativsystemet du har og systempreferansene dine.

Redusere skjermoppløsning og -farger

1. Åpne Windows kontrollpanel.

2. Klikk Vis, og klikk deretter Endre skjerminnstillinger.

3. Velg en lavere innstilling i Oppløsning -nedtrekksmenyen.

4. Velg en lavere innstilling i Farger -nedtrekksmenyen.

MERKNAD

Du kan ikke endre skjermfarger i Windows 7 og nyere operativsystemer.

5. Press OK .

Dele et opptak
If you want to share a recording with viewers who have SMART Notebook software, create a

recording as a SMART Recorder video file that they can play using SMART Video Player. If you

want to share the recording with viewers who don’t have SMART Notebook software, create a

Windows Media video file that they can play using Windows Media Player, or create a self-

extracting file that they can play on any computer.
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If you want to share a recording with viewers who have SMART Meeting Pro software, create a

recording as a SMART Recorder video file that they can play using SMART Video Player. If you

want to share the recording with viewers who don’t have SMART Meeting Pro software, create

a Windows Media video file that they can play using Windows Media Player, or create a self-

extracting file that they can play on any computer.

Konvertere en videofil fra SMART-Opptaker

1. Velg Meny > Del innspilling i SMART-opptaker.

MERKNAD

Hvis SMART-opptakeren er skjult, press SMART-opptaker ikonet i

systemstatusfeltet, og velg deretter Konfigurer alternativer .

Del innspilling -dialogboksen vises.

2. Velg WMV for å opprette en Windows Media-videofil.

ELLER

Velg Selvekstraherende for å opprette en selvekstraherende fil og klikk Neste.

3. Press Bla .

4. Søk deg frem til og velg SMART-opptakervideofilen du ønsker å konvertere og klikk

Åpne.

5. Klikk Neste.

6. Hvis du vil endre plasseringen eller navnet til den konverterte filen, klikk Søk, søk deg

frem til den plassen du ønsker å lagre filen på, skriv et navn for filen og klikk Lagre.

7. Klikk Neste.

8. Press Fullfør.

Starte SMART-opptaker
Første skritt i bruken av SMART Recorder er å starte den.

Starte SMART-Opptaker

CTRL-klikk Tavleverktøy -ikonet i dokken og velg Opptaker.

MERKNAD

Hvis datamaskinen ikke er koblet til et interaktivt produkt, omfatter Tavleverktøyikonet

en X i det nedre høyre hjørnet .

Hvis datamaskinen ikke er koblet til et interaktivt produkt, er SMART Tavleikonet grått

og inneholder en X i det nedre høyre hjørnet .

I Windows 7-operativsystemet, velg Start > Alle program > SMART Technologies >
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SMART-verktøy > Opptaker.

ELLER

I Windows 8-operativsystemet, gå til siden med applikasjoner og bla deg frem til og

klikk Opptaker.

SMART Recorder vises.

Using measurement tools
Med måleverktøyene til SMART Notebook-programvaren kan du sette en linjal, en transportør,

en geodreiecktransportør eller kompass innpå siden.

Using the ruler
Du kan sette inn en linjal på en side, og deretter redigere dens størrelse, lengde, rotasjon,

plassering og tegne langs kantene.

For å sette inn en linjal

Trykk Måleverktøy og velg deretter Sett inn linjal .

En linjal vises.

Slik flytter du linjalen

Trykk midt på linjalen (vises som en mørkere nyanse av blått), og dra deretter linjalen til en

annen plassering på siden.

For å endre størrelsen på linjalen

1. Velg linjalen.

2. Dra linjalens størrelseshåndtak (sirkelen nederst i høyre hjørne) for å øke eller redusere

linjalens størrelse.

Å forlenge linjalen (uten å endre dens skala)

Trykk langs kanten av linjalen, mellom menypilen og størrelseshåndtaket, og drar deretter

vekk fra linjalen.

Å forkorte linjalen (uten å endre dens skala)

Trykk langs kanten av linjalen, mellom menypilen og størrelseshåndtaket, og dra deretter

mot midten av linjalen.
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Hvis du vil rotere linjalen

Trykk på den øvre eller nedre kanten av linjalen (vises som en lysere nyanse av blått), og

dra deretter linjalen i den retningen du vil rotere den.

Linjalen viser gjeldende rotasjon i grader.

For å reversere målingene

Trykk på linjalens symbol for vending .

Hvis de metriske målene ble vist på den øverste kanten av linjalen, vises de den på

nederste kanten og vice versa.

Å tegne ved bruk av linjalen og en penn

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Penn eller Kalligrafipenn.

3. Velg en linjetype.

4. Tegn langs kanten av linjalen.

Digital blekk vises i en rett linje langs kanten av linjalen.

Å fjerne linjalen

1. Velg linjalen.

2. Trykk på linjalens menypil, og velg deretter Slett .

Using the protractor
Du kan sette en transportør på siden, konfigurere dens størrelse, rotasjon og plassering og så

tegne langs dens kanter.
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For å sette inn en transportør

Trykk Måleverktøy og velg deretter Sett inn vinkelmåler .

En transportør vises.

Å flytte vinkelmåleren

Trykk innersiden på transportøren (vises i en mørkere blånyanse) og dra transportøren til

en annen plass på siden.

For å endre størrelsen på vinkelmåleren

Trykk den innerste sirkelen med tall og dra vekk fra transportøren for å forstørre den eller

dra mot transportørens midtpunkt for å forminske den.

Hvis du vil rotere vinkelmåleren

Trykk på den ytre sirkelen med tall og dra transportøren i den retningen du ønsker å

rotere den.

Vinkelmåleren viser gjeldende rotasjon i grader.
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For å vise transportøren som en hel sirkel

1. Trykk på den blå sirkelen ved siden av merket 180 i den indre nummersirkelen.

2. Trykk den blå sirkelen igjen for å vende den tilbake til en halvsirkel.

For å tegne ved bruk av en penn og en transportør

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Penn eller Kalligrafipenn.

3. Velg en linjetype.

4. Tegn langs kanten av vinkelmåleren.

Digital blekk vises i buen langs kanten på transportøren.
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For å vise vinkler ved bruk av transportøren

1. Velg vinkelmåleren.

2. Dra den grønne sirkelen helt til den viser den rette vinkelen for den første av to kryssende

linjer.

3. Dra den hvite sirkelen helt til den viser den rette vinkelen for den andre av to kryssende

linjer.

4. Trykk den grønne pilen i det nederste hjørnet.

Linjen og vinkelen mellom dem vises som et separat objekt.

For å fjerne transportøren

1. Velg vinkelmåleren.

2. Trykk på vinkelmålerens menypil, og velg deretter Slett .

Using the Geodreieck protractor
Du kan sette inn en Geodreieck-vinkelmåler (også kjent som et fast kvadrat eller T-kvadrat) på

en side, og deretter manipulere dens størrelse, rotasjon og plassering.

For å sette inn en geometrisk vinkelmåler

Trykk Måleverktøy og velg deretter Sett inn geometrisk .

En Geodreieckvinkelmåler vises.

Å flytte vinkelmåleren

Trykk på den indre delen av vinkelmåleren (innenfor halvsirkelen), og dra deretter

vinkelmåleren til en annen plassering på siden.

For å endre størrelsen på vinkelmåleren

Trykk halvsirkelen, og dra deretter bort fra midten av vinkelmåleren for å gjøre den større

eller mot midten av vinkelmåleren for å gjøre den mindre.
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Hvis du vil rotere vinkelmåleren

Trykk på den ytre delen av vinkelmåleren (utenfor halvsirkelen), og dra deretter

vinkelmåleren i den retningen du vil rotere det.

Vinkelmåleren viser gjeldende rotasjon i grader.

For å tegne ved bruk av en penn og en geometrisk vinkelmåler

1. Press Penner .

Knappene for pennverktøy vises.

2. Klikk Penntyper og velg Penn eller Kalligrafipenn.

3. Velg en linjetype.

4. Tegn langs kanten av vinkelmåleren.

Digital blekk vises i en rett strek langs kanten av vinkelmåleren.

For å fjerne transportøren

1. Velg vinkelmåleren.

2. Trykk på vinkelmålerens menypil, og velg deretter Slett .
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Using the compass
Du kan sette inn et kompass på en side, endre bredden, rotasjonen og plasseringen og

deretter bruke den til å tegne sirkler og buer.

For å sette inn en passer

Trykk Måleverktøy og velg deretter Sett inn kompass .

Et kompass vises.

For å flytte kompasset

Trykk armen på kompasset som holder piggen, og dra deretter kompasset til et annet

sted på siden.

Å utvide kompasset

1. Trykk armen på kompasset som holder pennen.

To blå piler vises.

2. Dra for å endre vinkelen mellom piggen og pennen.

Tallet på kompasshåndtaket viser gjeldende vinkel mellom piggen og pennen.

For å vende passeren

Trykk på kompassets symbol for vending .

Den største kompasspennen vises på den motsatte side av piggen.

Slik roteres kompasset (uten tegning)

Trykk kompassets rotasjonshåndtak (den grønne sirkelen), og dra deretter kompasset i

den retningen du vil rotere det.

For å tegne med kompasset

1. Trykk kompassets penn.

Markøren endres til et pennesymbol.
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2. Dra kompasset i den retningen du vil rotere det.

For å endre fargen på passerens penn

1. Press Penner .

Knappene for pennverktøy vises.

2. Press Pennetyper , og velg deretter Penn .

3. Velg en linjetype.

Fargen på kompasspennen endres for å vise sin nye farge.

For å fjerne passeren

1. Velg kompasset.

2. Trykk kompassets menypil, og velg deretter Slett .

Fjerne eller omstille sider etter presentasjonen
er ferdig
Etter at studenter har blitt presentert med en undervisningsaktivitet kan du tømme eller

gjenopprette sidene i dine .notebook -filer for å bruke filene igjen i fremtidige

undervisningsaktiviteter.
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Clearing pages
You can erase digital ink and delete individual objects from a page. You can also clear all

objects or all digital ink objects from a page simultaneously.

MERKNAD

You’re unable to clear objects locked in place (see Låse objekter på side 97) or infinitely

cloned objects (see  Cloning objects på side 62). To clear all objects from a page, you must

unlock all locked objects and clear the selection of Infinite Cloner on any infinitely cloned

objects.

For å fjerne alle objekter på en side

1. Vis siden du ønsker å tømme dersom du ikke allerede har gjort dette.

2. Velg Rediger > Tøm siden.

NOTATER

o Denne valgmuligheten er deaktivert dersom det ikke finnes objekter på siden,

dersom objektene er fastlåste eller det finnes uendelige kloner av det.

o Du kan også velge denne muligheten ved å:

o CTRL-klikke siden

o Klikke sidens menypil fra sidesorteringen

o Trykke menypilen på siden imens du redigerer sidegrupper (se  Grouping

pages på side 23).

o Trykk Fjern side hvis denne funksjonen er inkludert i verktøylinjen (se

 Customizing the toolbar på side 165)

o You can clear all objects from multiple pages at the same time. Select the pages’

thumbnails in the Page Sorter, press the menu arrow, and then select Clear Page.
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For å fjerne alle digitale blekkobjekter fra en side

1. Vis siden du ønsker å tømme dersom du ikke allerede har gjort dette.

2. Velg Rediger > Tøm blekk fra siden.

NOTATER

o Denne valgmuligheten er deaktivert dersom det ikke finnes digitalt blekk på siden,

digitalblekktegningen er fastlåst eller det finnes uendelige kloner av det.

o Du kan også velge denne muligheten ved å:

o CTRL-klikke siden

o Klikke sidens menypil fra sidesorteringen

o Trykke menypilen på siden imens du redigerer sidegrupper (se  Grouping

pages på side 23).

o Trykk Fjern blekk hvis denne funksjonen er inkludert i verktøylinjen (se

 Customizing the toolbar på side 165)

o You can clear all digital ink objects from multiple pages at the same time. Select

the pages’ thumbnails in the Page Sorter, press the menu arrow, and then select

Clear Ink from Page.

Tilbakestille sider
Dersom du gjør endringer på en side (uten å lagre endringene) kan du gjenopprette siden slik

den var før du gjorde endringer.

MERKNAD

Du oppretter ikke Adobe Flash Player-kompatible filer som kjører på siden når du oppretter

den.



KAPITTEL 8
PRESENTASJON AV UNDERVISNINGSAKTIVITETER OG TILRETTELEGGING FOR SAMARBEID

152

For å gjenopprette en side

1. Vis siden du ønsker å opprette dersom du ikke allerede har gjort det.

2. Velg Rediger > Gjenopprett side.

En dialogboks som ber deg om å bekrefte gjenopprettingen vises.

NOTATER

o Denne valgmuligheten er ikke aktivert dersom du ikke har endret noe på siden

etter forrige lagring.

o Du kan også velge denne muligheten ved å:

o CTRL-klikke siden

o Klikke sidens menypil fra sidesorteringen

o Trykke menypilen på siden imens du redigerer sidegrupper (se  Grouping

pages på side 23).

o Trykk på Tilbakestill side om denne funksjonen er inkludert i verktøylinjen

(se  Customizing the toolbar på side 165)

o You can reset multiple pages at the same time. Select the pages’ thumbnails in the

Page Sorter, press the menu arrow, and then select Reset Page.

3. Klikk Gjenopprett side.

Tillater to personer å bruke en interaktiv tavle
If you have a SMART Board D600 or 800 series interactive whiteboard, two people can create

and manipulate objects in SMART Notebook software at the same time. How the two people

do this depends on whether you have a SMART Board D600 series interactive whiteboard or a

SMART Board 800 series interactive whiteboard.

Muligheten for at to personer kan bruke en interaktiv tavle er nyttig i situasjoner som for

eksempel følgende:

l To studenter arbeider på en oppgave på den interaktive tavlen samtidig

l En lærer og en elev løste en oppgave på på den interaktive tavlen samtidig

l En lærer eller en elev stiller spørsmål eller problemer på den interaktive tavlen, og en

annen student svarer på disse spørsmålene eller problemene



KAPITTEL 8
PRESENTASJON AV UNDERVISNINGSAKTIVITETER OG TILRETTELEGGING FOR SAMARBEID

153

Enabling two people to use a SMART Board D600 series
interactive whiteboard
If you’re using a SMART Board D600 series interactive whiteboard, two users can use the

interactive whiteboard simultaneously when SMART Notebook software is in Dual-User mode.

In Dual-User mode, the screen is divided in half. Each user can press his or her half of the

screen with a finger to left-click or drag objects, write using a pen tray pen and erase digital ink

using the eraser. Each user can also access frequently used tools using his or her own Floating

Tools toolbar.

Du kan trykke på en knapp på verktøylinjen for å veksle mellom enkeltbrukermodus og

dobbelbrukermodus.

For å vise en fil i dobbelbrukermodus

Trykk Vis skjermer og deretter velg Dobbel skrivemodus.

For å tilbakestille til enkel brukermodus

Trykk Avslutt .

Enabling two people to use a SMART Board 800 series
interactive whiteboard
If you’re using a SMART Board 800 series interactive whiteboard, two people can create and

manipulate objects in SMART Notebook software at the same time. Both people can create

and manipulate objects in any area of the SMART Notebook software page. Neither user is

restricted to a particular section of the page.

Dual-user collaboration mode is enabled when you pick up a pen from the pen tray. One user

creates or manipulates objects with his or her finger (“the touch user”). The other user creates

or manipulates objects with the pen (“the pen user”).

MERKNAD

In addition to enabling one touch user and one pen user to use the interactive whiteboard at

the same time, you can enable two pen users or two touch users to use the interactive

whiteboard at the same time. However, the two users must use the same tool.
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Velge verktøy
For å endre verktøy eller å stille inn berøringsegenskaper, må berøringsbrukeren trykke på

riktig knapp på verktøylinjen eller kontrollen i kategorien Egenskaper med fingeren. The

following is an example:

For å endre verktøy eller å stille inn egenskaper for pennen, må pennbrukeren trykke på riktig

knapp på verktøylinjen eller kontrollen i egenskaperfanen. The following is an example:

NOTATER

l Hvis pennbrukeren trykker på en knapp på verktøylinjen eller stiller inn en egenskap

med fingeren i stedet for pennen, endrer SMART Notebook-programvare det valgte

verktøyet eller egenskapene for berøringsbrukeren istedenfor pennbrukeren.

l Når både berøringsbrukeren og pennbrukeren velger flere objekter på skjermen vil den

stiplede kantlinjen av de utvalgte av berøringsbrukerobjektene være en annen farge

enn den stiplede kantlinjen som er valgt som pennbrukerobjektet.
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Kapittel 9: Enhancing SMART Notebook
software with add-ons

Installing add-ons 157
For å bruke tillegg 158
Identifying missing add-ons 158
Deaktivere og fjerne tillegg 158
Tilgang til XC Collaboration 159

Tillegg er utvidelser til SMART Notebook-programvaren som er utviklet av

SMART Technologies og av tredjeparts programvareutviklere.

SMART Notebook software includes the Activity Builder add-on (see  Creating a matching

lesson activity på side 104) and the Alignment Tools add-on (see  Aligning objects på side 58).

You can install other add-ons from the SMART Exchange website to add specialized features

to the software. In addition, you can manage all installed add-ons using the Add-on Manager.

Installing add-ons
Du kan søke etter og installere tilleggsprogram fra SMART Exchange-nettstedet.

For å installere et tillegg

1. Velg Tilleggsprogrammer > Håndter tilleggsprogram.

Tilleggsprogrambehandleren vises.

2. Klikk Finn mer.

SMART Exchange-nettstedet åpnes i nettleseren din.

3. Dersom du er ny på SMART Exchange-nettstedet kan du klikke Bli medlem gratisog lese

instruksene for hvordan til å opprette en konto på skjermen.

ELLER

Hvis du har en konto, press Logg inn , og følg deretter instruksjonene på skjermen for å

logge på SMART Exchange-nettsiden med kontoen din.

4. Søk etter et tilleggsprogram og last det ned på en midlertidig plass på datamaskinen din.
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5. Dobbeltklikk tilleggsprogrammet.

6. Følg instruksene på skjermen for hvordan til å installere tilleggsprogrammet.

For å bruke tillegg
Etter at du installerer tilleggsprogrammet kan du bruke funksjoner ved tilleggsprogrammet

som med de andre funksjonene i SMART Notebook-programvare.

For å vise et tillegg

1. Trykk Tillegg for å åpne en liste over tillegg.

2. Trykk tilleggets ikon for å åpne tillegget.

3. Trykk for å gå tilbake til listen over tillegg.

For å visse tilleggets versjon og annen informasjon

1. Velg Tillegg > Behandle tillegg på programvarens verktøylinje

ELLER

Trykk på tittellinjen i tillegg.

Tilleggsprogrambehandleren vises.

2. Klikk navnet på tilleggsprogrammet.

3. Klikk Om.

Identifying missing add-ons
If you open a page in a .notebook file that requires an add-on that isn’t installed or is disabled

on your computer, a message appears at the top of the page. Press the message to open the

Add-on Manager. The Add-on Manager identifies which add-on is required. You can then install

that add-on (see  Installing add-ons på forrige side) or enable it (see Deaktivere og fjerne

tillegg nedenfor).

Deaktivere og fjerne tillegg
I enkelte situasjoner kan det være lurt å deaktivere eller fjerne et tidligere installert

tilleggsprogram.

If you choose to disable an add-on, the add-on no longer appears in SMART Notebook

software but is still installed on your computer. You can subsequently enable the add-on.
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Hvis du velger å fjerne et tilleggsprogram, vises det ikke lenger i SMART Notebook-

programvaren og fjernes fra datamaskinen.

To disable an add-on

1. Velg Tilleggsprogrammer > Håndter tilleggsprogram.

Tilleggsprogrambehandleren vises.

2. Klikk navnet på tilleggsprogrammet.

3. Klikk Deaktiver.

TIPS

For å aktivere tilleggsprogrammet igjen, klikk Aktiver.

To remove an add-on

1. Velg Tilleggsprogrammer > Håndter tilleggsprogram.

Tilleggsprogrambehandleren vises.

2. Klikk navnet på tilleggsprogrammet.

3. Klikk Fjerne.

MERKNAD

Du kan ikke fjerne tilleggsprogrammene: Aktivitetsbygger eller Innrettingsverktøy.

Tilgang til XC Collaboration
SMART Notebook software includes the basic version of XC Collaboration. The basic version

of XC Collaboration is an add-on by FRIELAND that enables students to text ideas from their

mobile devices to a SMART Notebook page for the entire class to see. You can also access

the online tour to learn how to use XC Collaboration.

VIKTIG

Gå til xc-collaboration.com for å kjøpe fullversjonlisensen for XC Collaboration.

For å få tilgang til XC Collaboration

1. Trykk Tillegg og deretter trykk XC Collaboration.

2. Trykk Koble til.

http://www.xc-collaboration.com/
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For å få tilgang til XC Collaborations introduksjon på nett

1. Trykk Tillegg og deretter trykk XC Collaboration.

2. Trykk Start introduksjon.

MERKNAD

Du kan også finne hjelp på følgende måter:

o Trykk ved siden av funksjonen du trenger hjelp med.

o Gå til xc-collaboration.com/support.

http://www.xc-collaboration.com/support
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Kapittel 10: Tilgang til RSS-feed med Notebook
Connect
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Using the Notebook Connect add-on, you can access the latest articles and receive

continuously updated headlines from your favorite publications.You can add, delete and

manage feeds, view and bookmark articles and insert images and videos from the articles into

SMART Notebook software to share with your class. You can also access the SMART Central

RSS feed, which is included by default.

For å få tilgang til Notebook Connect

Trykk Tillegg og deretter trykk Notebook Connect.

Finne, legge til og slette en RSS-feed
Mange publikasjoner og medier tilbyr RSS-strøm for deres innhold. Du kan søke eksterne

nettsteder for URL for RSS-strøm, og deretter legge til URL til Notebook Connect. Du kan også

slette RSS-feeds.

For å legge til en RSS-feed

1. Finn nettadressen til RSS-strømmen du vil legge til.

2. Trykk Tillegg og trykk deretter SMART Connect.

3. Trykk Innstillinger og trykk deretter Legg til liste .

En dialogboks for Strøm-URL vises.

4. Skriv inn hele URL-adressen til RSS-strømmen i boksen.

For å slette en RSS-feed

Trykk Innstillinger og trykk deretter Slett liste ved siden av listens lenke.
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Se innhold fra RSS-feed
After you add an RSS feed, you can access the feed’s content and headlines from the main

feed. You can mark articles as either read or unread, and you can refresh the main feed to

ensure you have access to the latest content.

For å se innhold fra en hovedfeed

1. Trykk Hovedliste og deretter velg en visningsliste fra nedtrekkmenyen.

En liste med artikkelminiatyrbilder vises.

2. Velg overskriften på et miniatyrbildet for å se flere detaljer om artikkelen.

3. Velg Se Artikkel for å åpne hele artikkelen.

ELLER

Velg Tilbake å gå tilbake til listen over artikkelminiatyrbilder.

MERKNAD

Du kan endre standard programvaren artiklene skal åpnes i (se   To select the default

software for opening articles på neste side).

For å merke en artikkel som lest

Trykk Hovedliste og deretter trykk i artikkel-miniatyrbildet.

Ikonet endres til og artikkelen farges grå.

For å merke alle artikler som lest

Trykk Hovedliste og deretter trykk Merk alt som lest.

Ikonene endres for å på alle artikler og artiklene farges grå.

For å merke en artikkel som ulest

Trykk Hovedliste og deretter trykk i artikkel-miniatyrbildet.

Ikonet endres til og artikkelens utseende er gjenopprettet.

For å oppdatere hovedfeeden

Trykk Hovedliste og deretter velg .
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To select the default software for opening articles

1. Trykk Innstillinger .

2. Velg Notebook hvis du vil at artiklene skal åpnes i SMART Notebook-programvaren.

ELLER

Velg Din standard nettleser hvis du vil ha artikler å åpne i nettleseren din.

Bokmerke artikler
You can bookmark articles to view later by adding them to your favorites list. You can also

delete articles from your favorites list.

For å få tilgang til din favoritt liste

1. Trykk Favoritt .

Det vises en liste over bokmerkede artikler.

For å legge til en artikkel til favoritt listen din

Trykk Hovedliste og deretter trykk nederst i høyre hjørne av artikkelen om

miniatyrbilder.

For å slette en artikkel fra favoritt listen din

Trykk Favoritt og deretter trykk nederst i høyre hjørne ved artikkelen om

miniatyrbilder.

Sette inn bilder og video i tegneområdet
Dersom en artikkel inneholder et bilde eller en video - kan du sette det inn i

SMART Notebook-programmets tegneområde.

For å legge til et bilde eller en video i tegneområdet

1. Trykk Tillegg og deretter trykk Notebook Connect.

2. Trykk Hovedliste og deretter velg en visningsliste fra nedtrekkmenyen.

En liste med artikkelminiatyrbilder vises.
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3. Klikk på et åpnet artikkelminiatyrbilde for å sette artikkelens bilde inn i tegneområdet.

ELLER

Klikk på et artikkelminiatyrbilde for å sette artikkelens video inn i tegneområdet.
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Denne delen forklarer hvordan du opprettholder SMART Notebook-programvaren.

Customizing the toolbar
The SMART Notebook software toolbar enables you to select and use a variety of commands

and tools. You can customize the toolbar so that it includes the tools you use most frequently.

After adding or removing toolbar buttons, you can restore the default set of toolbar buttons.

You can also restore the tools’ default settings if you customized and saved the settings using

the Properties tab (see  Saving tool settings på side 56).

For å legge til eller fjerne knapper på verktøylinjen

1. Klikk Tilpasse verktøylinje .

ELLER

Høyreklikk på verktøylinjen.
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En dialogboks vises.

2. Press Handlinger eller Verktøy .

3. Gjør følgende:

o Hvis du vil legge til en knapp på verktøylinjen, trykker du på ikonet i dialogboksen,

og deretter drar den til verktøylinjen.

o Hvis du vil fjerne en knapp fra verktøylinjen, trykker du på symbolet i verktøylinjen,

og drar den bort fra verktøylinjen.

o Hvis du vil omorganisere knappene, trykker på et ikon på verktøylinjen, og drar den

deretter til en ny plassering på verktøylinjen.

NOTATER

o You can only add, remove and rearrange buttons in the panel of the toolbar you

selected in step 2. For example, if you pressed Actions in step 2, you can only add,

remove and rearrange buttons in the Actions panel.

o For å spenne en knapp på tvers av rader, dra og hold den mellom to

knappekolonner.

Hvis du bruker en mindre skjermoppløsning, spenn én eller to knapper på tvers av

rader for å unngå problemer når verktøylinjen er bredere enn SMART Notebook-

programvarevinduet.

4. Klikk Ferdig.

Gjenopprette standardoppsettet for verktøylinjeknapper

1. Klikk Tilpasse verktøylinje .

ELLER

Høyreklikk på verktøylinjen.

En dialogboks vises.

2. Press Gjenopprett Standard Verktøylinje .
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Gjenopprette standardinnstillinger for verktøyene

1. Klikk Tilpasse verktøylinje .

ELLER

Høyreklikk på verktøylinjen.

En dialogboks vises.

2. Press Gjenopprett Egenskaper for Standardverktøyet .

Konfigurere SMART Notebook-programvare
Denne delen forklarer hvordan du konfigurerer SMART Notebook-programvare.

Setting gesture preferences
Du kan jobbe med objekter i SMART Notebook-programvaren ved bruk av gester, inkludert

ristegesten og klikk-og-hold-gesten.

Gest Navn Formål

Ristebevegelse Gruppere to eller flere
objekter sammen.

Trykk-og-hold-gest Utføre en CTRL-klikk.

The shake and press-and-hold gestures are enabled by default. However, you can choose to

disable them if you find that you or your students frequently invoke the gestures by accident.

Hvis du vil deaktivere ristebevegelsen

1. Velg Notebook > Valg.

En dialogboks vises.
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2. Klikk Generelt.

3. Tøm Bruk ristegesten for å gruppere og løse opp grupper med objekter -

avemerkingsboksen.

4. Press OK .

Hvis du vil deaktivere trykk-og-hold-bevegelsen

1. Velg Notebook > Valg.

En dialogboks vises.

2. Klikk Generelt.

3. Tøm Klikk og hold for utføre en høyreklikk -avmerkingsboksen.

4. Press OK .

Setting image optimization preferences
If your .notebook files contain large pictures (pictures over 1 MB in file size), your files could

open and run slowly. You can reduce the pictures’ file size without noticeably reducing their

quality. As a result, your .notebook files’ overall file sizes will be smaller and the files will open

and run more quickly.

Hvis du vil angi bildeoptimaliseringspreferanser

1. Velg Notebook > Valg.

En dialogboks vises.

2. Klikk Standarder.

3. Velg en av de følgende alternativene fra bildeoptimalisering -nedtrekksmenyen.

o Spør hver gang jeg legger til et stort bilde for å få muligheten til å redusere eller ikke

redusere bildets filstørrelse når du legger de til.

o Aldri endre oppløsningen på bilder jeg legger til for aldri å bli spurt om å redusere

bildenes filstørrelser når du legger de til.

o Allt id endre bildeoppløsningen for å optimalisere filstørrelsen for å redusere

filstørrelsen til store bilder hver gang du legger de til.

4. Press OK .
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Redusere størrelsen på store bilder manuelt
Hvis du valgte Spør meg hver gang jeg legger til et stort bilde i bildeoptimalisering -

nedtrekksmenyen, kan du redusere størrelsen på store bilder manuelt når du legger bildene til

filen din eller etterpå.

For å redusere størrelsen på et stort bilde når du setter den i en fil

1. Sette inn bildet som beskrevet i  Inserting pictures på side 75 .

Etter at du klikker Åpne, vises bildeoptimalisering -dialogboksen.

2. Klikk Optimaliser for å redusere bildets filstørrelse.

ELLER

Klikk Behold oppløsningen for beholde bildets filstørrelse.

NOTATER

o When you insert a BMP file, SMART Notebook software internally converts the file

to PNG format. This conversion reduces the size of the file. As a result, you might

not need to export an optimized version of the .notebook file (see  Exporting

optimized files nedenfor) even if the BMP file is over 1 MB in size.

o SMART Notebook-programmet reduserer filstørrelsen på bilder over 5 MB eller 5

megapiskler uavhengig av hvilket alternativ du valgte.

For å redusere størrelsen på et stort bilde etter at du setter den i en fil

1. Velg bildet.

2. Klikk menypilen på bildet og velg Bildeoptimalisering.

Bildeoptimalisering -dialogboksen vises.

3. Klikk Optimaliser.

Exporting optimized files
If you have existing files that contain large pictures or if you chose Never change the

resolution of inserted images in the Image Optimization drop-down list, you can export

optimized versions of your files that contain reduced pictures. This is particularly useful when

you need to present a .notebook file on an older or less powerful computer.

Slik eksporterer en optimalisert fil

1. Velg Fil > Eksporter som > Optimalisert SMART Notebook-fil.

En dialogboks vises.

2. Søk deg frem til plassen du ønsker å lagre den nye filen til.

3. Type a name for the file in the Save As box.

4. Press Lagre .
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 Setting default background color preferences
By default, new pages added to your file have a default white background color. You can

change the default background color.

MERKNAD

Denne innstillingen påvirker kun nye sider og overstyres av temaer som velges.

For å endre standard bakgrunnsfarge

1. Velg Notebook > Valg.

En dialogboks vises.

2. Klikk Standarder.

3. Velg Endre farge og velg farge.

4. Press OK .

Setting measurement tool preferences
Linjalen, transportøren og geodreieckvinkelmåleren i SMART Notebook-programmet er

normalt blått og synes best på lysfargede bakgrunn.

Du kan endre fargen på disse verktøyene til gul hvis du vil bruke de på mørkere bakgrunner.
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MERKNAD

Completing the following procedure affects the appearance of measurement tools in

.notebook files when viewed on your copy of SMART Notebook software only. If you open

the same .notebook files on another copy of SMART Notebook software, the measurement

tools could display in a different color.

For å endre fargen i måleverktøyet

1. Velg Notebook > Valg.

En dialogboks vises.

2. Klikk Standarder.

3. Velg Blånyanse (anbefalt for lysere bakgrunn) i nedtrekksmenyen for måleverktøyfarge

for å stille inn måleverktøysfargen til blå.

ELLER

Velg Gulnyanse (anbefalt for mørkere bakgrunn) i nedtrekksmenyen for

måleverktøyfarge for å stille inn måleverktøyfargen til gul.

4. Press OK .

Setting table cell padding preferences
SMART Notebook 11 legger til fyll i tabellene.

Complete the following procedure to remove cell padding from tables. This is particularly

useful if you created tables prior to upgrading to SMART Notebook 11 software and intended

the tables’ contents to display without cell padding.

MERKNAD

Completing the following procedure affects the appearance of tables in .notebook files

when viewed on your copy of SMART Notebook software only. If you open the same

.notebook files on another copy of SMART Notebook software, the tables display with cell

padding (assuming the procedure hasn’t been completed on that copy of SMART Notebook

software).
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For å fjerne celleutfyllingen fra tabeller

1. Velg Notebook > Valg.

En dialogboks vises.

2. Klikk Standarder.

3. Tøm Legg cellefyll t il tabellceller -avmerkingsboksen.

4. Press OK .

5. Lukk og kjør SMART Notebook-programvaren på nytt.

Nye og eksisterende tabeller i dine -notebook -filer vises uten cellefyll.

Konfigurere språk
Du kan konfigurere språket for SMART-programmer som er installert på PC-en ved bruk av de

internasjonale systempreferansene.

MERKNAD

Denne prosedyren kan variere avhengig av hviken versjon av Mac OS X

operativsystemprogramvaren du har.

Slik konfigurerer du språket:

1. Velg > Systempreferanser.

Systemvalg-vinduet vises.

2. Press Internasjonal .

3. Press Språk .

4. Dra ønsket språk til toppen av listen over Språk .

MERKNAD

The SMART applications installed on your computer may not support all languages in

the Languages list. The system administrator’s guide for each SMART application lists

the supported languages.

5. Lukk Systemvalgvinduet .

Fjerne SMART-programvare
SMART Support might ask you to remove existing versions of SMART software before you

install new versions. You can do this using the SMART Uninstaller.
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For å fjerne SMART-programvare

1. I Finder, bla deg frem til og dobbeltklikk Applikasjoner/SMART Technologies/SMART -

Avinstallasjonsprogram .

2. Velg programvaren du vil fjerne.

NOTATER

o Some SMART software is dependent on other SMART software. For example, if

you select SMART Notebook, SMART Uninstaller removes SMART Response

software automatically because SMART Response software is dependent on

SMART Notebook software.

o SMART Uninstaller automatically removes any supporting software that is no longer

being used. If you choose to remove all SMART software, SMART Uninstaller

automatically removes all supporting software, including itself.

TIPS

o For å velge mer enn ett program, hold nede SHIFT eller COMMAND mens du

velger programmene.

o For å velge alle programmene, press Velg alle .

3. Press Fjerne , og trykk deretter på OK .

4. Hvis du blir bedt om det, oppgi et brukernavn og passord med administratorrettigheter,

og press  deretter på OK .

SMART-avinstallasjonsprogrammet fjerner valgt programvare.

5. Lukk SMART-avinstallasjonsprogrammet når du er ferdig.

Oppdatere og aktivere SMART-programvaren
After you install SMART software, you need to activate it. After you activate the software, you

need to install updates from SMART.

VIKTIG

For å oppdatere og aktivere SMART-programvaren, må du være koblet til Internett.

Oppdatere SMART-programvaren
SMART periodically releases updates to its software and firmware products. (Firmware is

software installed in hardware products like the SMART Board interactive whiteboard.) You can

use SMART Product Update (SPU) to check for and install these updates.

Your system administrator can install SPU in Full mode or Dashboard mode. In Full mode, you

can view installed versions and download and install updates as documented in this section. In

Dashboard mode, you can only view installed versions.
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Se automatisk etter oppdateringer

1. I Finder, bla deg frem til og dobbeltklikk Programmer/SMART Technologies/SMART-

Verktøy/SMART Produktoppdatering .

SMART Product Update vinduet vises.

2. Velg avmerkingsboksen for Sjekk etter oppdateringer automatisk og skriv antall dager

(inntil 60) mellom SPU-sjekk.

3. Lukk SMART-produktoppdatering -vinduet.

Hvis en oppdatering er tilgjengelig under neste SPU-sjekk, synes vinduet til SMART-

produktoppatering automatisk og oppdater -knappen til det påvirkede produktet blir

aktivert.

Se etter oppdateringer manuelt

1. I Finder, bla deg frem til og dobbeltklikk Programmer/SMART Technologies/SMART-

Verktøy/SMART Produktoppdatering .

SMART Product Update vinduet vises.

2. Klikk Sjekk nå.

Hvis en oppdatering er tilgjengelig for et produkt, vil knappen for oppdater være

tilgjengelig.

3. Hvis en oppdatering er tilgjengelig, kan du installere den ved å følge neste prosedyre.

Slik installerer du en oppdatering

1. Åpne vinduet for SMART-produktoppdatering som beskrevet i de forrige prosedyrene.

2. Trykk på produktets rad.

Product details appear. These product details include the installed version’s number and

the update’s number, date and download size (if an update is available).

TIPS

Klikk Se produktmerknader for å se et sammendrag av endringene i oppdateringen og

datakravene for oppdateringen.

3. Klikk Oppdater.

4. Følg anvisningene på skjermen for hvordan du laster ned og installerer oppdateringen.

VIKTIG

Du må ha fulle administratorrettigheter for å kunne installere oppdateringer.
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Slik deaktiverer du automatisk leting etter oppdateringer

1. I Finder, bla deg frem til og dobbeltklikk Programmer/SMART Technologies/SMART-

Verktøy/SMART Produktoppdatering .

SMART Product Update vinduet vises.

2. Tøm Sjekk etter oppdateringer automatisk -avmerkingsboksen.

VIKTIG

SMART anbefaler at du ikke fjerner merket i denne avmerkingsboksen.

Aktivere SMART-programvare
Typically, you activate SMART software after installing it. However, in some situations, you

activate the software later. For example, you could be evaluating the software before deciding

to purchase it.

NOTATER

l As of version 11.1, you don’t need to activate SMART Notebook software or

SMART Product Drivers. SMART provides you with the right to use this software when

you purchase a SMART interactive product.

l Hvis du ønsker å bruke SMART Notebook-programvaren med en enhet som ikke er et

interaktivt SMART-produkt, må du kjøpe en produktnøkkel.

Kjøpe en produktnøkkel
For noen SMART-produkter må du kjøpe en produktnøkkel fra din autoriserte SMART

forhandler (smarttech.com/wheretobuy).

TIPS

Hvis du mister produktnøkkelen, kan du gjenopprette den på

smarttech.com/findproductkey .

Aktivere SMART-programvare med en produktnøkkel
Når du har innhentet en produktnøkkel, kan du aktivere SMART-programvaren.

For å aktivere SMART-programvare

1. I Finder, bla deg frem til og dobbeltklikk Programmer/SMART Technologies/SMART-

Verktøy/SMART Produktoppdatering .

SMART Product Update vinduet vises.

http://www.smarttech.com/wheretobuy
http://www.smarttech.com/findproductkey
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2. Trykk på Aktiver eller Administrer for programvaren du vil bruke.

Dialogboksen SMART programvareaktivering vises.

MERKNAD

Verdien i Status -kolonnen angir status for hvert produkt:

Verdi Beskrivelse

Installert Programvaren er installert.

Aktivert Programvaren er installert og aktivert med en evigvarende lisens eller
vedikeholdslisens.

Abonnement The software is installed and activated with a subscription license. The
number in parentheses indicates the days remaining in the subscription
period.

Utløper The software is installed but not yet activated. The number in
parentheses indicates the days remaining in the evaluation period.

Utløpt The software is installed but not yet activated. The evaluation period is
over. You’re unable to use the software until you activate it.

Ukjent Programvarens status er ukjent.

3. Trykk Legg til.

4. Følg anvisningene på skjermen for å aktivere programvaren ved bruk av

produktnøkkelen.

Hvis du vil se produktnøkler

1. I Finder, bla deg frem til og dobbeltklikk Programmer/SMART Technologies/SMART-

Verktøy/SMART Produktoppdatering .

SMART Product Update vinduet vises.

2. Velg Verktøy > Vis produktnøkler.

Dialogboksen Produktnøkler vises.

3. Trykk OK når du er ferdig med å vise produktnøklene.

MERKNAD

Alternativt kan du vise produktnøklene for ett enkelt produkt ved å trykke på

produktets navn i vinduet SMART Product Update og deretter trykke Vis

produktnøkkel.
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Sende tilbakemelding til SMART
When you start SMART software for the first time, a dialog box could appear asking whether

you want to join the SMART Customer Experience Program. If you choose to join the program,

the software sends information to SMART that helps us improve the software for future

releases. After starting the software for the first time, you can enable or disable this feature

through the Help menu.

Du kan også sende e-post med funksjonsforespørsel til SMART.

Aktivere kundeerfaringsprogrammets sporingsfunksjon

Velg Notebook > Kundeerfaringsprogram > Tilbakemeldingssporing PÅ .

Deaktivere kundeerfaringsprogrammets sporingsfunksjon

Velg Notebook> Kundeerfaringsprogram > Tilbakemeldingssporing AV.

Sende en e-post med funksjonsforespørsel

1. Velg Notebook > Send funksjonsforespørsel.

En ny e-postmelding vises i e-postprogrammet ditt.

2. Skriv inn forespørselen i den nye e-postmeldingen, og trykk deretter på  Send .
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Kapittel 12: Feilsøking i SMART Notebook-
programvaren

Troubleshooting files 179
Troubleshooting the SMART Notebook software window and toolbar 179
Troubleshooting digital ink 180
Troubleshooting objects 181
Troubleshooting gestures 182

Dette kapittelet forklarer hvordan du feilsøker problemer med SMART Notebook-

programvaren.

Troubleshooting files
Problem Anbefaling

Filen din inneholder store bilder og kjører
tregt når du åpner den i SMART Notebook-
programvaren.

Eksportere en optimalisert versjon av filen
(se  Setting image optimization preferences
på side 168 ).

Troubleshooting the SMART Notebook
software window and toolbar
Problem Anbefaling

Når du bruker SMART Notebook-
programvaren på et interaktivt produkt og du
eller dine studenter ikke rekker bort til
verktøylinjen.

Trykk Flytt verktøylinje til toppen/bunnen

av vinduet for å flytte verktøylinjen fra
toppen til bunnen av vinduet.

TIPS

Hvis du har en høydejusterbar veggfeste
kan du også justere høyden på den
interaktive tavlen eller skjermen slik at
studentene når den.
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Problem Anbefaling

Verktøyknapper som er beskrevet i dette
dokumentet vises ikke på verktøylinjen.

Hvis en nedoverpil synes på høyre side av
verktøylinjen kan du klikke den for å vise
flere verktøyknapper.

Hvis knappen du leter ikke dukker opp når
du klikker på pilen ned , har du eller en
annen bruker mest sannsynlig fjernet denne
knappen (se  Customizing the toolbar på
side 165).

Ikke sett altfor mange knapper ved siden av
hverandre i rader, unngå at verktøylinjen blir
bredere enn programvarevinduet til
SMART Notebook.

Det er ikke nok plass til å vise sideinnholdet
på ditt interaktive produkt.

Trykk Vis skjermer og deretter velg
Fullskjerm for å vise siden i fullskjermmodus.

ELLER

Velg Autoskjul -avmerkingsboksen for å
skjule fanene når de ikke er i bruk.

Faner for sidesorteringsfunksjonen, galleriet,
vedlegg, egenskaper og andre faner skjules
når du klikker på utsiden av de.

Klikk en av faneikonene for å vise den og
sørg for at du tømmer Autoskjul -
avmerkingsboksen.

Two users are creating or manipulating
objects in SMART Notebook software on a
SMART Board 800 series interactive
whiteboard. One user is using his or her
finger. The other user is using a pen from the
pen tray.

Når brukeren som bruker pennen klikker en
knapp i verktøylinjen, endrer det valgte
verktøyet eller alternativet seg for den som
bruker fingeren.

Brukeren som benytter pennen må klikke
knappene i verktøylinjen med en penn, ikke
med fingeren.

For more information, see  Enabling two
people to use a SMART Board 800 series
interactive whiteboard på side 154.

Troubleshooting digital ink
Problem Anbefaling

Du vil at håndskriften din skal se mer naturlig
ut i SMART Notebook-programmet.

Bruk Kalligrafisk pennetype fremfor Standard
pennetype (se  Writing or drawing digital ink
på side 28 ).
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Troubleshooting objects
Problem Anbefaling

Når du oppretter en .notebook -fil på en
datamaskin og åpner det på en annen
datamaskin ser objektene annerledes ut.

There are several possible causes. The
following are the most common:

l Du brukte en skrifttype som er kun er
installert på den ene datamaskinen.

l Datamaskinene har forskjellige
operativsystem.

l Datamaskinene har forskjellige
versjoner av SMART Notebook-
programvaren

Du ønsker å flytte et objekt, endre størrelsen
på det eller endre det på en annen måte,
men når du gjør dette blir andre objekter
påvirket på samme måte.

The objects are grouped. Any changes you
make to one object affect the other objects.

Select the objects, and then select Format >
Group > Ungroup to ungroup them. You can
then move, resize or otherwise change the
individual objects.

For mer informasjon, se  Grouping objects på
side 67 .

You want to move, resize or otherwise

change an object but can’t. A lock icon
appears instead of a menu arrow when you
select the object.

The object is locked, which prevents you
from making changes to it. To unlock the

object, select it, press its lock icon , and
then select Unlock.

For mer informasjon, se Låse objekter på
side 97 .

Et objekt dekker over et annet på siden:

Du vil endre det slik at det underliggende
objektet dekker over den øverste:

Når du lager objekter, vil nyere objekter
automatisk dekke over eldre objekter hvis
objektene ligger på samme sted på siden.

You can change the order of objects. For
more information, see  Rearranging stacked
objects på side 59.
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Problem Anbefaling

Når du fyller et objekt med et bilde som er
større enn objektet blir bildet klippet av:

Når du fyller et objekt med et bilde som
derimot er mindre enn objektet, blir objektet
flislagt av bildet.

Når du fyller et objekt med et bilde kan du
velge Skaler bildet slik at det passer for å
endre størrelsen på bildet slik at det passer
objektet:

For mer informasjon, se  Changing objects’
properties på side 53 .

Troubleshooting gestures
Problem Anbefaling

Flerberøringsgester som beskrives i denne
veiledningen virker ikke med
SMART Notebook-programmet.

Sørg for at ditt interaktive produkt støtter
flerberøringsgester og at
flerberøringsgestene er aktiverte.
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A

Adobe Flash-videofiler 78
Adobe Flash Player-kompatible filer 77
AIFF-filer 79
aktivering 175
Aktivitetsbygger 104
aliaser 84
animasjon 97
ASF-filer 79
audio files Se: sound files
automatiske oppgaver

gruppere objekter 68
AVI-filer 79, 137

B

bakgrunner 101
beskjæring

bilder 61
bevegelser

feilsøke 182
innstille preferanser for 167
om 10
typer

klem for å zoome 113
knipse 57
panorere 114
riste 67, 167
rotere 65
skalere 63
sveipe 19

bilder
eksportere filer til 15
kopiere inn fra et SMART

dokumentkamera 76
om 75
opprette transparente områder

i;transparente områder;{nopage}

usynlige områder{see}

redusere filstørrelsen på 168
sette inn fra filer 75

BMP-filer 15, 75, 169
brosjyrer 17
buer 33
bunntekst 16-17

C

cellefyll 171
CFF-filer 16, 80
CPU-brikker 138

D

diamanter 31
digitalt blekk

feilsøke 180
konvertere til tekst 35, 127
om 28
skrive eller tegne 28
viske ut 30

dobbel sidevisning 118
Dobbelbrukermodus 154
dokumentkameraer 76

E

egenskaper
bevegelser 167
bildeoptimalisering 168
måleverktøyenes 170
tabellcelleutfylling 171

Eksempler på undervisningsaktiviteter 72
eksporter 15, 88
elektroniske ressurser 74
Enkelbrukermodus 154
Essentials for Educators Se: Gallery

Essentials
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F

falmende objekter 124, 131
Fargestiftpennetype 28
feilsøke

bevegelser 182
digitalt blekk 180
filer 179
objekter 181
SMART Notebook programvarevindu

og verktøylinje 179
femkanter 31-32
Fet tekst 37
ffmpegX 79
figurer

lage med Figurverktøyet 31
lage med penneverktøyet for

figurgjenkjenning 33
lage med verktøyet for regulære

polygoner 32
Figurgjenkjenningspenn 29, 33
filer

eksporterer 15
feilsøke 179
importerer 80
klippe, kopiere og lime innhold inn fra 79
lagre 14
legge ved .notebook filer 84
lenker til objekter 95
opprette 13
redusere størrelsen på 168
skrive ut 17
vise i dobbeltsidig visning 118
vise i Full Tavlevisning 114
visning i Dual-brukermodus 154
Visning i Transparent Bakgrunn 116
åpne 13

firkanter 31-33
Flash files Se: Adobe Flash Player

compatible files
Flash video files Se: Adobe Flash video

files
flere interaktive produkter 119
former

om 31
forstørre 113, 124

Forstørret bokstav 37
freehand objects Se: digital ink
fullskjermvisning 114
funksjonsforespørsler 177

G

Galleri
anvende bakgrunner og temaer fra 103
eksportere innhold fra 88
finne og jobbe med innhold fra 72
import av innhold til 88
legge ditt innhold til 86
legge temaer til 104
organisere innholdet ditt i 87

Galleriverktøy 72
Gallery Sampler Se: Lesson Activity

Examples
Geodreieckvinkelmåler 147
GeoGebra

finne og jobbe med innhold fra 73
GIF-filer 75
gjennomsiktig bakgrunnsvisning 116
GPU-aksellerering 138

bruke SMART-opptaker 138
graphics Se: pictures
grupper

objekt 67, 181
sider 23

H

haker 31
HTML-filer 15
håndskrift, konvertere til tekst av 35, 127

I

images Se: pictures
importerer 80, 88
innhold

dele med andre lærere 88
organisering 87
sette inn i .notebook-filer 71

Interaktive SMART Board-tavler i 800-

serien 154
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Interaktive SMART Board-tavler i D600-

serien 154

J

JPEG-filer 15, 75

K

kalligrafipenn 28
kategorier for teaminnhold 89
klone

objekter 62
sider 21

knapp for størrelsesendring 63
kompasser 149
kors 31
Kreativ pennetype 29, 92
Kundeprogram 177
kursiv tekst 37

L

lenker
legge til objekter 94
vise 118

linjaler 143
linjer 33
Linux-operativsystemer 14
lydfiler 96, 120
lydomkodere 79
låste objekter 181

M

Mac OS X operativsystemprogramvare 14
Magisk penneverktøy 29
Magisk Penneverktøy 123
Matematikkverktøy 80
matematiske symboler 39
Menypiler 52
merkepenn 28
miniatyrbilder

i Sidesorteringen 19
i utskrifter 17

Mitt innhold-kategorien 87

MOV-filer 79
MP3 files Se: sound files
MP4-filer 79
MPEG-filer 79
multimediafiler 77
music files Se: sound files
My Content category Se også: Team

Content categories
måleverktøy

om 143
måleverktøyenes

innstille preferanser for 170
typer

Geodreieckvinkelmåler 147
kompass 149
linjaler 143
transportør 144

N

navn
av sider 22
for filer 14, 169
på sidegrupper 23

nedlastinger 79
Nettlesere 82
nettsider 15, 85, 94
.notebook filformat 14
Notebook software Se: SMART Notebook

O

objekter
animere 97
beskjæring 61
Endre størrelse 62
endring av tekststørrelse 38
falming 124, 131
feilsøke 181
fjerne alt fra en side 151
flytte 56
flytte til andre sider 57
gruppere 67
innretting 58
innstilling av fyll og linjestil for 53
klippe ut, kopiere og lime inn 60
klone 62
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legge lenker til 94
legge til galleriet 86
legge til tabeller 43
legger lenker til;lenker

legger til objekter 130
låse;låste objekter 97
omarrangere 59
Rotere 65
Slette 68
Velge 52
Vende 66
viske ut 30

omkodere 79
oppdateringer 173
ovaler 33

P

panorere 114
parallellogrammer 31
PDF-filer

eksportere 16
penner

typer
Fargestift 28
Figurgjenkjenning 29, 33
Kalligrafisk 28
Kreativ 29, 92
Magisk 29, 123
Malerpennerel 29
Merkepenn 28
Tekst 29

typer av
Standard 28

Pennetypen Malerkost 29
photographs Se: pictures
piler 31
PNG-filer 15, 75
polygoner 32
PowerPoint 42
Preferanser

standardfarge for ny side 170
produktnøkler 175
proxy-servere 83

Q

QuickTime files Se: MOV files

R

regelmessige polygoner 32
rektangler 31, 33
rette linjer 33
RSS-strøm 162-163
RSS feeds;tillegg

SMART Central 161

S

sekskanter 31-32
set squares Se: Geodreieck protractors
shortcuts Se: aliases
sider

bakgrunnsinnstillinger for 101
flytte objekter mellom 57
gruppere 23
klone 21
legge til galleriet 86
lenker til objekter 94
låsing 118
omarrangere 23
omdøpe 22
opprette 20
opptak 99, 120
panorere 114
skrive ut 17
slette 24
tømme 151
utvide 21
vise 19
vise i dobbeltsidig visning 118
vise i Full Tavlevisning 114
visning i Dual-brukermodus 154
Visning i Transparent Bakgrunn 116
zoome inn og ut 113

sidetall 16-17
sirkler 31, 33
skjermoppløsninger 141
skjermskyggelegging 123
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Skjermskygger;sider
skjule med skjermskygger 122

skrivere 17
SMART-avinstalleringsprogram 172
SMART Board-verktøy 2
SMART Document Cameras 76
SMART Exchange 74, 89, 157
SMART Ink

om 2
SMART Notebook 2
SMART Opptaker

Dele opptak 141
Endre filplassering 135
Endre video- og lydkvalitet 136
endre videoformat 137
legge til vannmerker 133
om 133
Skjule 139
Starte 142
Ta opp 139

SMART Produktdrivere 2
SMART produktoppdatering 173
spottlys 126
språk 35, 127, 172
stabler med objekter 59
stavekontroll 39
SWF files Se: Adobe Flash Player

compatible files
syvkanter 32

T

T-squares Se: Geodreieck protractors
tabeller

endre egenskaper for 45
fjerne 50
fjerne cellenyanser fra 123
fjerne celleutfylling fra 171
fjerne kolonner, rader eller celler fra 48
flytte 45
legge cellenyanser til 123
legge kolonner, rader eller celler til 48
Legge til objekter i 43
om 41
opprette 41
splitte eller sammenslå celler i 49
velge 44

Team Content categories Se også: My

Content category
tekst

klippe 40
konvertere håndskrift til;digitalt blekk

konvertere til tekst;håndskrift,

konvertere til tekst på;språk 128
redigere 36
skrive 34

Tekst
endre størrelse 38
inkludere matematiske symboler i 39
konvertere håndskrift til 35, 127
stavekontroll av 39

Tekstpennetype 29
temaer

anvende 103
oppretting 104

TIFF-filer 15
tilbakemelding 177
tillegg

bruk 158
deaktivere 159
fjerne 159
identifisere manglende 158
installere 157
om 157

topptekster 16-17
trapezoider 31
trekanter 31-33

U

understreket tekst 37
utfylling 171

V

Vanlig filformat for Tnteraktiv Tavle 16, 80
vannmerker 133
varsler for verktøyendringer 10
vedlegg 84
verktøylinje

Fullskjerm 115
Transparent bakgrunn 116

verktøylinjer
SMART Notebook 165, 179
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Verktøypakke for undervisningsaktiviteter 72
videoer 78

ta opp 133
videoomkodere 79
vinkelmåler 144
viskelær 30
volume 120

W

WAV-filer 79
web browsers Se: Internet browsers
widgeter 74
Windows-operativsystemer 14
Windows Media-filer 79, 137
Word 42

X

XBK filer 13

Y

ytelse, forbedring
bruke SMART-opptaker

deaktive maskinvareakselerering 138
deaktive maskinvareakselerering 138
for SMART-opptaker

redusere skjermoppløsningen 141
redusere skjermoppløsningen 141

Z

zoome inn og ut 113, 124

Å

åttekant 32
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